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Preface

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme
Any last-minute information about Agile PLM can be found in the Readme file on the Oracle

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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New in Release 9.3.1.2

There are no new features or changes to existing features in the current release of this component
of Agile SDK. There is new content in this document which addresses the execution of Events in
PLM clusters. You can find this content under Synchronous and Asynchronous Operations in OAS

Clusters on page 75.
New in Release 9.3.1.1

There are no new features in the current release of this component of Agile SDK Developer. There
is new content and reorganization of existing content in Developing Dashboard Management
Extensions on page 53 in this component of SDK Developer Guide. The new content is organized
under Configuring the Link Data Type for Objects Created in Custom Table DXs on page 63 and
provides the following information:

o Invoking Advanced Search in a Custom Table DX Data Source on page 63

o Enabling Quick View in a Custom Table DX Data Source on page 63

= Displaying Quick View with Mouseover on page 66

B Opening the Selected Object in the Right Pane on page 67
New in Release 9.3.1 Rev 3

There are no new features or enhancements implemented in this release of this component of the
SDK Developer Guide. Changes summarized below, only apply to this document.

Publishing Agile APIs and PLM Extensions in Separate Books

Starting with this release, the SDK Developer Guide which was published as a single book in
previous releases, is divided and published in two complimentary books as follows:

o SDK Developer Guide - Using Agile APIs — This book consists of the first twenty chapters of the
SDK Developer Guide Release 9.3.1 Rev 2 and applicable Appendices.

o SDK Developer Guide - Developing PLM Extensions — The contents of this book are the Process
Extensions, Web Services Extensions, Dashboard Management Extensions, and Event
Framework chapters of the SDK Developer Guide Release 9.3.1 Rev 2 and applicable
Appendices.

This change is necessary, because the number of pages that make up the SDK Developer Guide
which is posted on the Oracle Technology Network (OTN), is exceeding the 500 page limit set for
OTN submissions, and documents that exceed this limit are rejected by the OTN.
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New in Release 9.3.1 Rev 2

The SDK_samples.zip file is moved from
http://www.oracle.com/technology/sample code/products/agile/9.3/index.html to
https://codesamples.samplecode.oracle.com/servlets/tracking/id/S614.

Note  Oracle recommends using the Internet Explorer to access these sites.

Note The PG&C constants and the relationships table functionality in 2gileAPI.jar
Release 9.2.2 and subsequent releases of Agile PLM are incompatible with the ones in
the earlier versions of AgileAPI.jar.
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About this Guide

Oracle's Agile Software Development Kit (SDK) is a collection of Java application programming
interfaces (APIs), sample applications, and documentation that enable building custom applications
to access, or extend the functionalities of the Agile Application Server. Using the SDK, you can
create programs that extend the functionality of the Agile product lifecycle management system
(PLM) and can perform tasks against the PLM system.

The SDK enables the following operations:

m]

m]

u]

u]

Integrate the Agile PLM system with enterprise resource planning (ERP) applications or other
custom applications

Develop applications to process product data
Perform batch operations against the Agile Application Server

Extend the functionality of the Agile PLM system

This release marks the partition of the SDK Developer Guide which was published as a single book
prior to this release, into the following two books.

u]

SDK Developer Guide - Using Agile APIs — This component of the SDK Developer Guide provides
information to develop batch operations against the PLM Server, integrate the PLM with other
application, and process PLM data. This information is described and documented in the SDK
Developer Guide - Using Agile APIs.

SDK Developer Guide — Developing Extensions — This component of the SDK Developer Guide
provides background and procedural information to create additional PLM clients (extend Agile
PLM functionalities) and work with PLM Frameworks described and documented in this book.
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Agile PLM Extension Frameworks

This component of the SDK Developer Guide documents the following extension frameworks that
are developed in conjunction with the Java APIs, and tools such as Java or Groovy scripts:

u]

Process extensions (Custom PXs) — This framework enables Agile PLM customers extend the
functionality of Agile PLM. The functionality can be server-side extensions, such as custom
workflow actions and custom autonumbering, or extensions to client-side functionalities, such
as external reports, or new commands added to the Actions menu or the Tools menu. These
PXs are implemented using the Java programming language.

Event Framework — This framework supports Java process extensions (Java PXs), and Script
process extensions (Script PXs). Similar to Custom PXs, they make it easier for PLM
customers to extend the functionality of PLM clients to manage events by extending the
function of an action taken by a user, an interface, or the system when the Event is triggered.
Java PXs are implemented using Java and Script PXs are implemented using a scripting
language called Groovy. Groovy is an object-oriented programming language for the Java
Platform as an alternative to the Java programming language.

Web service extensions (WSX) — This is a framework that allows Agile PLM customers extend the
functionality of the PLM system and expose the customer-specific solutions as a Web service.

Dashboard Management extensions (DX) — DXs extend the functionality of the Agile PLM system.
They provide the data, Dashboard Tabs, and the required formats to display the data (tables,
charts, and URLS) that are configured in Agile Java Client in Agile Web Client for authorized

users.

SDK Components

The Agile SDK has the following Client-side and sever-side components:

Client-Side Components

The contents of the Agile SDK Client-side components are:

Documentation

m]

u]

u]

SDK Developer Guide (this manual)

API Reference files (these are the Javadoc generated HTML files that document the API
methods)

Sample applications

The APl HTML reference files and Sample applications are in the SDK_samples.zip folder. You can
find this files at: http://www.oracle.com/technetwork/indexes/samplecode/agileplm-sample-
520945.htm.

Note  For more information and procedures to access its contents, contact your system

administrator, or refer to your PLM installation guide.

Agile Product Lifecycle Management
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Installation
o Agile APl library (AgileAPI.jar)
= Java Process Extensions API library (pxapi.jar)

o Apache Axis library (axis.jar)

Server-Side Components

Oracle's Agile Application Server contains the following SDK server-side components:
@ Agile APl implementation classes
= Java and Scripting process extensions framework

B Web service extensions frameworks

SDK Architecture

The SDK facilitates developing many types of programs to connect to the Agile Application Server.
If you are using only the Agile API, you can develop programs that connect directly to the server. If
you are using WSX to develop Web service extensions, you can deploy the Web services inside the
Agile Application Server container. You can locate the Web server used for WSX either inside or
outside the company’s demilitarized computing zone (DMZ) or perimeter network. When the Agile
PLM Client initiates a custom action, it either runs a program deployed on the server, or it connects
to an external resource or URL, WSX, Java PX, and Script PX extensions can also use the Agile
API. It's a tool available to all Agile SDK development projects. You can also develop extensions
using APIs that are not provided by Agile.

Figure 1: Agile SDK architecture
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Note  Agile API programs connect to the Agile Application Server using non-secure means.
Consequently, Agile API programs should be run only from within the corporate firewall.
Web service Clients, however, can connect to the server through the corporate firewall
using standard HTTP(S) technology.

System Requirements

For Agile SDK system requirements, refer to PLM Capacity Planning and Deployment Guide.

Java Requirements

The Agile API must be compatible with the version of Java that the application server supports. To
avoid problems, an Agile API Client must use the same version of Java that the connecting
application server is using. Oracle Application Server 10g must use Sun Java Runtime Environment
(JRE) 1.5.0_06 and Oracle WebLogic Server 10.3 must use Sun Java Runtime Environment (JRE)
1.6 for interoperability and 2007 Daylight Saving Time compliance.

The following table lists the recommended Java Runtime Environment (JRE) to use with Agile API
Clients on different application servers that Agile PLM supports.

Application Server Operating System Required Java Version for Agile API
clients
Oracle Application Server 10g Windows 2003 Sun JRE 1.5.0
Oracle WebLogic Server 10.3 Windows 2003 Sun JRE 1.6

Java Virtual Memory Parameters (JVM) to Prevent Out of
Memory Exceptions

To prevent out of memory errors, add the following JVM options in the indicated locations.
Note  This workaround is only applicable to single-threaded SDK programs.
= If the Client is a standalone SDK Client, add the JVM option as shown below:

java -Ddisable.agile.sessionID.generation=true pk.sample

= If the Client is a PX and out of memory occurs in Agile Server, add the JVM option in
<OAS_HOME>/opmn/conf /opmn.xml

<category id="start-parameters">
<data id="java-options" value="-Xrs -server -
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XX :MaxPermSize=256M -msl1l280M -mx1280M -XX:NewSize=256M -

XX :MaxNewSize=256M -XX:AppendRatio=3 -
Doracle.xdkjava.compatibility.version=10.1.0 -
Djava.security.policy=$ORACLE HOME/j2ee/home/config/java2.policy -
Dagile.log.dir=$ORACLE HOME/j2ee/home/log -

Dcom. sun.management . jmxremote -

Dcom. sun.management . jmxremote .port=9899 -

Dcom. sun.management . jmxremote.authenticate=false -

Dcom. sun.management . jmxremote.ssl=false -Djava.awt.headless=true -
Dhttp.webdir.enable=false -Duser.timezone=GMT -
Ddisable.agile.sessionlD.generation=true"/>

<data id="oc4j-options" value="-verbosity 10 -
userThreads" />
</category>

o If the Client is a URL PX, add the following JVM option in the Server Start up (similar to
catalina.bat in Tomcat):

-Ddisable.agile.sessionID.generation=true

Agile SDK Installation Folders

The Agile SDK files use the following folder structure on your computer:

lib —The \agile home\integration\sdk\1lib folder contains the following libraries:

Important Do not include the axis. jar file and AgileAPl.jar file in the same classpath. The
SDK classpath does not support this setting and the SDK will not function properly.

B AgileAPI.jar — Agile API library, which contains Agile API classes and interfaces

B axis.jar - An Oracle-modified version of the Apache Axis library required for Web service
Clients

o pxapi.jar — PX API library, which contains interfaces used to develop custom autonumber
sources and custom actions

Checking Your Agile PLM System

Before trying to run the Agile SDK Clients on your Agile PLM system, make sure the system is
configured and working properly. In particular, make sure the HTTP ports for your application server
are set correctly. For more information, refer to the Agile PLM Installation Guide.
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Agile PLM Business Objects

With any enterprise software system, you work with business objects to manage the company’s
data. The following table lists the Agile PLM business objects and their related Agile APl interfaces.

Object Related Agile API Interface
Changes IChange
Customers ICustomer
Declarations IDeclaration
Design IDesign
Discussions IDiscussion
File Folders IFileFolder
Items ITtem

Manufacturer parts

IManufacturerPart

Manufacturers IManufacturer
Packages IPackage

Part Groups (Commodity or Part Family) ICommodity

Prices IPrice

Product Service Request IServiceRequest
Projects IProgram

Sourcing Project IProject

Quality Change Request

IQualityChangeRequest

Reports

IProductReport

Requests for Quote (RFQ)

IRequestForQuote

RFQ Responses ISupplierResponse*

Sites IManufacturingSite

Specifications ISpecification

Substances ISubstance

Suppliers ISupplier

Transfer Order ITransferOrder

User Groups IUserGroup

Users IUser
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* Agile does not support the API interfaces in the current release of the software.

The business objects that you can view and actions that you can perform on these objects are
determined by the server components installed on your Agile Application Server and the roles, and
assigned privileges. Privilege levels can vary from field to field. In addition to Users and User
Groups, Agile PLM administrators work with administrative objects, such as administrative nodes
and Agile PLM classes.

Note Not all Agile PLM business objects are exposed in the Agile API. For example, some
Report objects are not accessible via the Agile API.
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About Process Extensions

Process extensions (PX) is a framework for extending the functionality of the Agile PLM system.

The fu

nctionality can be server-side extensions, such as custom workflow actions and custom auto

numbering, or extensions to client-side functionality, such as external reports or new commands

added

to the Actions menu or the Tools menu. Regardless of the type of functionality a process

extension provides, all custom actions are invoked on the Agile Application Server rather than the

local ¢

Note

lient.

In addition to server-side functionalities you can develop in the PX framework, Agile
PLM's Event framework also supports developing extensions using Java and Groovy
Script, called Java PXs and Script PXs respectively. Although you can migrate some of
the custom actions developed in PX framework to Events framework, the two
frameworks have their own unique interfaces and are not the same.

Process extensions enable the Agile PLM server and Agile PLM users to connect to external
systems. You can also use process extensions to add functionality not provided by the standard
Agile PLM client. Using a simple yet powerful approach, process extensions open the Agile PLM
system, allowing you to tailor the application to your business requirements.

A process extension is either a Java class deployed on the Agile Application Server, or a link to a
URL. The URL can be a simple Web site or the location of a Web-based application.

You can use process extensions to create:

o Custom reports

@ User-driven and workflow-triggered custom actions

@ Custom tools accessible through Agile PLM clients

o Custom auto numbering
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What types of custom actions and tools can you create within the process extensions framework?
Technically, there are few limitations on what a custom action can do. After all, you define it.
Consequently, it's an open-ended solution. Agile Solutions Delivery and Agile partners can help
your company develop the process extensions it needs.

Multiple process extensions can be linked together in a chain with each process extension
performing a discrete business function. Process extensions can also be used to make requests to
Web services, such as services built with Agile’s Web service extensions framework.

There are five integration points for process extensions available in Agile PLM clients. You can
invoke process extensions from the following areas:

= External reports
@ Actions menu

@ Tools menu

o Workflow Status

o Autonumber sources

Developing Custom Autonumber Sources

This section describes how to develop a custom autonumber source.

Most Agile PLM object classes have at least one default autonumber source that lets you create a
new object and automatically number it with the next number in the sequence. Autonumbers can
have an alphanumeric prefix and/or suffix. You can also specify the length of the autonumber (a
string) and which numeric characters to use.

Despite the flexibility that autonumbers provide, some companies have specific numbering
requirements that can’t be accommodated by Agile PLM's standard autonumbering capabilities.
Such companies can define custom autonumber sources and add them to the Agile PLM system
using the process extensions framework.

If you have administrator privileges, you can define autonumber sources in Agile Java Client. An
autonumber source can use the client’s standard numbering capabilities, or it can be associated
with a custom autonumber source. When an Agile PLM client uses a custom autonumber source to
create a new object, the Agile Application Server invokes the custom Java code to generate the
number.

Defining a Custom Autonumber Source

To define a custom autonumber source, create a Java class that implements the
ICustomAutoNumber interface, a server-side APl in the com.agile.px package. The code
should define the autonumbering logic, for example, prefix, suffix, number of digits, character set,
and so on, and the persistence mechanism. Regarding persistence, the location where your custom
autonumber source stores numbers is entirely up to your program. For example, you can store
numbers in a SQL database like Oracle or in a file.

The Agile PLM server gets the next number from the custom autonumber source by calling the
getAutoNumber () method, which must be provided in your class. The following example shows
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how to implement a Java class for a custom autonumber source.

Example: Defining the class for a custom autonumber source
package autonumbers;

import com.agile.px.*;
import com.agile.api.*;

public class ResistorNumber implements ICustomAutoNumber

{

public ActionResult getAutoNumber (IAgileSession session, INode
actionNode)

String num;
// Write your code here to define the custom autonumber source for
Resistors
return new ActionResult (ActionResult.STRING, num) ;

}
}

Packaging and Deploying a Custom Autonumber Source

After you develop classes for a custom autonumber source, follow these instructions to properly
package and deploy them.

To package and deploy a custom autonumber source:

1. Use your Java development environment or the Java Archive tool (or JAR tool) to create one
or more JAR files for the custom autonumber source. Make sure the JAR file(s) includes a
META-INF/services directory that contains a file named
com.agile.px.ICustomAutoNumber, which is a text file that lists the fully qualified Java
class names, one class per line, for the custom autonumber source.

Multiple custom autonumber sources can be included in one package. For example, the
com.agile.px.ICustomAutoNumber file could look like this:

autonumbers.ResistorNumber
autonumbers.CapacitorNumber

autonumbers .DiodeNumber

Note  Paths within a JAR file are case-sensitive. Therefore, make sure the META-INF
folder contained within the JAR file has a name with all uppercase or all lowercase
characters. Otherwise, the custom autonumber source will not be deployed.

2. Place the JAR file(s) in the agile_home/integration/sdk/extensions folder on the same computer
where the Agile Application Server is installed.

Note If you have several application servers in a clustered environment, you must deploy
process extension files on each server in the cluster.

v9.3.1.2 11



SDK Developer Guide - Developing PLM Extensions

Configuring Custom Autonumber Sources in Java Client

In Agile Java Client, you can define autonumber sources in the Admin module. To configure Agile
PLM system settings, you must have an administrator account.

To add a custom autonumber source:

1. Log into Agile Java Client as an administrator.
2. Click the Admin tab.

3.  Go to Settings > Data Settings > AutoNumbers.

4. Click the AutoNumbers node.

A
5.  In the AutoNumbers window, click J The Define the Autonumber dialog box appears.
Figure 2: Define the Autonumber dialog box

= Define the AutoMumber §|

Mame

API Mame

Descripkion

Enabled

Type

Where Used

Custom Autonumber v

A

[ Ok ][ Cancel ]

6. Provide the following information:
* Name — Type the name of the autonumber source.

*  APIName — This field is automatically filled in after completing the Name field. Refer to
Accessing PLM Metadata with APIName Field in SDK Developer Guide - Using the APIs.

®  Description — Type a brief description of the autonumber source.
® Enabled — Select Yes or No.
*  AutoNumber type — Select Custom. This activates the Custom AutoNumber field.
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*  Where Used — Select the subclass(es) that can use the autonumber source.
®  Custom AutoNumber — Select a custom autonumber source from the list.

7. Click OK to save the autonumber definition.
Assigning Autonumber Sources to a Subclass

When you define an autonumber source, you can specify the subclasses where it's used in the
Where Used field. You can also assign an autonumber source to a subclass in the Classes node.

To assigh autonumber sources to a subclass:
1. Loginto Agile Java Client as an administrator.
Click the Admin tab.

Open the Data Settings folder.

Open the Classes node.

a > W DN

In the Classes window, double-click a subclass. The subclass window appears.

6. In the Autonumber Source field, click E A popup window appears.

7. Select autonumber sources in the Choices list, and then click B to move them into the
Selected list. When you are finished, click OK.

8. Click Save to save settings.

Developing Custom Actions

This section describes how to develop custom actions in Java classes. The Agile PLM clients can
make direct method calls into these classes to perform the actions.

You can initiate a custom action from the following areas of Agile PLM clients:
@ Actions menu

@ Tools menu

= External reports

8 Workflow Status

Defining a Custom Action

To define a custom action, create a Java class that implements the ICustomAction interface, a
server-side API in the com.agile.px package. The code should define the action to perform. The
Agile PLM server initiates the action by calling the doAction () method, which must be provided in
your class.

The following example shows the code for a HelloWorld class. When the doAction () method is
called, the method returns “Hello World.” If you invoke the HelloWorld custom action from Actions
menu, the string “Hello World” will be logged to the object’s History table. If you invoke the
HelloWorld custom action from a workflow, the string “HelloWorld” will be logged to the change
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order’s History table when it enters the appropriate workflow status.
Example: Defining a HelloWorld class for a custom action
package actions;

import com.agile.px.*;
import com.agile.api.*;

public class HelloWorld implements ICustomAction

public ActionResult doAction(IAgileSession session, INode
actionNode,
IDataObject affectedObject)

}

return new ActionResult (ActionResult.STRING, ""Hello World") ;

}

The above HelloWorld class does not perform a useful action, it simply demonstrates how to
implement the class for a custom action.

Formatting New Lines (Line Breaks) in PLM Clients

You can configure new lines in ActionResult outputs in Web and Java clients using the '\n'
character.

Note  SDK only supports the character '\n' for new lines in both Web and Java clients.

Example: Formatting new lines in SDK string outputs
1. Create a Process Extension that includes with the following ActionResult string.

return ActionResult (ActionResult.STRING, "Hello \n This example tests
formatting new lines \n in the SDK");

2. Run the Process Extension in the Web and Java clients from Actions menu and Tools menu.

The output should be as below

Hello
This example tests formatting new lines
in the SDK

Custom Actions and User Sessions

When an Agile PLM client invokes a process extension, it does so within the current user’s session.
Therefore, the process extension should not create any additional IAgileSession objects using
the Agile API within the process extension code or any code directly invoked from the process
extension. Stated simply, process extensions never directly create new Agile PLM sessions.
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If you have written a Web service extension (WSX) and want to make use of that code from within a
process extension, you can directly invoke Java methods contained in WSX classes without using
the Web services infrastructure, provided those methods do not create a new IAgileSession
object.

Do not mix Process extension (PX) invocations with Web service extension (WSX) invocations. The
PX code must not invoke any WSX code directly, especially when the PX and WSX reside in the
same application container. If a process extension makes use of Web services, that WSX will likely
create a new Agile PLM session, which is distinct from the session used by the process extension.

URL-based process extensions can call an external application that communicates with the Agile
PLM server and performs some action upon the currently selected business object. To perform
such an action, the external application can use the Agile API to create another Agile PLM session.
For more information, see Creating an Agile PLM Session from the Target System on page 21.

Packaging and Deploying a Custom Action

After you develop classes for a custom action, follow these instructions to properly package and
deploy them.
To package and deploy a custom action:

1. Use your Java development environment or the Java Archive tool (or JAR tool) to create one
or more JAR files for the custom action. Make sure the JAR file(s) includes a META-
INF/services directory that contains a file named com.agile.px.ICustomAction, whichis a
text file that lists the fully qualified Java class names, one class per line, for the custom action.

Multiple custom actions can be included in one package. For example, the
com.agile.px.ICustomAction file could look like this:

actions.HelloWorld
actions.RFQConsolidation
actions.RefreshCustomerFromCRM
actions.StartMfg
actions.ObsoletePartReplacer
actions.WorkflowConflictResolver

Note Paths within a JAR file are case-sensitive. Therefore, make sure the META-INF
folder contained within the JAR file has a name with all uppercase or all lowercase
characters. Otherwise, the custom action will not be deployed.

2. Place the JAR file(s) in the agile home/integration/sdk/extensions folder on the
same computer where the Agile Application Server is installed.

Note If you have several application servers in a clustered environment, you must deploy
process extension files on each server in the cluster.

Roles and Privileges for Custom Actions

When you configure a custom action in Agile Java Client, you can specify the roles it uses. By
default, a custom action uses the roles and privileges of the current user. However, you can
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configure a custom action to have expanded privileges. This is an important feature of process
extensions. In effect, you can enforce the business logic of a custom action by granting it more
privileges than those given to ordinary users. When a custom action is invoked in the Agile PLM
client, its roles and privileges override the roles and privileges of the current user. Once the custom
action is completed, the client reverts to the user's roles and privileges.

User Privileges for Configuring Process Extensions

To configure a Process Extension, you must have necessary user privileges to get the user’s
language setting. If a PX fails, the error message should display in the user’s current language. If
the user’s roles are not set to include the privilege to load current user object info, the server will
display all messages in the default system language.

Configuring Custom Actions in Agile Java Client

In Agile Java Client, you can define custom actions in the Admin module. To configure Agile PLM
system settings, you must log in as a user with administrator privileges.

Using the Process Extension Library

The Process Extension Library is where you define the custom actions that can be used in Agile
PLM clients. When you add a custom action to the Process Extension Library, you specify how to
initiate that action from the client.

To add a custom action to the Process Extension Library:
1. Log into Agile Java Client as an administrator.

2. Click the Admin tab.

3. Open the Data Settings folder.

4. Open the Process Extensions node.
Figure 3: The Process Extension Library
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Irmport AxML. .. Process exkension b import an Agile XML (akML) file for a Declaration, IrnportA XML s
||Im|:|0rt IPC HML... Process extension bo import a IPC XML Far a Declaration. IrnporEIRCEML Yes
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A
5. Inthe Process Extension Library window, click the Add Process Extension button J to open

the Add Process Extension dialog box.

Figure 4: The Add Process Extension dialog
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Type the following information:

* Name — Type the name of the process extension.

x
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* APIName — This field is automatically filled in after completing the Name field. Refer to

Accessing PLM Metadata with APIName Field in SDK Developer Guide - Using the APIs.

*  Description — Type a brief description of the process extension.

* Type — Select Internal Custom Action. This activates the Internal Custom Actions field.

* Internal Custom Action — Select a custom action from the list.

* |Initiate From — Select one or more locations from which the process extension can be
initiated. Choose from the following options:

Actions menu — Allows you to select the custom action from the Actions menu of a properly

configured class.

External report — Allows you to generate a report by accessing an external resource or URL. If
the process extension is an internal custom action, the External Report option is unavailable.

Tools menu — Allows you to select the custom action from the Tools menu.

Workflow status — Invokes the custom action whenever a properly configured workflow enters a

particular status.

If you specify that a process extension is initiated from the Actions menu or a workflow status,
you can configure subclasses or workflows to use it. If you specify that a process extension is

used to generate an external report, you can use Agile Web Client to create the report. If you
specify that a process extension is initiated from the Tools menu, it is always available in the

Agile PLM client.
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®* Roles — Select one or more roles to use for the custom action. To use the roles and
privileges of the current user, leave this field blank. To temporarily override roles and
privileges of the current user, select one or more roles. Once the custom action is
completed, the client reverts to the current user's roles and privileges.

®* Enabled — Select Yes or No.

1. Click OK to save the new process extension.
Assigning Process Extensions to Classes

To add custom actions to the Actions menu of an Agile PLM object (such as a Part or an ECO), you
configure the object’s class. Each base class, class, and subclass has a Process Extensions tab.
The custom actions that you assign to a class must be previously defined in the Process Extension
Library.

Process Extensions are inherited from classes and base classes. Consequently, if you assign a
process extension to a base class, it is also assigned to classes and subclasses beneath the base
class.

Note  Process extensions can be assigned to only one level in a class hierarchy. For example,
if a process extension is assigned to the Part subclass, it can't be assigned to the Item
base class.

To assign process extensions to a class:

Log in to Agile Java Client as an administrator.
Click the Admin tab.

Open the Data Settings folder.

Open the Classes node.

In the Classes window, double-click a base class, class, or subclass.

S o o

Click the Process Extensions tab.
7. Inthe toolbar, click @ The Assign Process Extension dialog box appears.

8. Select custom actions in the Choices list, and then click M to move them into the
Selected list. When you are finished, click OK.

9. Click OK to save settings.

Assigning Process Extensions to Workflow Statuses

For each workflow status except the Pending status, you can assign one or more custom actions
that are initiated when the workflow enters that status. The custom actions you assign to a workflow

status must be previously defined in the Process Extension Library.

Note  Automated Transfer Orders (ATOs) do not support workflow-triggered process
extensions.
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To assign process extensions to a workflow status:

N o o > w DN

Open the Workflows node.

Log in to Agile Java Client as an administrator.
Click the Admin tab.
Open the Workflow Settings folder.

In the Workflows window, double-click a workflow
Click the Status tab.

properties table that appears below the status table.

8. Double-click the selected status in the Workflow Criteria properties table.

Select a status other than Pending. The selected status updates the Workflow Criteria

9. Inthe Process Extensions list, click E A popup window appears.

10. Select custom actions in the Choices list, and then click B to move them into the Selected list.
When you are finished, click OK.

11. Click Save to save settings.

Defining and Deploying URL-Based Process
Extensions

URL-Based Process Extensions are used by Agile Web Client to provide access from the Web
Client to external applications. When the Agile PLM Web Client invokes a process extension that
references a URL, the client displays the Web page in a new browser window.

What types of Web-based applications could be used for URL-based process extensions? Again,
there are few limitations. One example might be a Web-based application that performs business
rules validation for an Agile PLM object and updates the object accordingly. The following figure
shows the program flow of such a process extension.

Figure 5: Process flow for a possible URL-based process extension

Agile PLM Web
Client invokes a
URL-based process
extension.

Agile PLM connects
to a target
application using an
HTTP request.

v

Target application
fetches Agile PLM
authentication
information.

Target application
configures the object
using the Agile API.

v

Target application
validates the

referenced object.
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You can also use URL-based process extensions to reference a Web-based report engine. To
create an external report that uses a URL-based process extension, choose Create > Report > External
in Agile Web Client. For more information, see Creating an External Report on page 26.

Note  Agile Java Client does not support URL PXs.

Before Building a URL-Based Process Extension

Please note the following requirements and constraints when building a URL-based process
extension:

o URL-based process extensions cannot be initiated by a change in a workflow, because an
Agile PLM client may not be active to trigger the change in status

= URL-based process extensions are not supported for Souring projects (IProject)

Defining a URL-Based Process Extension

To define a URL-based process extension do as follows:
1. Log into the Agile Java Client as an administrator.

2. Click the Admin tab.

3. Open the Data Settings folder.

4

Open the Process Extensions node.

A
5. Inthe Process Extension Library window, click J The Add Process Extension dialog box
appears.

6. Enter the following information:
* Name — Type the name of the process extension.
® Description — Type a brief description of the process extension.
* Type — Select the URL.

* Address — Specify the address of a Web page. You must specify the complete URL,
including the protocol. For example, to specify the Agile Corporation Web site, you would
type “http://www.agile.com”, not “www.agile.com”.

* |Initiate From — Select one or more locations from which the Web page can be initiated.
Choose from the following options:
= Actions menu — Allows you to select the Web page from the Actions menu of a
properly configured class.
= Dashboard — See Developing Dashboard Management Extensions on page 53.
=  External report — Use this to generate a report by accessing the Web page.
=  Tools menu — Use this to select the Web page from the Tools menu.

If you specify that a process extension is initiated from the Actions menu, you can
configure subclasses to use it. If you specify that the process extension is used to
generate an external report, you can use the Agile Web Client to create the report. If you
specify that the process extension is initiated from the Tools menu, it is available at all
times in the Agile PLM client.

20 Agile Product Lifecycle Management


http://www.agile.com/
http://www.agile.com/

Chapter 2: Developing Process Extensions

* Enabled — Select Yes or No.

7. Click OK to save the new process extension.

Passing Encoded Agile PLM Information to Other
Applications

Agile SDK 9.2.2 does not support single sign-on via password protected external application
servers.

Important Agile Web Client can propagate encoded user credentials which can be reused by the
SDK when your PX application uses the Agile SDK. If you want to password protect
access to an external Application Server, you need to hard code the username and
password to access the external servlet into your code.

If a URL-based process extension is initiated from an object’s Actions menu, the object’'s composite
key and class ID, as well as the current username, are encoded in the URL using the GET method.
The client encodes the data as ID=value pairs and appends it to the end of the URL. Each ID is
prefixed with “agile,” as shown in the following example.

http://www.acoolwebsite.com/?agile.username=wangsh&agile.classId=10141&
agile.1001=
1 000- 02&agile.l10l4=A&agile.siteName=Taipei

Note  Unlike the Actions menu, there isn’t an Agile PLM object associated with commands on
the Tools menu. Consequently, if a URL-based process extension is initiated from the
Tools menu, the URL is not augmented with encoded object data.

In addition to information encoded in the URL of a URL-based process extension, the encrypted
username and its associated password are available from the j_username and j_password cookies,
respectively, which are automatically passed to the target system if the following conditions are met:

o The user initiates a URL-based process extension from Agile Web Client.

Note  Your Web application must reside in the domain specified in the cookie.domain property
of agile.properties. Otherwise, security cookies will not propagate.

o The target system is permitted to receive cookies.

= The target system is in the same domain as the Agile PLM system.

Note If the target system is located outside the company firewall, it should be a secure Web
server using SSL.
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Creating an Agile PLM Session from the Target System

Using authentication information contained in the HTTP request received from a URL-based
process extension initiated from Agile Web Client, the target application can use the Agile API to
create an IAgileSession. The Agile API client can then retrieve and configure the Agile PLM
object referenced by the HTTP request.

When a user logs into Agile Web Client, the authentication process creates a pair of cookies
(j_username and j password) on the server computer that store the user's encrypted user name
and password.

Note  These cookies will expire after the duration set by the Agile PLM Administrator.

When you initiate a URL-based process extension from Agile Web client, the target system can use
cookies to create an Agile PLM session. In effect, Agile Web client and the Agile API client on the
target system can share a single sign-on.

Note  The Agile Java Client, unlike the Web client, does not create client-side cookies.
Therefore, it does not support the single sign-on feature for process extensions.

Cookies are designed to be shared among computers within the same domain. For example, if
during installation of Agile PLM, you configure the domain to be “.agile.agilesoft.com” and all
computers ending with “.agile.agilesoft.com” can use the j_username and j_password
cookies.

For more information, see http://wp.netscape.com/newsref/std/cookie spec.html.

The following example shows how to use the Agile API to extract cookie information from the HTTP
servlet request and use that information to generate an IAgileSession. The value of the
AgileSessionFactory.PX REQUEST field, which is the key used to create the session, is set to
be equal to the servlet request.

Example: Creating an IAgileSession from a servlet request using the PX_REQUEST field

private IAgileSession connect (HttpServletRequest request) throws
ServletException {

factory =
AgileSessionFactory.getInstance ("http://agileserver/Agile") ;

HashMap params = new HashMap () ;
params.put(AgileSessionFactory.PX REQUEST, request);
session = factory.createSession (params) ;

return session;

}

If the target application is not servlet-based, there is another way to use the cookie information to
create a session. Rather than using AgileSessionFactory.PX REQUEST, you can use
AgileSessionFactory.PX USERNAME and AgileSessionFactory.PX PASSWORD fields as
keys for the HashMap. The values of these fields should be the values of the j_username and
j_password cookies, respectively.

Example: Creating an IAgileSession using PX_USERNAME and PX_PASSWORD fields
private IAgileSession connect (Cookie[] cookies) throws Exception ({
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factory =
AgileSessionFactory.getInstance ("http://agileserver/Agile") ;

HashMap params = new HashMap () ;

String username = null;
String pwd = null;
for (int i = 0; i < cookies.length; i++) {
if (cookies[i] .getName () .equals("j username"))
username = cookies[i] .getValue () ;
else if (cookies[i] .getName () .equals("j password"))
pwd = cookies[i] .getValue() ;
}
params.put(AgileSessionFactory.PX_USERNAME, username);
params.put(AgileSessionFactory.PX PASSWORD, pwd);
session = factory.createSession (params) ;
return session;

}
Retrieving an Agile PLM Object from an HTTP Request

If you invoke a URL-based process extension from an object’s Actions menu, you may want the
target application to retrieve the Agile PLM object and modify it. The object’s composite key and
class ID are encoded in the URL using the GET method. To make it easier for the target application
to retrieve the referenced IAgileObject, the Agile API provides an overloaded use of the
IAgileSession.getObject () method, as shown in the following example. The SDK extracts
the object ID information from the request and uses it to retrieve the specified object.

Example: Retrieving an Agile PLM object from an HTTP request

private IAgileObject getAgileObject (HttpServletRequest request) throws
ServletException ({

IAgileObject obj = session.getObject(null, request);

return obj;

}

If the target application is not servlet-based, you can use the normal
IAgileSession.getObject () methods to retrieve the referenced object. For the params
parameter of getObject (), specify a HashMap containing all required attributes for the object’s
class; the necessary attribute/value pairs are contained in the encoded URL. For a list of identifying
attributes for each Agile PLM class, see the following section.
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Identifying Attributes for Agile PLM Classes

Each Agile PLM class has a different set of identifying attributes that could be passed as
parameters in an encoded URL. For example, a Change object would pass its class ID and Cover
Page.Number attribute. The following table lists the identifying attributes for each Agile PLM class.

Class Parameter Description

Change agile.classID Class ID of selected object
agile.1047 Cover Page.Number

Customer agile.classID Class ID of selected object
agile.5110 General Info.Customer Number

Commodity agile.classID Class ID of selected object
agile.agile.2000 Title Block.Name
004284

Declaration agile.classID Class ID of selected object
agile.agile.2000 Title Block.Name
002615

Discussion agile.classID Class ID of selected object
agile.18417 Cover Page.Number

File Folder agile.classID Class ID of selected object
agile.6173 Title Block.Number
agile.7951 Title Block.Version

ltem agile.classID Class ID of selected object
agile.1001 Title Block.Number
agile.1014 Title Block.Rev

agile.siteName

Site name — If All is selected, this parameter is omitted

Manufacturer Part

agile.classID

Class ID of selected object

agile.1l647 General Info.Manufacturer Name
agile.1l648 General Info.Manufacturer Part Number
Manufacturer agile.classID Class ID of selected object
agile.1754 General Info.Manufacturer Name
Package agile.classID Class ID of selected object
agile.3110 Cover Page.Package Number
Price agile.classID Class ID of selected object
agile.10355 General Information.Number
agile.10357 General Information.Rev
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Class Parameter Description
Program agile.classID Class ID of selected object
agile.18041 General Info.Number
Sourcing Project agile.classID Class ID of selected object
agile.14824 General Info.Number
PSR agile.classID Class ID of selected object
agile.4856 Cover Page.Number
QCR agile.classID Class ID of selected object
agile.4029 Cover Page.QCR Number
Reportl agile.classID Class ID of selected object
agile.8071 General Info.Name
RFQ agile.classID Class ID of selected object
agile.13925 CoverPage.RFQ Number
RFQ Response agile.classID Class ID of selected object
agile.14472 CoverPage.RFQ Number
agile.14452 CoverPage.SupplierName
Site agile.classID Class ID of selected object
agile.11882 General Info.Name
Specification agile.classID Class ID of selected object
agile.2000001969 | Title Block.Name
Substances agile.classID Class ID of selected object
agile.2000001124 Title Block.Name
Supplier agile.classID Class ID of selected object
agile.17761 General Info.Number
Transfer Order agile.classID Class ID of selected object
agile.12673 Cover Page.Transfer Order Number
User agile.classID Class ID of selected object
agile.11617 General Info.Username
User Groups agile.classID Class ID of selected object
agile.12077 General Info.Name
Note  Although the process extensions framework can encode Report information in a URL,
Report objects are not supported by the Agile API. Therefore, you cannot use the Agile
API to retrieve Report objects referenced in a URL.
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Creating an External Report

In Agile Web Client, you can connect to an external resource or URL to generate an external report.
Before you create an external report, you must add the URL associated with the report to the
Process Extension Library. For more information, see Defining URL-Based Process Extensions on
page 19.

To create reports in Agile Web Client, you must have the Create Reports privilege.

To create an external report:
1. Log into Agile Web Client.

Note  You cannot create external reports in Agile Java Client.

Choose Create > Report > External. The Report Creation Wizard appears.
Type the name of the report. Click Next.
4. Type the following General Information:

*  Description — Type a brief description of the report.

®  Process Extension — Select a process extension. The process extension you select is
associated with a URL, such as the location of Web-based report engine.

®  Folder — Select the report’s parent folder.
5.  Click Finish.

Deploying Process Extensions in a Clustered
Environment

If the Agile PLM installer was not run on a server in the application server cluster, the
/agile_home/integration/sdk/extensions folder will not exist on that server. If so, you must
create the folder manually and copy any process extension JAR files into that folder.

To manually create deployment folders for process extensions:

1. Create the following folder on all application servers in the cluster (if it does not exist):
/agile_home/integration/sdk/extensions

2. Put all process extension JAR files in the /agile_home/integration/sdk/extensions
folder on each server in the cluster.
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Best Practices for Copying third Party JAR Files

If your PX code uses 3" party JAR files such as axis.jar, you can copy them in the shared
library and add them to classpath using the following procedures.

Use te following procedure to configure your shared libraries

To configure shared libraries in Oracle Application Server:

1. Place all 3" party JAR files in a folder, for example, D: \commonLib.

Stop the Agile server.

Navigate to <OAS HOME>\j2ee\home\application-deployments\Agile.

Open orion-application.xml in a text editor.

a > w0

Append a line to specify your library path:

<library path="ABSOLUTE PATH TO YOUR LIBRARY" />

<!-- Specify the absolute path to the folder having those required JAR files)
For example, <library path="D:\commonLib" /> after these two lines:
<library path="../APP-INF/lib" />

<library path="../APP-INF/classes" />

6. Start the Agile Server.

Procedures in this section show how to deploy the following dependent JAR files:
= The dependent JAR file from 3" party JAR files that do not dependent on Agile JAR files

@ Any dependent JAR file from 3 party JAR files that are dependent or not dependent on Agile
JAR files

To deploy the 3" party JAR files on WebLogic:

1. Stop all servers in the domain.

2. Copy the shared JAR file(s) to a 1ib subdirectory of the domain directory.
For example, cp c¢:\3rdpartyjars\utility.jar agile home\agileDomain\lib
Note  The WebLogic Server must have read access to the 1ib directory during startup.

Note  The Administration Server does not automatically copy files in the 1ib directory to
Managed Servers on remote machines. If you have Managed Servers that do not
share the same physical domain directory with the Administration Server, you must
manually copy the JAR file(s) to the domain name/1ib directory on the Managed
Servers.

3. Start the Administration and the Managed Servers in the domain.
Start the Administration Server and all Managed Servers in the domain. WebLogic Server
appends JAR files found in the lib directory to the system classpath. Multiple files are added in
alphabetical order.
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To deploy the dependent JAR files from a WebLogic Admin console:

1.

4.
5.

In WLS Administration console, select Deployments > Control > Install.

ORACLE Weblogic Server® Administration Console

Change Center @ Home Log Out Preferences Record Help | Q

G E TS Horne =Summary of Deployments

Configuration editing is enabled. Future Summary of Deployments
changes will automatically be activated as you
modify, add or delete items in this domain, Control | Monitoring

Domain Structure

testmergebuid

B-Eri
Enwiranment controls on this page.

~-Security Realms
[-Interoperabiliey
[-Diagnnstics [ Customize this table

Deployments

Ingtall | | Update | | Delgte Statv || Stopw

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain, Installed applications
and modules can be started, stopped, updated (redeployed), or deleted fram the damain by first selecting the application name and using the

~Services Toinstall 2 new application or madule for deployment to targets in this domain, click the Install button,

Welcome, weblogic ‘ Connected to: testmergebuild

Showing 1t0 2 of 2 Previous | Mext

Select the JAR file and then click Next.

Locate deployment to install and prepare for deployment

Select the fils path that represents the application raot directory, archive fils, exploded archive directory, or application module descriptor that you
want tainskall, You can also enter the path of the application directary or file in the Path Field.

Note: Only valid file paths are displayed below. IF you cannot find your deployment files, uplosd your file(s) andfor confirm that your application
cantains the required deployment descriptors,

Path: Dryjelk? B.0_0BYlib\ch jar
Recently Used Paths:  [0:ijdki 5.0_06\b

Current Location: rm-05 4 D 4 jakl.5.0_06 { b

O dt.jar

htmlconverter.jar

jeonsole.jar
O O toolsjar

Back | [Nex ‘ Finish | Cancel

In Install Application Assistant accept the default settings and click Finish.

Install Application Assistant

Back | | Nest | Fimth | Cancel

Optional Settings
Yfou can modify these settings or accept the defaults
General

what do yau want ko name this deplayment?
Name: ot

Security

it security madel do you want to use with this application?

(2 DD Only: Use only roles and policies that are defined in the deployment descriptors.

Make sure the library pointd to the Agile Server/cluster.

Create a file called weblogic-application.xml with the following content:

<?xml version="1.0" encoding="UTF-8"?>
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<wls:weblogic-application

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xmlns:wls=http://www.bea.com/ns/weblogic/weblogic-

application

x8i:schemalocation="http://www.bea.com/ns/weblogic/weblogi

c-application http://www.bea.com/ns/weblogic/weblogic-

application.xsd http://java.sun.com/xml/ns/j2ee

http://java.sun.com/xml/ns/j2ee/j2ee 1 4.xsd">

<wls:library-refs>

<wls:library-name><Shared Library Jar file
names></wls:library-names

</wls:library-ref>

</wls:weblogic-application>

6. Placethe weblogic-application.xml file in
agile home\agiledomain\applications\application.ear\META-INF folder in the
Administration server.

7. Restart the Administration and all the Managed servers.

To deploy the properties files on WebLogic:

1. Stop all servers in the domain.

2. Copy the properties file(s) to a directory as in agile home/pxConfig in each server.

Note
Note

WebLogic Server must have read access to the directory during startup.

The Administration Server does not automatically copy files in the directory to
Managed Servers that are on remote machines. If you have Managed Servers that
do not share the same physical domain directory as the Administration Server, you

must manually copy the properties file(s) to the agile home/pxConfig directory

on the Managed Servers.

3. Add the directory containing the properties file(s), for example, agile home/pxConfig to the

WebLog

a. Editagile home/agileDomain/bin/setEnv.bat in all Managed Servers

b. Add

set
set
set

set
set
set
set
set
set
set
set
set
set
set
set

ic CLASSPATH as shown below:

agile_home/pxConfig folder to the CLASSPATH
CLASSPATH=9JAVA_HOME%/lib/tOOlS.jar
CLASSPATH:QCLASSPATH%;%LIB_HOME%/ojdbc14.jar
CLASSPATH=9CLASSPATH%;%WLS_HOME%/server/lib/

weblogic sp.jar;%$WLS_HOMES%/server/lib/weblogic.jar
ClASSPATH=%CLASSPATH%; $LIB_HOME%/agbase.jar
CLASSPATH=9CLASSPATH%;%LIB_HOME%/wlsauth.jar
CLASSPATH=$CLASSPATH%;%LIB_HOME%/crypto.jar
CLASSPATH:QCLASSPATH%;%LIB_HOME%/XerceSImpl.jar
CLASSPATH=9CLASSPATH%;%LIB_HOME%/jdom.jar;
CLASSPATH=$CLASSPATH%;%LIB_HOME%/log4j.jar;
CLASSPATH=%CLASSPATHS%; $LIB HOME%/jobaccess.jar;
ClASSPATH=9CLASSPATH%;%LIB_HOME%/COlt.jar
ClASSPATH:%CLASSPATH%;%LIB_HOME%/jms.jar
ClASSPATH:QCLASSPATH%;%LIB_HOME%/jndi.jar
ClASSPATH=9CLASSPATH%;%LIB_HOME%/tibij.jar
ClASSPATH=$CLASSPATH%;%LIB_HOME%/oc4jclient.jar
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set ClASSPATH=%CLASSPATHS; %LIB_HOME%/OC4j .jar
set CLASSPATH=%CLASSPATHS%;../ldaplib/ldaputil.jar
set CLASSPATH=%CLASSPATH%;D:\Agile931b28/agileDomain/config

set CLASSPATH=%CLASSPATH%;agile home/pxConfig

4. Start the Administration Server and all Managed Servers in the domain.

Process Extensions FAQ

This section answers common questions about process extensions.
What are process extensions?

Process extensions extend the functionality of Agile PLM clients through custom actions, external
reports, custom autonumbering and tools, thus tailoring the system to fit a customer's business.
Process extensions can be used to connect the Agile PLM server and Agile PLM users to external
systems.

What types of actions can you define with process extensions?

Process extensions support two types of process extensions actions. They are custom autonumber
sources and custom actions. Custom autonumber sources define the numbering sequences used
by classes of objects. Custom actions are programs that can be run from Agile PLM clients.

A process extension can also be a reference to a URL. The URL can be a simple Web site or the
location of a Web-based application.

Can Process Extensions support asynchronous operations?

Agile Process Extensions only support synchronous operations. If your Process Extension requires
asynchronous behavior, you must modify your PX code to implement asynchronous solutions of
your choice. For example, you can spawn a thread.

Can | use Agile's Java API within a process extension program?

Yes. You can use Agile's Java API and other external Java APIs. The only requirement is that you
implement either the ICustomAutoNumber or the ICustomAction interface, depending on the
type of extension.

How do you initiate a process extension in an Agile PLM client?

Custom actions can be triggered in the following ways:

@ A change to a Workflow status.

o Selecting a custom action from the Tools menu.

@ Selecting a custom action from the object's Actions menu.

o Selecting an external report that uses a custom action.

o Creating an object of a class that uses a custom autonumber source.
Do process extensions have special security requirements?

No. The process extensions stack sits on the Agile Application Server, so custom actions and
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custom autonumber sources operate within an environment where the user has already been
authenticated and authorized.

How are roles and privileges defined for custom actions?

By default, a custom action uses the roles and privileges of the current user. However, if you want
to configure a custom action to have expanded privileges, you can specify the roles required for a
custom action in the Process Extension Library of Agile Java Client. When you use a custom action
in the Agile PLM client, roles and privileges that are specified for the custom action, override the
roles and privileges of the current user. Once the custom action is completed, the client reverts to
the user's original roles and privileges.

How do | configure and deploy a process extension?

Place the JAR file(s) for a process extension in the agile_home/integration/sdk/extensions folder on
the application server. Included with the JAR file(s) should be a file named
com.agile.px.ICustomAutoNumber or com.agile.px.ICustomAction in the META-INF/services
directory. The contents of these files are the fully qualified Java class names, one class per line, for
a custom autonumber source or a custom action, respectively.

After | deploy a process extension program on the application server, how do | enable it?

Once process extensions have been deployed, you can configure them for use within Agile PLM
clients. In Agile Java Client, you can add custom actions to the Process Extension Library and
custom autonumbers to the Autonumbers table.

After I've deployed JAR file(s) for a custom action or custom autonumber source, do | need to update the
application server classpath?

No. The classpath is updated automatically by a special-purpose classloader. The classloader
extends the application server classpath with any classes located in
agile_home/integration/sdk/extensions (or the location specified for the sdk.extensions
property in the agile.properties file).

How do you create a custom autonumber source?

Create a Java class that implements the ICustomAutoNumber interface, a server-side APl in the
com.agile.px package. The code defines the autonumbering logic, for example, prefix, suffix,
number of digits, and so on, and the persistence mechanism. The Agile PLM system gets the next
number from the custom autonumber source by calling the getAutoNumber () method.

How do you assign custom autonumber sources in Agile Java Client?

In the Classes node, you assign autonumber sources to specific subclasses. In the AutoNumbers
node, you can also assign subclasses to an autonumber source.
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How do you create a custom action?

Create a Java class that implements the ICustomAction interface, a server-side APl in the
com.agile.px package. The code defines the custom action, whether to modify the current
object, create an external report, integrate the Agile PLM client with an external system, or perform
some other business logic. When an Agile PLM client initiates a custom action, the Agile PLM
system calls the doAction () method.

How do you associate custom actions with the Tools menu, the Actions menu, Workflow statuses, and external
reports?

In Agile Java Client, open the Process Extensions node to add and configure custom actions. You
can associate custom actions with Workflow statuses, the Tools menu, the Actions menu for
classes, and external reports. A custom action associated with a Workflow status is initiated
automatically when the Workflow assumes that status. A custom action appears on the Tools menu
when its Initiate From property is set to Tools menu. A custom action appears on the Actions menu
for an object when you add it to the Process Extensions tab for a subclass. A custom action
associated with an external report is triggered automatically when that report is executed.

In what order do process extensions appear on the Tools menu or Actions menu of Agile PLM clients?

If you add process extensions to either the Tools menu or an object’'s Actions menu, they are listed
after standard menu commands in the order they were created. You cannot reorder or otherwise
manage commands on the Tools menu or Actions menu.

What is the inheritance model of custom actions that are assigned to classes?

Custom actions can be defined at the base class level, the class level, or the subclass level. A
custom action defined at the base class level is available to all classes and subclasses beneath the
base class. A custom action defined at the subclass level is available only to that subclass.

Where do | put PX and WSX configuration property files?

After deployment changes in Agile PLM Release 9.2.2.2, the agileDomain\config directory is no
longer in the classpath. You can put PX and WSX property files in this directory:
\oas\j2ee\home\applications\Agile\APP-INF\classes\.
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About Web Service Extensions

Web service extensions (WSX) is a Web service engine enabling communication between Agile

PLMa
(ERP)

nd disparate systems both internal and external including Enterprise Resource Planning
systems, Customer Resource Management (CRM) systems, Business-to-Business

Integration systems (B2Bi), other Agile PLM systems, and supply chain partners. WSX can
streamline the process for new product introduction (NPI), product changes, and rapid ramp-up of
manufacturing resources. It can also simplify the process for aggregating raw product content and
making critical product content available in real time to other core systems. WSX contains the tools
and framework to develop new Agile PLM Web services.

You can use WSX to:

= Make product content available to Enterprise Application Integration (EAI) systems, which can
then feed the data to a broad array of internal applications.

@ Share product content with product design, manufacturing planning, shop floor, Enterprise
Resource Planning (ERP), and Customer Relationship Management (CRM) applications.

o Make product content available to Business-to-Business (B2B) systems, which can transfer
Agile Application server data across corporate boundaries to a wide range of external
applications.

= Provide content to exchanges, reports, and custom applications and import Product content
data from ERP and other supply chain applications.

Note  Agile Integration Services (AlS) is a set of Web services that is built with WSX
technology to provide programmatic import and export capabilities for the Agile PLM
system. AIS is a separately licensed product. For more information about AlS, refer to
the Agile Integration Services Developer Guide.
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Key Features

WSX includes the following key features:

u]

Programmatic access to data — WSX provides programmatic access to data stored in Agile PLM
systems and other data resources, allowing you to create custom applications to automate
content transfer.

Accessibility — WSX provides accessibility of Agile PLM product content outside the corporate
firewall using standard HTTP(S) technology.

Multiple programming language support — WSX supports any language that can create and
understand Simple Object Access Protocol (SOAP) and/or Web Services Description
Language (WSDL).

Multiple output format support — WSX supports aXML and PDX 1.0. You can also use XSL to
transform XML data into any format, or develop Web services that return data in any format.

Security — WSX communicates with XML-compliant applications using Internet-standard
communication and security protocols (HTTP and SSL), so the interface is both firewall-friendly
and secure.

WSX Architecture

To connect to Agile PLM and the WSX framework, you use standard Web service invocation
methodologies.

Figure 6: WSX architecture
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About Web Services

Web services is a technology for building distributed applications. These services, which can be
made available over the Internet, use a standardized XML messaging system and are not tied to
any one operating system or programming language. Through Web services, companies can
encapsulate existing business processes, publish them as services, search for and subscribe to
other services, and exchange information throughout and beyond the enterprise. Web services are
based on universally agreed upon specifications for structured data exchange, messaging,
discovery of services, interface description, and business process design.

A Web service makes remote procedure calls across the Internet. It uses HTTP(S) or other
protocols to transport requests and responses and the Simple Object Access Protocol (SOAP) to
communicate request and response information.

The key benefits provided by Web services are:

o Service-oriented Architecture — Unlike packaged products, Web services can be delivered as
streams of services that allow access from any platform. Components can be isolated; only the
business-level services need be exposed.

o Interoperability — Web services ensure complete interoperability between systems.

= Integration — Web services facilitate flexible integration solutions, particularly if you are
connecting applications on different platforms or written in different languages.

o Modularity — Web services offer a modular approach to programming. Each business function in
an application can be exposed as a separate Web service. Smaller modules reduce errors and
result in more reusable components.

o Accessibility — Business services can be completely decentralized. They can be distributed over
the Internet and accessed by a wide variety of communications devices.

o Efficiency — Web services constructed from applications meant for internal use can be used for
externally without changing code. Incremental development using Web services is relatively
simple because Web services are declared and implemented in a human readable format.

Like any technology, Web services have some limitations. When developing Web services, you
should consider the following:

= SOAP is a simple mechanism for handling data and requests over a transport medium. It is not
designed to handle advanced operations such as distributed garbage collection, object
activation, or call by reference.

o Because Web services are network-based, they are affected by network traffic. The latency for
any Web service invocation can often be measured in hundreds of milliseconds. Thus, the
amount of functionality provided by the service should be significant enough to warrant making
a high-latency call.

= Web services are not good at conversational programming. Thus, when designing services to
be exposed, you should try to make the service as independent as possible.
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Web Services Architecture

You can view Web services architecture in terms of roles and the protocol stack:

B Web service roles:

®  Service provider — This provides the service by implementing it and making it available on
the Internet.

®  Service requestor — This is the user of the service who accesses the service by opening a
network connection and sending an XML request.

®  Service registry —This is a centralized directory of services where developers can publish
new services of find existing ones.

o Web services protocol stack:

®  Service transport layer — uses HTTP to transport messages between applications. Other
transports will be supported in future AIS releases.

* XML messaging layer — encodes messages in XML format by using SOAP, a platform-
independent XML protocol used for exchanging information between computers. It defines
an envelope specification for encapsulated data being transferred, the data encoding rules,
and RPC conventions.

*  Service description layer —describes the public interface to a specific Web service by using
the Web Service Description Language (WSDL) protocol. WSDL defines an XML grammar
for describing network services as collections of communication endpoints capable of
exchanging messages, which contain either document-oriented or procedure-oriented
information. The operations and messages are described abstractly, and then bound to a
network protocol and message format. WSDL allows description of endpoints and their
messages regardless of what message formats or network protocols are used to
communicate. A WSDL document defines services as collections of network endpoints
(called ports). A port is defined by associating a network address with a reusable binding,
and a collection of ports define a service.

®  Service discovery layer — centralizes services into a common registry by using the Universal
Description, Discovery, and Integration (UDDI) protocol.

Note  WSX does not currently support UDDI or other service discovery layers.

Security

WSX communicates with XML-compliant applications using Internet-standard communication and
security protocols (HTTP and SSL). Communication between WSX and its clients (via the Web
server) may be encrypted via Secure Sockets Layer (SSL) and a server-side certificate, thus
providing authentication, privacy, and message integrity. Using standard Java cryptography
libraries, you can encrypt and decrypt files, create security keys, digitally sign a file, and verify a
digital signature.

The Web service extensions framework forces any invocation request received from outside the
firewall to be secure. In other words, all external requests to WSX must be secured using HTTPS or
an equivalent protocol. Internal requests to WSX can be conducted insecurely, that is, using HTTP.
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There are several ways to enforce username and password security when invoking a Web service.
If you are using the Agile API to develop your Web service, you can specify the username and
password in the createSession () parameters just as you would with any API program.

For more information about Java security and cryptography support, see
http://java.sun.com/j2se/1.3/docs/quide/security/index.html

Tools

There is no single set of tools needed to access Web services. The tools you choose depend very
much on the environment you use to develop clients. Basically, you'll need tools that enable you to
generate and process XML, and process HTTP request/responses messages.

The WSX framework is based on the Apache eXtensible Interaction System (AXIS), which is a
SOAP processor. However, you can use other implementations of SOAP tools, regardless of source
language, to build Web service clients.

Note  The WSX Java samples included with the Agile SDK show how to use AXIS. For detailed
information about AXIS, its features, and how to use it, refer to the AXIS Web site:
http://xml.apache.org/axis

Finding Additional Information About Web Services

This is a list of some Web sites to explore:

o WebServices.Org — http://www.webservices.org/

8 Web Services Architect — http://www.webservicesarchitect.com/

8 Web Services Journal — http://www.sys-con.com/webservices/

o webservices.xml.com — http://webservices.xml.com/

o O'Reilly Web Services — http://webservices.oreilly.com/

= Apache Axis — http://ws.apache.org/axis/

o Java Web Services Developer Pack 1.1 — http://java.sun.com/webservices/webservicespack/html

@ Sun ONE Web Services Platform Developer Edition —
http://forums.sun.com/thread.jspa?thread|D=5020700

8 Microsoft .Net Framework — http://msdn.microsoft.com/netframework/

o SOAP::Lite for Perl — http://www.soaplite.com/

= Soap Tutorial — http://www.w3schools.com/soap/default.asp
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Developing and Deploying a Web Service

Writing your own Web service is a simple task, consisting of a few steps:

1. Define your Web service's entry point(s). A Web service entry point (or operation) corresponds
to a public method on a Java class.

2. Code your Web service operation’s logic. You need not follow any special rules when coding
the logic for your Web service operation. You may take advantage of third party code libraries
as well as Agile-provided libraries, including the Agile API.

Compile your Java code as you normally would.

4. Copy the compiled JAR file(s) to AGILE_HOME\integration\sdk\extensions on the Agile
Application Server computer. The deployment descriptor for the Web service should also be in
the JAR file(s) in a file named META-INF/services/com.agile.wsx.Deployment.wsdd.

Note If you have several application servers in a clustered environment, you must deploy
Web service files on each server in the cluster.

The Agile Application Server automatically deploys all Web services listed in the deployment
descriptor, ensuring that your latest changes have been applied.

About Deployment Descriptors

The Web service deployment descriptor file (Deployment.wsdd) is an XML file that is formatted
according to Axis's Web Service Deployment Descriptor (WSDD) format. It declares and describes
the set of Web services and Web service operations that are to be exposed via WSX. The WSDD
file also defines any additional behavior that should be used when processing incoming SOAP
requests (such as authentication, and so on) or responses (such as reformatting outgoing data).

The Axis documentation provides a good introduction to the WSDD format and its use. However,
before consulting the Axis documentation, please be aware of the following constraints within WSX:

= The Web service deployment descriptor should not contain global WSX configuration
information. The configuration information declared within Deployment.wsdd should be
restricted to service-specific declarations.

o WSX does not support the Axis .jws-based Web services. While these sound good on paper,
we have found our mechanism of redeploying Web services to be more robust and easier to
work with in a development environment.

B For security reasons, WSX does not include the Axis AdminServlet.
For more information about Axis deployment descriptors, refer to the following Axis documentations:

o Axis User’'s Guide — http://ws.apache.org/axis/java/user-quide.html

See the sections entitled “Custom Deployment - Introducing WSDD” and “Service Styles -
RPC, Document, Wrapped, and Message.”

o Axis Reference Guide — http://ws.apache.org/axis/java/reference.html

See the sections entitled “Deployment (WSDD) Reference.”
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Note  These sites are subject to periodic change. In that event, use your favorite search engine
to locate these documents.

Reserved Web Service Names

The following Web service names are reserved because they are used by Agile Integration Services
(AIS). Do not use them to name a Web service that you've created.

= Export
= Importer

o Reserved Service names:
®* FSHelper, DmsService (File manager and Viewer)
*  Export, Importer (AIS)
* ResponseService, PackageService, AcsStatusService (ACS)

Using a Web Service

Once you have developed and deployed your custom Web service, you will want to use it. You can
access your Web service using a URL of the form
http://<hostname><port>/<virtualPath>/integration/ws/<WebServiceName>

Note  You must use the Agile-modified axis.jar file thatis included with the Agile API. This
file
gets installed in the following location when you install Agile’s APl component:
agile_home\integration\sdk\lib\axis.jar

Defining a Web Service Entry Point

A Web service entry point (or operation) corresponds to a public method on a Java class. Not all
public methods on a class need be exposed as an operation, but all operations correspond to public
methods. Thus, if you have a Java class (such as MyClass), that exposes two public methods
(such as methodOne and methodTwo), it is possible for you to expose either or both methods as
Web service operations.

As a general rule, the simpler the datatypes used for your parameter and return types, the more
interoperable your Web service operation will be. More complex datatypes will require either custom
serializers/deserializers or additional support from the Web service framework. More information on
the additional serializers/deserializers provided by Axis can be found at
http://ws.apache.org/axis/java/apiDocs/org/apache/axis/encoding/Serializer.html and
http://ws.apache.org/axis/java/apiDocs/org/apache/axis/encoding/Deserializer.html. These sites are periodically
changed. In this case, pleas invoke your favorite search engine to locate the latest information on
these interfaces.

Note  Asarule, do not try to return an Agile API object, such as TaAgileSession or IItem,
from a Web service. Web services should only return data structures.
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Authenticating Users

All default out-of-box Web services and user customized versions are protected by the application
server. To access a protected Web service, add the following lines in your Web service client stub
code:

// Configure the stub with the necessary authentication information
stub.setUsername(cl.getOptionValue(USER_SHRT));

stub.setPassword(cl.getOptionValue(PASSWORD_SHRT));

stub.setMaintainSession(true);

To remove the Web container protection for a specific Web service, add the following lines in the
following applications:

application.ear#application.war/WEB-INF/web.xml

and

application.ear#integration.war/WEB-INF/web.xml files:

<gecurity-constraints>
<web-resource-collection>
<web-resource-name>Unprotect web services</web-resource-name>
<url-pattern>/ws/<web service name></url-patterns
<url-pattern>/services/<web service name></url-patterns
</web-resource-collection>

</security-constraint>

Using Single Sign-On Cookies for Client-Server Access

After a user on the WSX client is authenticated by the Agile 9.X server which is protected by third
party single sign-on products, the browser is granted a Single sign-on cookie. This cookie is sent to
the custom j2ee Web application, provided this application is in the same DNS domain as the Agile
9.X server. Now, to invoke the Web service deployed on Agile 9.X server, you can pass the single
sign-on cookie instead of username and password as a valid credential.

Note If you are using both username/password and single sign-on cookies, the single sign-on
cookie has precedence over username/password.

40 Agile Product Lifecycle Management



Chapter 3: Developing Web Service Extensions

Deployment Architecture

Interactions and the request flow between the Agile server and WSX client is summarized in the
following illustration.

Figure 7: Deployment Architecture
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Invoking the Web Service Client with a Single Sign-on Cookie

This is accomplished by first, retrieving the single sign-on cookie from the HTTP request followed by
modifying the SOAP binding stub code.

Retrieve the Single Sign-On Cookie

Before invoking the Web service client stub, you must retrieve the single sign-on cookie in the
HTTP request. By default, the single sign-on cookie provided by SiteMinder is called
"SMSESSION." Modify the cookie to the format specified in RFC2965 available at
http://www.ietf.org/rfc/rfc2965.txt. The simplest format is "name=value" where name and value are
accessed by calling the javax.servlet.http.Cookie object method.

Modifying the SOAP Binding Stub Code

Find the Web service SOAP bhinding stub class which is generated by wsdl2java utility of axis. It is
usually called <service-name>SoapBindingStub. java. Add a variable named cookies and a
method to set the value as shown below.

To modify the SOAP binding stub code:

1. Add the following lines in the SOAP stub class:
private String cookies = "'';
public void setCookies(String cookies) {

this.cookies = cookies;
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2. Add the line in bold font in createCall () method.
if (super.cachedPortName != null)
_call.setPortname (super.cachedPortName) ;

}

_call.setProperty(org.apache.axis.transport.http.HTTPConstants.HEADER _
COOKIE, this.cookies);

java.util.Enumeration keys = super.cachedProperties.keys() ;
3. Recompile this class and follow the sample below to invoke the Web service stub.

((<soaping binding stub class name>)stub).setCookies(<sso cookies you
got in step 2.1>);

stub.setMaintainSession(true);

4. Compare with the documented sample that requires username and password as valid
credentials.

stub.setUsername (<usernames) ;
stub.setPassword (<passwords>) ;
stub.setMaintainSession (true) ;

5. Test the Web service client as part of the j2ee Web application.

Preparing Environment for MyFirstWebService

To explain developing a Web service, a sample that highlights the development process is
provided. The sample, called MyFirstWebService, is a simple example that demonstrates how to
create a Web service that can use the Agile SDK to retrieve information about a particular Item and
return the Item as the result of the Web service operation.

To support the desired operation, the following entry point is defined:
public String getItemField(String[] args) throws RemoteException

MyFirstWebService sample uses a third party library called Jakarta Commons CLI and parses
args as a set of command line arguments. Based on these arguments, the results are returned as
a String. You can find more information on implementation details in the SDK_samples.zip folder
described in Client-Side Components on page 2. The path to MyFirstWebService is in
samples\wsx\src\first. The remaining paragraphs in this section describe the deployment
process and do not address implementation details.
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Downloading Tools to Build the Sample

Before you can build and deploy the MyFirstWebService sample, you need to download the
following tools:

Tool Download Site
Java 2 SDK SE Version 1.5 http://java.sun.com/j2se/1.4.2/download.html
Apache Project's Ant build tool, version 1.6.5 http://ant.apache.org/

Installing the Java SDK

This section provides the instructions to install the Java SDK on Windows and on Solaris platforms.
You can skip this section if you already have the proper version of Java installed.

To install the Java SDK on Windows:
1. Double-click the distribution and follow the installation procedures.

2. Setthe system variable JAVA_HOME to point to the home directory of your Java SDK
installation (for example, D:\j2sdk150).

To install the Java SDK on Solaris:

1. Execute the distribution (for example, $ ./ j2sdk-1_5 0-solaris-sparc.sh) and follow the
installation procedures.

2. Set the environment variable JAVA_HOME to point to the home directory of your Java SDK
installation (for example, /Thome/<user>/j2sdk150).

3.  Execute your .profile or .cshrc (depending on your shell) file to reinitialize your environment
settings.

Installing Ant

This section provides the necessary instructions to install Ant on Windows and Solaris machines.

To install the Ant on Windows:

1. Extract the contents of the Zip archive to a local directory and follow the installation
procedures.

The Ant distribution for Windows is a zip file (for example, apache-ant-1.6.5-bin.zip).

2. Open a command prompt window and verify that Ant can be invoked by entering the following
command:

%ANT _HOME%\bin\ant -version
The following output is displayed:

Apache Ant version 1.6.5 compiled on date
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To install the Ant on Solaris:

1.

Extract the contents of the tar archive to a local directory (for example, /home/user/ant) and
follow the installation procedures.

The ANT distribution for UNIX is a tar file (for example, apache-ant-1.6.5-bin.tar.gz).

Execute your .profile or .cshrc (depending on your shell) file to reinitialize your environment
settings.

From a command prompt, verify that Ant can be invoked by entering the following command:
$ANT_HOME/bin/ant -version

The following output should be displayed:

Apache Ant version 1.6.5 compiled on date

Building MyFirstWebService Sample

Agile provides several sample programs for the SDK, including a sample Web service program
called MyFirstWebService mentioned in . To download the sample program, refer to the Note in
Client-Side Components on page 2. The MyFirstWebService sample is in the wsx folder in SDK

Samples.

The Ant tool reads the build.xml script and builds all targets in the following sequence on the server
that is running the WSX samples):

1.
2.

Compiles the Java code for the Web service into MyFirstWebService. jar.

Copies the resulting MyFirstWebService. jar file, which includes the Deployment.wsdd file,
and the
commons-cli.jar file into the .../sdk/extensions folder.

Generates a script (either runner.bat or runner.sh) that can be used to run the client. (It
conveniently sets the CLASSPATH needed to run the client.)

Generates client-side stub files and places them in the following folder:

sdk\samples\wsx\built\src\client located in Oracle Agile PLM 9.3 Event and Web Services
Samples. To access this folder, see the Note in Client-Side Components on page 2.

Compiles the client classes and places them in the sdk\samples\wsx\built\classes\client flder,
located in Oracle Agile PLM's Event and Web Services Samples Web site at:
https://codesamples.samplecode.oracle.com/servlets/tracking/id/S614.

To build the WSX sample on the server platform:

1. Copy the SDK_samlpes (ZIP) file. For information to access this file, see the Note in Client-Side
Components on page 2.

2. Goto samples/WSX folder.
Note Ifthere’s no AgileAPI.jar in this folder, you are not able to compile the WSX

sample. In that case, do as follows:

Go to $AGILE_HOME/sdk/samples/wsx on the server.

4. Download wsd14j-1.5.1.jar from
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http://archive.apache.org/dist/ws/axis/1 2/ (axis-bin-1 2.zip#/1lib),
and copy it to lib folder and rename the file to wsd143j.jar.

5. Build the MyFirstWebService sample using the sample's build.xml file:
® OnWindows — $ANT HOMES%/bin/ant
® On Solaris/Linux — $ANT HOME/bin/ant

Important If you are not building the Web service sample under
$AGILE_HOME/sdk/samples/wsx, then upload the
wsx/built/MyFirstWebService. jar into
$AGILE_HOME/integration/sdk/extensions. This directory is configurable in
agile.properties on the server. Because the SDK will not generate WSDL files or
WSXs when you invoke
http://hostname:port/virtualPath/services/MyFirstWebService
?wsdl, it will not return the required WSDL file. To generate these files do as
shown in the next step.

6. Copy the package wsdl47j . jar file described above into Agile application.ear#APP-
INF/1ib folder and redeploy the ear file.

7. Inthe WSX folder, invoke the applicable command below to generate the WSX stub.

®* OnWindows — $ANT HOME%/bin/ant -
Dwsx.url=http://webserver/virtualPath/services -
Dusername=<username> -Dpassword=<passwords>

® OnSolaris/Linux — SANT HOME/bin/ant -
Dwsx.url=http://webserver/virtualPath/services -
Dusername=<username> -Dpassword=<password>

About Web Service Clients

This section describes the tools that you can use to develop client applications and languages that
can generate and process XML files and HTTP request/response messages.

Client Programming Languages

Although Agile tests and certifies Java for use in developing AlS clients, SOAP messages are
platform- and language-independent, which means you can use virtually any client programming
language that can generate and process XML and process HTTP request/response messages. For
example, you can develop clients in Java, Visual Basic.Net, C++, C, or Perl.

There are helpful libraries for Java, .Net, Perl, Python, C++, and C, and for other environments as
well. Here are some Web sites where you can find more information:

= Apache Axis — Open source SOAP implementation for Java: http://ws.apache.org/axis/

= Java Web Services Developer Pack (JWSDP) — Sun’s Java implementation of the SOAP protocol:
http://java.sun.com/webservices/webservicespack.html

@ Microsoft .Net — An XML Web services platform for Microsoft Windows that can be used to
create Web service clients:
http://msdn.microsoft.com/net

o SOAP::Lite for Perl — A Perl implementation of the SOAP protocol: http://www.soaplite.com/
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Note  For a comprehensive list of other SOAP implementations, see the following Web site:
http://www.soapware.org/

Accessing a Web Service

In general, to access a Web service, you need to do the following:

1. Generate a SOAP request — In many cases, a Web-service-aware code library will be able to
generate client-side stubs that generate an appropriately formatted SOAP request.

2. Submit that request to WSX via HTTP or HTTPS — Once an appropriate set of client-side stubs has
been generated, a client application can use these stubs to submit a request.

3. Process the SOAP response — The client-side stubs usually are responsible for processing the
SOAP response and converting the response into an appropriate set of return objects.

The WSX samples provide examples of how SOAP and Web service-related libraries can make this
process simple. The following sections illustrate, using the MyFirstWebService sample, the above
steps in greater detail.

Creating MyFirstClient

When you build and deploy MyFirstWebService, you also automatically generate the client-side
stubs and the client classes. This section uses MyFirstClient as an example to describe some
general aspects of how to create a Web service client.

Generating the SOAP Request

In most cases, generating an appropriate SOAP request is as simple as making use of client-side
stubs. Many Web-service-aware code libraries are able to generate client-side stubs for you. This
entails using a code generation utility along with the WSDL for the desired Web service.

Axis provides a WSDL2Java utility that can be used to generate client-side stubs. Other Web-
service-aware libraries have their own client-side stub generation facility. Microsoft .Net includes a
wsdl.exe utility. In the case of the WSX samples, the client-side stub generation occurs during the
samples' build process.

Within the build.xml file, you will find the following Ant target:

<target name="generate-stubs" depends="init" unless="stubs.present"s>
<fail unless="wsx.url"swsx.url must be defined</fails
<axis-wsdl2java output="${built.dir}/src"
urll="${wsx.url}/MyFirstWebService?wsdl">
<mapping namespace="http://www.agile.com/ws/SampleWsx"
package="'client"/>
</axis-wsdl2java>

</target>

This Ant target is responsible for generating the client-side stubs for MyFirstWebService. This
invocation retrieves the MyFirstWebService WSDL from ${ws.url}/MyFirstWebService?wsdl,
generates Java code in the client Java package, and places the source code within the
${built.dir}/src directory. For more information on the WSDL2Java utility, please consult the Axis
documentation, which can be found on the Axis Web site at
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http://xml.apache.org/axis.

Once the client-side stubs have been generated, the user can use the generated object definitions
in order to more easily generate the appropriate SOAP request. Rather than requiring the user to
understand how to construct a valid SOAP request, these stubs allow the user to focus on the
capabilities of the target Web service operation. Looking at the MyFirstClient.java sample found
within .\samples\wsx\src\client, note that the main method contains all the code used to generate
the SOAP request.

Submitting the SOAP Request

The next step in consuming a Web service operation is properly submitting the generated SOAP
request to the Web service engine. When dealing with generated client-side stubs, this step is
usually as simple as pointing the stubs to the desired server and invoking a method on the stubs.
You do not need to worry about opening a connection or manually marshaling your data onto the
wire. Instead, the generated stubs handle these details for you.

The MyFirstClient.java sample found within ..\samples\wsx\src\client illustrates how to submit the
SOAP request in two places:

o The getsStub () method is responsible for pointing the client-side stubs to the desired Web
service engine.

o The stub.getItemField () method invocation found within the main method is responsible for
submitting the request to the Web service engine. The submitting of the request is managed by
the stubs themselves; you do not need to worry about the connecting, submitting, or
marshaling particulars.

The details on how you point the stubs to the desired Web service engine and submit the request
vary from code library to code library. Please consult the documentation for your Web-service-
aware code library for more information.

Processing the SOAP Response

The processing of the SOAP response is usually handled via the generated client-side stubs.
Without these generated stubs, you would be responsible for parsing the XML-based SOAP
response and dealing with the many formatting and unmarshaling issues that arise. However, when
dealing with generated stubs, all of these details are taken care of for you, allowing you to receive
properly typed Java objects. Rather than require you to parse an XML document and discern what
the returned data is, the stubs automatically do this for you.

The details on how SOAP responses are processed will vary from code library to code library.
Some SOAP servers expect the client to know the datatype through some other means (perhaps
WSDL). Please consult the documentation for your Web-service-aware code library for more
information.
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Running MyFirstClient

To build and deploy the MyFirstWebService sample, use the information provided in the in file
SDK_samples.zip folder that lists the necessary CLASSPATH initializations to run the sample on
the Web service client. To access this folder, see the Note in Client-Side Components on page 2.

8 In Windows environments, the file is called runner .bat

@ In environments, the file is called runner. sh

To print out a usage statement for MyFirstClient, enter the following command:
> runner client_MyFirstClient

The following usage statement returns the “Title Block.Description” field for part 1000-02:

> runner client.MyFirstClient -T 15000 -a "<attribute name>"
-e <virtual path> -h <host> -1 <port> -n <item number> -p <password>
-u <username>

> runner client.MyFirstClient -T 15000 -a "Title Block.Description"
-e Agile -h localhost -1 80 -n 1000-02 -p agile -u jeffp

Creating an Agile Session inside WSX

By default, the Web container protects the WSX. Therefore, you must specify user credentials when
creating an Agile Session inside the WSX. The following example creates an Agile session within a
protected WSX.
Example: Setting up a session inside a WSX
AgileSessionFactory factory = AgileSessionFactory.getInstance (null);
IAgileSession session = factory.createSession (null) ;

Note Do not override the implicit session.

To have a different user, you need to make an explicit SDK session as if connecting from a remote
client. That is, provide an argument to the AgileSessionFactory.getinstance() method.

Example: Creating an explicit session independent of the implicit session
AgileSessionFactory factory = AgileSessionFactory.getInstance
("http://...");

HashMap params = new HashMap () ;
params.put (AgileSessionFactory.USERNAME, ...);
params.put (AgileSessionFactory.PASSWORD, ...);
IAgileSession session = factory.createSession (params) ;

Microsoft .NET Interoperability

Microsoft's .NET framework technology is a development framework that provides an application
programming interface (API) to the services and APIs of classic Windows operating systems, while
bringing together a number of disparate technologies that emerged from Microsoft in the late 1990s:
ASP, COM+, XML, SOAP, to name a few.

.NET also brings together all the languages provided by the Visual Studio environments provided by
Microsoft such as Visual Basic, J++, and C++. Also, new languages have been developed - such as
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C# (read C Sharp) and the relatively new language to the .NET family, J# (read J Sharp). J# is
actually Java in Microsoft disguise providing integration of Java into the .NET framework. Yet, J#
will not work with the Java VM. J#, in essence, acts as a wrapper to contain Java-enabled code to
be executed by the .NET Common Language Runtime (CLR), Microsoft’'s own ‘virtual machine’.

The CLR is probably the most important component to the .NET framework. The CLR provides for
the activation of objects, security checks, memory management, object execution, and memory
cleanup (garbage-collection) when objects are no longer being used.

Another factor behind .NET is that it not only provides for the writing of Windows-based applications
or Web-based applications (via ASP.NET) by using any of the languages mentioned, it also can
integrate these languages into one common API. This means that developers can write language
independent code, inherit from classes, catch exceptions, and take full advantage of polymorphism
across differing languages across the .NET framework.

Important Although the WSX framework (the AXIS SOAP processor) works fine with AXIS Web
service clients, it is not completely compatible with .Net. Neither Microsoft nor the
Apache group have conducted interoperability tests for AXIS and .Net. For simple data
types, AXIS-based Web services should work fine with .Net-based Web service
clients. For some complex data types (such as binary attachments), you may
experience interoperability problems. For interoperability information about non-AXIS
Web service implementations deployed outside of the Agile Application Server,
contact the specific Web service vendor.

Web Service Extensions FAQs

This section answers common questions about Web service extensions.
What is Web service extensions (WSX)?

WSX is a framework for Agile customers to extend the functionality of the Agile PLM server using
Web services.

What are Web services?

Web services use the SOAP messaging protocol to provide software services over the Internet,
allowing software components to interact with each other around the world. Web services are not
tied to any one operating system or programming language. They use WSDL to describe a service's
public interface, essentially making Web services self-describing and therefore relatively easy to
use.

What can | do with WSX that | can't do solely with Agile's Java API?

WSX provides firewall-friendly, XML-based integration with Agile PLM data using the standard
HTTP(S) protocol. It supports any SOAP-compliant programming language. For example, you can
create Perl or .Net clients for a Web service. WSX enables systems in different companies to
interact with each other easily and securely. Services deployed within WSX take advantage of all
the scalability, failover, and clustering features provided by the application server. There are also
compelling performance benefits to services that run on the application server.

Does WSX support both secured and unsecured connections?
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Yes. Requests that come to a Web service from outside the firewall are subject to different security
requirements from requests that originate within the firewall. Two separate entry points are provided
for each WSX, external (outside the firewall) or internal. External requests are made against a proxy
server and then forwarded to the application server. The proxy server resides in the DMZ. Internal
requests can be made against the same secure proxy server, another proxy server that doesn't
reside in the DMZ, or directly against the application server, as shown in the following figure.

Figure 8: How Web service clients connect to the Agile PLM server
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What user authentication services are provided by WSX?

By default, WSX is protected by application server. Username and password security is enforced
whenever a WSX client invokes a service that is protected. For more information, see
Authenticating Users on page 40.

What SOAP engine does WSX use?

WSX is based on Apache Axis, an open-source implementation of SOAP. For more information
about Axis, refer to the Axis Web site at http://ws.apache.org/axis/.

Does WSX handle SOAP attachments?
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Yes. In fact, Agile Integration Services provides exportData and importData services that let you
export and import binary attachment files.

Does WSX support stateful sessions?

Yes. The Axis Web services engine at the heart of WSX maintains session state between
connections. Sessions can be based on HTTP cookies or on SOAP headers. This is useful for
generating server-side code that supports more persistent applications instead of simple, one-shot
processes. For more information about Web services sessions, refer to Axis documentation. You
can start with the Axis FAQ located at http://ws.apache.org/axis/fag.html.

Does WSX support protocols other than HTTP?

No. WSX supports only HTTP-related protocols. For additional security, you can connect to a Web
service using HTTPS and SSL. Over time, WSX may support additional protocols as needed.

Does WSX support Perl, Python, PHP, or other Web scripting languages?

WSX supports any client programming language that can send a SOAP message. Although the
Agile SDK does not provide WSX client examples in Perl, Python, or PHP, those scripting
languages are certainly capable of sending SOAP messages.

Does WSX support UDDI?

No. UDDI is a specification for a universal business registry of Web services that's designed to
enable software to automatically discover and integrate with other services. It's currently
unnecessary to register Agile PLM Web services on the Internet using UDDI. Agile PLM Web
services are typically created for integration with internal software systems or to exchange data with
partners or suppliers. However, Agile may consider supporting UDDI as the technology matures.

How do | deploy a Web service?

Place the service's JAR files in the agile_homel/integration/sdk/extensions folder on the application
server computer. Included with the Web service’s JAR file(s) should be a deployment descriptor file
named META-INF/services/com.agile.wsx.Deployment.wsdd.

The deployment descriptor file is an XML file formatted according to Axis’ Web Service Deployment
Descriptor (WSDD) format. It declares and describes the set of Web services and Web service
operations that are exposed via WSX. The WSDD file also defines any additional behavior that
should be used when processing incoming SOAP requests (such as user authentication) or
responses (such as reformatting outgoing data). For more information about WSDD format, refer to
the Axis Reference Guide at http://ws.apache.org/axis/.

When | deploy a Web service and its JAR file(s), do | need to update the application server classpath?

No. The classpath is updated automatically by a special-purpose classloader. The classloader
extends the application server classpath with any classes located in
agile_home/integration/sdk/extensions (or the location specified for the sdk.extensions property in
the agile.properties file).
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If I make changes to a Web service and redeploy it, do | need to restart the application server?

No. A special-purpose handler ensures that the Web services stack is updated with the latest files
that have been deployed. Whenever a Web service request is made, the handler checks whether
any JAR files located in agile_home/integration/sdk/services have been updated, added, or
removed. If so, the entire Web services stack is reset. This feature allows you to recompile your
code and redeploy a Web service without having to restart the application server, saving you
precious development time.

Are there any Agile products that use the WSX framework?

Yes. Agile Content Service (ACS) and Agile Integration Services (AIS) both rely on WSX framework
to exchange data with the Agile PLM server.

What are Agile Integration Services?

Agile Integration Services (AIS) are Web services that provide import, export, and partlist
functionality. Included with these Web services are sample Java Clients, but you can create other
SOAP-compliant AIS clients in other programming languages.

What is basic authentication?

Basic authentication is a simple method of authentication. It allows a client program to provide
credentials in the form of an unencrypted user name and password when making a request. There
is a new Web module that uses basic authentication for deploying Web service listeners. The URL
for accessing Web services with basic authentication is:
http://<hostname>/Aqile/ws/MyFirstWebService?wsdl|

For example, use this URL for the MyFirstWebService sample:

http://<hostname>/Agile/integration/ws/MyFirstWebService?wsdl
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Developing Dashboard Management
Extensions

This chapter includes the following:

About Dashboard Management EXLENSIONS .........cccvurereieeriierrirneesseesiss s sssesssssesssssssssssssssssssssssssesssssessssens
Developing Custom Chart Dashboard Management Extensions
Developing Custom Table Dashboard Management Extensions
Defining CUSIOM (URL) EXIENSIONS .....cucuviieeiiieiritieisieieise ettt ettt

About Dashboard Management Extensions

Similar to Process Extensions, Dashboard Management Extensions (DX) extend the functionality of
the Agile PLM system. The Extensions support the following formats to access and display PLM
data on the Agile PLM Dashboard:

o ChartDataModel for charts

o Collections for tables

When data is defined using these formats, Agile servers can interpret and process this data, and
Agile Java Client users with administrator privileges can define Dashboard Tabs and display them
in one of the following views or layouts:

8 Chart
o Table
@ Custom (URL)

The SDK provides the API's that enable connecting the Agile PLM server to internal Agile
databases to get the required content, format it as required by the DXs, and display the data in the
Agile PLM Dashboard. Similarly, you can use other Java API's such as JDBC to connect to external
databases for content.

Briefly, DXs provide the data, Dashboard Tabs and the formats to display the data (tables, charts,
and URLSs) are configured in Agile Java Client. Finally, Agile PLM users with proper privileges can
view the Dashboard Tab and displays in Agile Web Client.

This chapter provides both background information and procedures to develop these methods.
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Roles and Privileges in Dashboard Management Extensions

You must set the Dashboard Tab View privilege in Admin>User Settings>Privileges so that PLM users
can view the Tabs and the related data in Web Client. In addition, Dashboard Tabs are controlled
by privileges, and Agile PLM users must have the necessary roles and privileges to view the data
on the Tab. Procedures to configure the views and assign privileges are fully documented in Agile
PLM Administrator Guide.

Developing Custom Chart Dashboard
Management Extensions

The ICustomChart interface enables creating the necessary DXs that will display the required
data in chart formats. This interface exposes the method which returns an instance of the public
ChartDataModel getChart (IAgileSession session, Map params)

Note Implementations of this interface must have no-arg constructors and they must be
reentrant.

Understanding ChartDataModel and ChartDataSet

The ChartDataModel class organizes the input data in a chart format. It is a concrete class that is
exposed to the DXs and It contains one or more ChartDataSet (s) that you need to construct
the chart.

A ChartDataSet is another concrete class that is exposed to the DXs. It contains the data
required to plot a chart. For example, X-axis and Y-axis values and labels. The ChartDataModel
is a placeholder for all the data sets.

Note The ChartDataModel and ChartDataSet classes are exposed in com.agile.px
package.

Defining a Custom Chart DX Data Source

As indicated above, chart DXs display the data in chart formats. The code in Example 20-1 uses
ICustomChart and the exposed classes (ChartDataModel and ChartDataSet) to display the
differences between morning and evening temperatures for every day of the week, using predefined
input data in a chart format.

Example: Defining a DX to display data in a chart format
package dashboard.chart;

import java.util.Map;

import com.agile.api.IAgileSession;
import com.agile.px.lCustomChart;
import com.agile.px.ChartDataModel;
import com.agile.px.ChartDataSet;
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/**
* A Sample Dashboard DX for Charts with predefined data.
* This Example displays a comparison chart between
* Morning and Evening Temperatures for each day of the
* week with predefined data.
*/

public class TemperatureComparisionChart implements ICustomChart(

/**
* Returns custom ChartDataModel. ChartDataModel
* ig a placeholder to hold all the
* ChartDataSet (s) and any other relevant information related to the
charts.
* @param session current user session.
* @param params
* @return com.agile.px.ChartDataModel
*/
public ChartDataModel getChart(IAgileSession session,Map params) throws
Exception{
// Create a ChartDataModel
ChartDataModel chartDataModel = new ChartDataModel ("Temperatures") ;

// Create a ChartDataSet's for Morning and Evening Temperatures
ChartDataSet chartdataSet[] = new ChartDataSet[2];

// Create a ChartDataSet for Morning Temperatures chartdataSet [0]
ChartDataSet ("Morning Temperatures",7) ;

// £i1ll in the Morning Temperatures double[] morTempValues = {10, 8,
12, 19, 10, 14, 13};

chartdataSet [0] .setValues (morTempValues); // or setYValues can be used
instead

// Set the Labels

new

String[] labels = {"Monday", "Tuesday", "Wednesday", "Thursday",
"Friday", "Saturday", "Sunday"};

chartdataSet [0] .setLabels (labels) ;

// Create a ChartDataSet for Evening Temperatures chartdataSet[1] = new

ChartDataSet ("Evening Temperatures",7) ;

// Fill in the Evening Temperatures double[] eveTempValues = {16, 12,
20, 15, 18, 24, 26};

chartdataSet [1] .setValues (eveTempValues) ;
chartdataSet [1] .setLabels (labels) ;

// Set the ChartDataSets in the Chart Model
chartDataModel . setDataSets (chartdataSet) ;

return chartDataModel ;

}
}
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Packaging and Deploying a Custom Chart DX Source

After developing the necessary classes for a new Chart, package and deploy them using the
following procedure.

To package and deploy a Chart DX source:

1. Use your Java development environment or the Java Archive tool (or JAR tool), to create one
or more JAR files for the custom action. Make sure the JAR file(s) includes a META-
INF/services directory that contains the file com.agile.px.ICustomChart. This is a text file that
lists the fully qualified Java class names, one class per line, for the custom action.

You can include multiple charts in one package. For example,
com.agile.px.ICustomChart could look like this:

dashboard.chart.TemperatureComparisionChart
dashboard.chart.AgileObjectsCountChart
dashboard.chart.ActualVsBudgetedLaborCostChart

Note  Paths within a JAR file are case-sensitive. Therefore, make sure the META-INF
folder contained within the JAR file name are either all uppercase or all lowercase
characters. Otherwise, the custom action will fail to deploy.

2. Place the JAR file(s) in the agile_home/integration/sdk/extensions folder on the same
computer where the Agile Application Server is installed.

Note If you have several application servers in a clustered environment, you must deploy
the Dashboard Extension files on each server in the cluster.

Configuring Chart DXs in Java Client

In Agile Java Client, you can define Chart data sources in the Admin module. To configure the Agile
PLM system settings, you must have an administrator account. This is briefly documented in the
sequel below. For more information, refer to the Agile PLM Administrator Guide.

The data that you provide for a DX, regardless of the layout, is viewed in a Dashboard Management
Tab. Because you cannot define a new Table in the Out of Box Tabs such as Executive or
Financial, you must define a new Tab and then a Table within the Tab to configure a DX.
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To add an optional Dashboard Management tab:

1. InJava Client, select Admin > Systems Settings > Dashboard Management and click the New

e

Dashboard Tab

icon in Dashboard Management.

2. Inthe Create Dashboard Tab dialog, complete the name (For example, call it Dashboard
Extensions) and description fields, set the Visible field to Yes, and then click OK. Dashboard
Extensions appears as an entry in the Dashboard Management.

3.  Click the Order Tabs for Dashboard * icon to reorder the tabs as required in Java Client.

Displaying Optional Tabs in Agile Web Client

You can display the new optional Tab in Agile Web Client and users satisfying the role and
privileges requirement can view the tabs and the corresponding data. You can find the necessary
procedures in Agile PLM Administrator Guide.

To configure a Chart type table in the optional tab:

1. Define a new tab, for example, Dashboard Extensions as shown above.

2. Inthe new tab (Dashboard Extensions), click

Dashboard Extensions page appears.

3. Inthis page, click New Dashboard Table
and define the new table.

e

4.  Select Chart from the View List Type drop-down list.

. The Dashboard Management -

icon to open the Create Dashboard Table dialog

Dashboard Table

Description/Purpose

Possible Settings

select Chart, additional options are displayed).

Name Type the name of the table String
APl Name The Name typed above, converted to CamelCase String
naming convention by Agile PLM
Description Type the description of the table String (optional)
View List Type Lists the types of table. Select Chart (when you Chart, Table, Custom, Advance Search

Dashboard Extension

Lists all process extensions created for chart type
list. Select the chart process extension you want.

Visible To enable viewing in Web Client Yes/No
Chart Type Select the type of chart you want displayed Area, Bar, Line, Pie, Polar, Scatter,
Stacked Area, Stacked Bar, Table
X axis Type the X axis label (optional)
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Dashboard Table Description/Purpose Possible Settings

Y axis Type the Y axis label (optional)

Show Legend To display the chart legend on screen Yes/ No

Legend Position Select the position where the Legend should be Bottom, default, left, right, top

displayed

3D Style To view the graph in 3D Yes/ No

Header Enter a header note if required (optional)

Footer Enter a footer note if required (optional)

5. Complete the fields and then click OK. The name of the new Chart appears in the Dashboard

Management - Dashboard Extensions view.

Developing Custom Table Dashboard

Management Extensions

The ICcustomTable interface is defined to create DXs to display the required data in tabular
formats. This interface exposes the getTable (IAgileSession session, Map params)

method which returns an instance of the Collection class.

public Collection getTable (IAgileSession session, Map params) ;

Note Implementations of this interface must have a no-arg constructor and they must be

reentrant.

Understanding Collection and CustomTableConstants

The Tabular Data in DX is a “collection” of Java HashMaps. Each Map key represents an attribute

in the Table View and the Map represents a row in the table.

The property “Attribute” of a column in View defines the mapping between the data model and the
Table View. The value of this property corresponds to the key of a HashMap entry.

= HashMap keys — For HashMap entries, an attribute is defined in the Table view. For example, a
HashMap entry with “name” as its key value, the property “Attribute” of this attribute will have
the value “name.” The get (‘name’) method will provide the display data for this attribute.

= Link, Image, Money, Text, Date and Numeric Data — These data types are supported in Tabular DX

formats and return objects with the following properties.

* Text — Date, and Numeric Data types do not require any additional properties.

* Link — A valid URL (as String) serves as the target and label for the display. The properties
expected for a link data type are the same for the internal and external links. The DX users
resolve the URL for internal links and add them to the URL property. The DX users can
specify the target property as "RightPane" for internal links. By default, the links will be

targeted to a new window.
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* Image — Images are expected to return an image URL (as String) and label to be displayed
as a tool tip on the Image.

®*  Money — Currency code (String) and Value (Number) needs to be provided for Money Data
types

Note  Keys that support the Link, Money and Image data properties are provided as constants
in the class CustomTableConstants. A constant SERVER_URL is provided in this class.
You can use it get the Server URL in the DX's from the params.

Defining a Custom Table DX Data Source

The sample Dashboard DX in the following example creates a collection of rows with predefined
data for display in the Dashboard. Each row is a Java Map object with key-value pairs that
correspond to each column in the table. This value appears in each cell of the column in the table.
The key is the mapping Attribute name in the View. When creating new Attributes (columns) in the
View, it is necessary to supply this key in the Attribute field. Attribute Names and the corresponding
Data type for this DX are as follows:

Attribute Corresponding Data Type
myString Text
myExternalLink Link
myDate Date
myMoney Money
myNumber Numeric
myImage Image

Example: Defining a Dashboard extension to display data in tabular format
package dashboard.table;

import java.util.*;

import com.agile.api.IAgileSession;

import com.agile.px.lCustomTable;

import com.agile.px.CustomTableConstants;

/** This Sample Dashboard DX creates a collection
* of rows with predefined data

* in the format to be displayed in the Dashboard.
* Each row is a Java Map object which has
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*

*

*

key-value pairs corresponding to each column in the Table.
The value is displayed in each Cell of the
column in the table. The key is the
mapping Attribute name in the View.

While creating

new Attributes (Columnsg) in the View,

you must supply this keyin the Attribute field.

The corresponding Attribute Names and

Data type for this DX are listed below.
<table border="1">
<tr><tds><b>Attribute</b> </td><td><b>Data

*  <tr><tdsmyString </td><td>Text
*  <tr><tdsmyExternalLink </td><td>Link
*  <tr><tds>myDate </td><td>Date
*  <tr><td>myMoney </td><td>Money
*  <tr><tds>myNumber </td><td>Numeric
*  <tr><tds>myImage </td><td>Image
* </table>

*

*/
public class DashboardSampleTable

/**

*

Returns custom
Row is assumed
@param session
@param params

@return : java

/

Tye<b></td></tr>
</td></tr>
</td></tr>
</td></tr>
</td></tr>
</td></tr>
</td></tr>

implements ICustomTable {

table data in form of collection of rows.

to be a java Map object.
the user session

.util.Collection

public Collection getTable (IAgileSession session,Map params) throws
Exception{

St

St

ring serverUrl

(String)params.get (CustomTableConstants.SERVER_URL) ;

ring baseUrl =

serverUrl.substring (0, serverUrl.lastIndexOf ('/"));
ArrayList result

= new ArrayList () ;
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// 1lst Row Entry
HashMap rowl = new HashMap () ;

// For Text type
rowl.put ("myString", "Manoj Yeturu") ;

// For Numeric type
rowl.put ("myNumber",new Double (10000)) ;

// For Date Type
rowl.put ("myDate",new Date()) ;

// For Image Type. The url for image and label (for tooltip) properties
sre set

HashMap hmlImage = new HashMap () ;

hmlImage.put (CustomTableConstants.URL,baseUrl+"/images/action noshad.gi
£")

// Tool Tip hmlImage.put (CustomTableConstants.LABEL, "Action Noshad") ;
rowl.put ("myImage", hmlImage) ;

// For Money Type. The Currency and value properties are set HashMap
hmlMoney = new HashMap () ;

hmlMoney.put (CustomTableConstants.MONEY CURRENCY CODE, "USD") ;
hmlMoney.put (CustomTableConstants.MONEY VALUE,new Integer(3000)) ;
rowl.put ("myMoney" , hmlMoney) ;

// For External Link, url, label (display string) and target
(Rightpane, new etc) are set

HashMap externallLinkl = new HashMap () ;

externallLinkl.put (CustomTableConstants.URL, "http://www.agile.com") ;
externalLinkl.put (CustomTableConstants.LABEL, "Agile") ;
externallLinkl.put (CustomTableConstants.TARGET, " new") ;

rowl.put ("myExternalLink", externalLinkl) ;

result.add (rowl) ;

// 2nd Row Entry
HashMap row2 = new HashMap () ;
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// For Text type
row2.put ("myString", "Venkat Tipparam") ;

// For Numeric type
row2 .put ("myNumber",new Double (50000)) ;

// For Date Type
row2.put ("myDate", (new Date())) ;

// For Image Type
HashMap hm2Image = new HashMap () ;

hm2Image.put (CustomTableConstants.URL, baseUrl +
"/images/addressdown.gif") ;

// Tool Tip

hm2Image.put (CustomTableConstants.LABEL, "Addressdown") ;

row2.put ("myImage", hm2Image) ;

// For Money Type

HashMap hm2Money = new HashMap () ;

hm2Money.put (CustomTableConstants.MONEY CURRENCY CODE, "INR") ;
hm2Money.put (CustomTableConstants.MONEY VALUE,new Integer(4000)) ;
row2.put ("myMoney" , hm2Money) ;

// For External Link

HashMap externallLink2 = new HashMap () ;

externallLink?2.put (CustomTableConstants.URL, "http://www.agile.com/servic
es/support.asp") ;

externallLink?2.put (CustomTableConstants.LABEL, "Supprt") ;
externallLink2.put (CustomTableConstants.TARGET, " new") ;
row2 .put ("myExternalLink", externallLink?2) ;

result.add (row2) ;

return result;

}
}
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Configuring the Link Data Type for Objects Created in Custom Table
DXs

In Understanding Collection and CustomTableConstants on page 54, the Link data type is defined
as follows:

= Avalid URL string that serves as the target and label for the display
And

o DX users can specify the target property as "RightPane" for internal links which are targeted to
a new window by default

When Web Client users retrieve an Agile Object in a Dashboard table by invoking Advanced

Search, they automatically get the Number with a Link and === =%
illustration.

Figure 9: The Quick View option in a Dashboard

as shown in the following

Daghboard

Designs

Designs | have Checked Out

'w scription Design Info.Projet Design Info.Subty
. SN feet=t"9 @

cick iee

The SDK supports configuring the URL in the Link data type to display and open the
selected object in the RightPane for Agile Objects that are generated through user-defined
Dashboard table DXs with ICustomeTable. To perform these configurations, you must first invoke
the Advanced Search function to retrieve the Object.

Invoking Advanced Search in a Custom Table DX Data Source

The following code snippet returns the specified Agile Object and enables the Quick View pop-up
for that Object.

Example: Invoking Advanced Search in a Custom Table DX Data Source

public class DashboardTableContainsQuickView implements ICustomTable{
public Collection getTable (IAgileSession session, Map params)

try

IQuery query = null;

query = (IQuery)session.createObject (-5,
ProgramConstants.CLASS _ACTIVITIES_CLASS) ;
query.setCaseSensitive (false) ;
query.setCriteria ("[General Info.Name] contains
"Dashboard®") ;

Iterator iter = query.execute().iterator();
ArrayList result = new ArrayList () ;

while (iter.hasNext ())
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IRow row = (IRow)iter.next () ;
HashMap rowMap = new HashMap () ;
IProgram program = (IProgram)row.getReferent () ;

program.getId() ;
String number = program.getName () ;
rowMap .put (""number', number) ;

String name =

(String)program.getCell (ProgramConstants.ATT_GENERAL_IN
FO_NAME) .getvalue () ;

HashMap internallLinkMap = new HashMap () ;

internallLinkMap.put ("label", name) ;
internallLinkMap.put ("target", "RightPane");
rowMap.put ("name", internalLinkMap) ;

result.add (rowMap) ;

}

return result;

catch (Exception e)

e.printStackTrace () ;
}return null;

}

Enabling Quick View in a Custom Table DX Data Source

The following example enables Quick View for the Object returned by the search function. Code in

the shaded area enables Quick View. To display = ““™* =" ' you must specify the correct Object
Class ID (objCls1d) and Object ID (obj1d) attributes. In this example, ActivityHandler is
hard coded, because this is the object type that the user wants to open. For other types of object,
for example, Part, you can use itemhandler. The output of this DX is displayed in Sample output
generated by the DX on page 66.

64 Agile Product Lifecycle Management



Chapter 4: Developing Dashboard Management Extensions

Example: Enabling Quick View in a Custom Table DX Data Source

public class DashboardTableContainsQuickView implements ICustomTable{
public Collection getTable (IAgileSession session, Map params)

try

{
IQuery query = null;
query = (IQuery)session.createObject (-5,
ProgramConstants.CLASS ACTIVITIES_CLASS) ;
query.setCaseSensitive (false) ;
query.setCriteria ("[General Info.Name] contains
"Dashboard™") ;
Iterator iter = query.execute () .iterator () ;
ArrayList result = new ArrayList();
while (iter.hasNext ())

IRow row = (IRow)iter.next () ;
HashMap rowMap = new HashMap () ;
IProgram program = (IProgram)row.getReferent () ;

program.getId() ;
String number = program.getName () ;
rowMap.put (""number"', number) ;

String name =

(String)program.getCell (ProgramConstants.ATT_GENERAL_IN
FO_NAME) .getvalue () ;

HashMap internallLinkMap = new HashMap () ;

// Generate Quick View - Object ID and Class ID are necessary

int objClsId = ((Integer)row.getClassId()) .intValue() ;
int objId = ((Integer)program.getObjectId()) .intValue() ;
int objVersion =

((Integer) program.getObjectVersion()) .intValue () ;

String urlStr =
"javascript:displayObject ('ActivityHandler',
" 4+ objClsId + "', '" + objId + "', '0');
\ "onmouseover=\"showQuickViewLink (event, this)\"
onmouseout=\"cancelQuickViewTimer (this) ;

\" infourl=\"showObjectInfo('" + objClsId + "',
rn s obde s "|I II, II, II, Itruell II,
UL oijersion Fn ) ,.\n\n) ,.n,.

internalLinkMap.put ("url", urlStr) ;
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internallinkMap.put ("label", name) ;
internallinkMap.put ("target", "RightPane") ;
rowMap.put ("name", internalLinkMap) ;
result.add (rowMap) ;

}

return result;

catch (Exception e)

e.printStackTrace () ;
}return null;

}

Figure 10: Sample output generated by the DX
Dashboard | Notifications ~ Workflow Routings = My Assignments

Executive Projects Resources Financial My Stuff Optional Tab 1 Optional Tab 2 testox all programs testiyDX

programscontaindashboard

lumber Hame
PGMO00D01 Dashboardpry0l
PGMO0002 Dashboardprg02

Displaying Quick View with Mouseover

To display . = | \when moving the mouse over the Object ID, set the URL parameter as shown

in the following code snippet. Make sure you are using correct values for classid and objectid
parameters.

Example: URL parameter settings to display Quick View

HashMap internallLinkMap = new HashMap () ;
internalLinkMap.put (""'url™,
"Javascript:displayDesignObject("AttachmentHandler®, "2000008297",

"21335435", "0°, "RightPane®, "0", "%, "47);"
onmouseover=""showQuickViewLink(event, this)"
onmouseout="cancelQuickViewTimer(this);"
infourl="'showObjectInfo("2000008297", 21335435, "1", "6173"
"RO", “true®, "DASHBOARD_DXTABLE_2488764_GRID", "4%);'");
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internallLinkMap.put ("label", name) ;
internallLinkMap.put ("target", "RightPane") ;
rowMap.put ("name", internalLinkMap) ;

Note In this example, 2000008297 is the object's classId, 21335435 is the object's 1D, and
so on. These values were defined in the code snippet in Enabling Quick View in a
Custom Table DX Data Source on page 63.

Opening the Selected Object in the Right Pane

By default, when you use the Link option to open the selected object, the object is displayed in a
new Window. The following syntax opens the referenced object in the right pane of the same
window for an object retrieved using Advanced Search shown above.

Note  You must specify the correct Class ID and object ID attributes. In this case, 18022 and
4555 respectively. Also, this link does not enable Quick View. It is a way quick way to put
a link in your code. The Quick View option creates a link that enables the Quick View
popup.

Example: Opening the selected object in the right pane

String name =

(String)program.getCell (ProgramConstants.ATT GENERAL INFO NAME)get.V

alue () ;

HashMap internallLinkMap = newHashMap () ;
internalLinkMap.put ("url","/web/PCMServlet?module=ActivityHandler
&opcode=displayObject&classid=18022&objid=4555") ;
internalLinkMap.put ("label", name) ;
internallLinkMap.put ("target", "RightPane") ;
rowMap .put ("name", internalLinkMap) ;

v9.3.1.2 67



SDK Developer Guide - Developing PLM Extensions

Packaging and Deploying a Custom Table DX Source

After developing the required classes for a new Table, package and deploy them as shown below.

To package and deploy a Table DX source:

1.

Use your Java development environment, or the Java Archive tool (or JAR tool), to create one
or more JAR files for the custom action. Make sure the JAR file(s) includes a META-
INF/services directory that contains a file named com.agile.px.ICustomTable. Thisis a
text file that lists the fully qualified Java class names, one class per line, for the custom action.

You can include multiple charts in one package. For example, the
com.agile.px.ICustomTable file could look like this:

dashboard.chart .ActualVsBudgetedLaborCostTable
dashboard.chart .DashboardSampleTable

dashboard.chart.QueryDashboardPrograms

Note  Paths within a JAR file are case-sensitive. Therefore, make sure the META-INF
folder contained within the JAR file has a name with all uppercase or all lowercase
characters. Otherwise, the custom action is not deployed.

Place the JAR file(s) in the agile_home/integration/sdk/extensions folder on the same computer
where the Agile Application Server is installed.

Note If you have several application servers in a clustered environment, you must deploy
the Dashboard Extension files on each server in the cluster.

Configuring Table DXs in Java Client

Similar to Chart type DXs, you can use an existing Dashboard Management tab, or create your own
optional tab to add your Table DXs.

To Add a Table to a Tab:

1. Define a new tab. For example, Dashboard Extensions as shown above.

2. Inthe new tab (Dashboard Extensions), click I%. The Dashboard Management -
Dashboard Extensions page appears.

i H

3. Inthis page, click the New Dashboard Table == icon to open the Create Dashboard Table dialog
and define the new table.

4. Select Table from the View List Type drop-down list. The Create Dashboard Table dialog
displaying the necessary fields appears.
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5. Complete these fields and then click OK. The new table is created.

Dashboard Table Description/Purpose Possible Settings
Name Type a name for the table String
APl Name The Name filed typed above, converted to String
CamelCase naming convention by
AgilePLM
Description Type a description of the table String
View List Type Lists the types of table. Select Table Chart, Table, Custom, Advance
Search
Dashboard Extension Lists all the process extensions created for These are the attributes that were
the type of Table in view defined in the Packaging and
Deploying a Custom Action on
page 15.
Variable To enable in Web client Yes/No

To Add Data to Tables:

1. Double-click the new table that you created in To Add a Table to Tab on page 68.

2. Click Attributes and then the Add an Attribute icon to create a new attribute.

Note  Agile currently supports Text, Numeric, Image, Date, Money, and Link type data as
table attributes. They are listed and defined in Packaging and Deploying a Custom

Table DX Source on page 68

Figure 11: Sample Dashboard Table DX

Genetal Information |

i e

i3 Add an Attribate | escripkion Display width Attribute
Marne REE Yes Text 100 mySkring ~
es Lirik, 100 myExckernalLink,
Dake fEs Drate 100 myDtae 7
Money Yes Monesy oo |myMoney Y

myManey e

3. Inthe General Information tab, map the Attribute field to the attribute name in the DX.

Note  You are now defining the attributes (columns) that will show up in the table on the

Dashboard Tab. The property “Attribute” defines the mapping between the data
model and the view. For example, if the attribute name in the DX is myString and the
selected attribute type is Text, map the attribute field whose attribute name is
myString.

4. For more information, refer to the Agile PLM Administrator Guide.
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Defining Custom (URL) Extensions

A Dashboard PX of the type URL is configured to initiate from Dashboard Management. When
defining Custom extensions, simply select Custom as the table type. See “To Add a URL to a Tab"
below. No other mapping is required for Dashboard PX's of type URL.

Note  URL Process Extensions are defined in the Process Extensions Library to initiate from
Dashboard Management.

To Add a URL to a Tab:

1. Define a new tab, for example, Dashboard Extensions as shown above.

2. Inthe new tab (Dashboard Extensions), click

Tahles

Dashboard Extensions page appears.

3. Inthis page, click New Dashboard Table
and define the new table.

iH

. The Dashboard Management -

icon to open the Create Dashboard Table dialog

4.  Select Custom from View List Type drop-down list. The Create Dashboard Table dialog displaying
fields listed in the following appears.

5. Complete the Create Dashboard Table dialog fields and then click OK.

Dashboard Table Description Possible Settings
Name Type a name for the URL String
Description Type a description String
View List Type Lists types of table. Select Custom Chart, Table, Custom, Advance

Search

Dashboard Extension

Lists all process extensions created for
Custom type list.

Employee Portal, Yahoo, Google,
Process Extension_URLSs

Visible

To enable in Web Client

Yes/No
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Working with Agile PLM Events and
Event Context Objects

This chapter includes the following:

Understanding Agile PLM Events and EVENt FIAMEWOTK..........c.oveeireniininicssssessessssssssssesssss s sssesssssseens
Key Components 0f an AGle PLIM EVENL..........cccovviirince st ssssesessseens
Working with EVENt CONEXE ODJECES ......vevieeieieieirieieiseee et
Working with Event Information and Event Script Objects

Understanding Agile PLM Events and Event
Framework

In Agile PLM, Events act as trigger points for generating an automation action within the PLM
application. Every Event is generated from a source within Agile PLM applications. The source can
be a business action triggered by a user, a Ul action, or system initiated source such as a timer.
These sources can signal other PLM modules that something (an event) has occurred within the
application and it may require an action. The required action can be taken by a user or the PLM
module. Event-driven applications greatly facilitate the management of event-based integrations
and complex event analysis in real time modes.

In Agile SDK environment, Event framework extends the PX framework which facilitated automating
and extending the Agile PLM Applications. Event framework provides a flexible environment for
rapid development and deployment of event-driven applications. To support this environment, Event
framework provides a comprehensive set of data parameters to create, configure, and execute
different types of Agile PLM Events.
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Key Components of an Agile PLM Event

Event framework empowers users to configure Events and Event subscribers. The basic
components of Event framework are shown in the following illustration and described in the
following paragraphs.

Figure 12: Event components

Event Components

Event Handler
Event _ _
=e=n
— e

Event Subrscriber

Trigger Execution Error
Type Mode Handling Order

Event Types

In Agile PLM, Event type refers to a particular action, for example, Create Object, Delete Object,
Audit for Workflow. Agile PLM provides a list of pre-defined Event types for which an event can
occur.

For each Event type, depending on its Handler type, there is a corresponding Java and Script
interface for its Event Context object. For example, for Create Object, there is the
ICreateEventInfo Java interface and ICreateScriptObj Script interface respectively.
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Event type is selected from the drop-down list in Java Client's Create Event dialog when the Event
is created. To access this dialog, refer to Agile PLM Administrator Guide. Default Event types and
their descriptions is shown in the figure below.

Figure 13: Event Types and their descriptions

MName 4 ([escripkion

approve Far Workflow Warkflow, Approve

audit For Warkflow Warkflow, Aodit

Cancel Check Ouk Files Files, Cancel Check Cuk
Change spprovers or Ohservers For WarkFlow Wiarkflow, Change Approvers or Observers
(“hange Status For Sourcing Object Sourcing Object, Change Status
“hange Status For WorkFlow Workflow, Change Status
_heck In Files Files, Check In

heck Qut Files Files, Check Cut

Zommenk For WorkFlow Workflow, Comment
ompliance Rollup on Object Obiject, Compliance Rollup
Create Object obiject, Create
|Delete Chject Obiject, Delete
||Esu:a|atiu:un For Workflow Workflow, Escalation
||E>c:|:n:urt Chjeck Ohiject, Expork
||E>c:tenu:| Ackions Menu Ackions Menu, Extend
lExtend Tools Menu Tools Menu, Extend

et File File, Get

Incarporakte Ikem Ikem, Incorporate
||Pramation Failure For WarkFow Warkflow, Promation Failure
|Purge Version Files Files, Purge Yersion
|Reeject for Workflow workFlow, Reject
Feminder For workFlow Warkflow, Reminder

Save As Object Ohijeck, Save As

Scheduled Event Event, Scheduled

Transfer Aukharity Authority, Transfer
||Unincorpotate Tkem Ikerm, Unincorporate
||LI|:u:IaI:e Relationship Relationship, Update
||LI|:u:IaI:e Table Table, Update

||LI|:u:IaI:e Title Block, Title Block, Update

Note  You can neither create new Event types, nor delete these Event types.

Event Handler and Handler Types

An Event Handler represents a custom action that is called when the Event is raised. They extend
the function of an action taken by a user, interface, or the system when the Event is triggered.
Information about the Event is passed from the Event to the Handler by the Event Context object.
Handlers are invoked by Event Triggers.

The SDK and Event framework support the following Event Handler types:

o Java PX - Java PXs are Java process extensions that implement the IEventAction interface
in com.agile.px package and trigger the compiled Java code. See Event Information
Objects on page 82.
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o Script PX — Script PXs are Script process extensions based on Groovy script language.

The Groovy script code is directly stored in Agile PLM databases. Event Script objects (Event
Script PX handlers) that you develop are text files that are deployed on the Agile PLM server
using the Event Management Node in Java Client. For information on submitting the text files,
see Working with Agile PLM Administrator on page 114. For information about Groovy
implementation in Event framework and Event Script PX development process, see Groovy
Implementation in Framework Environment on page 131.

= Notification — Agile PLM has the capability to send notifications to users, either when the user is
required to take action, or to notify the user of actions that have occurred. Notifications can be
triggered from the SDK and Script. Event Notifications are addressed in the Agile PLM
Administrator Guide. To use the SDK to programmatically send Notifications, refer to "Sending
Notifications with Agile SDK" in SDK Developer Guide - Using Agile APIs.

Note  SDK developers use the Java PX and Script PX to extend the capabilities of Agile PLM.
Notification templates are used by the Agile PLM Administrator to define and configure
Notifications for action or information.

Event Subscribers

An Event Subscriber links an Event Handler to a specific Event. Thus, when a particular event
occurs, Event Handlers associated with the Event through Event Subscribers are initiated in the
order requested by the configuration. The Handler action includes invoking a Java Process
Extension, a Script Process Extension, or sending Notifications.

Event Trigger and Trigger Types

Event Trigger is used to determine when an Event Extension is raised. The Event framework
provides the hooks to automate actions when an incident happens. For example, when a change of
status occurs, a CEO approval is required, the trigger signals the occurrence of an action which will
subsequently notify all Event subscribers for that Event. Most Agile PLM Events are associated with
business actions. Examples are:

@ Create Object Event — associated with the object creation action

o Change Status for Workflow Event — associated with the Workflow status change action

Event Trigger Types

= Pre— This trigger type signals a point prior to the occurrence of an action. The Pre trigger is
commonly used for events that require data validation or other preparations for the upcoming
action. Event Handlers are invoked synchronously from the “Pre” trigger point.

= Post— This trigger type signals a point immediately after the action's changes are committed to
the database. The post trigger is commonly used for Events that perform auditing tasks,
notifications, and integration tasks with external systems related to the completed action. Event
Handlers are invoked synchronously or asynchronously from the “Post” trigger point.

Synchronous and Asynchronous Execution Modes

Event Handlers are invoked synchronously or asynchronously. In general, the term synchronous
means it is run as part of the application within the current action. A synchronous operation blocks a
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process until the operation completes, while an asynchronous operation is non-blocking and only
initiates the operation.

In Agile PLM, the difference between the two modes is:

@ Synchronous — In this mode, the Event Handler is executed in the same thread (as part of the
execution of the action taken) as the Agile PLM thread that triggers the event (for example, a
change in a Workflow status). The original Agile PLM action will resume after the handler action
is completed.

= Asynchronous — In this mode, the Event Handler has its own thread (runs independent of the
execution of the action taken) and it cannot be stopped once it is started. This transaction is
either committed or rolled back based on its own status. The Agile PLM thread that triggers the
event will continue to run independently regardless of the Handler action has finished or not
(Non-block). Notifications are always handled asynchronously.

Synchronous and Asynchronous Operations in OAS Clusters

PLMs that are configured for operation in clusters use Java Message Service (JMS) for messaging
purposes within the cluster. JMS is a Java Message Oriented Middleware (MOM) API for sending
messages between two or more clients.

In OAS clusters, JMS resources are hosted only on the primary node, or IMS-host. If the primary
node is down, asynchronous Events are still triggered on the secondary node and are set to queued
status, but they are never executed. Once the primary node is recovered, depending on the
implementation of OAS, asynchronous Events can execute and cause the final result provided they
can pick up the queued JMS messages when the system went down. Otherwise, these Events
remain in the queue and are never executed. In these situations, you must stop and restart the
cluster, starting with the primary node. If you cannot recover the primary, you must configure the
primary (JMS-host) on another node before starting the cluster. Queued Events do not execute if
you drop the primary and continue to use the application on the secondary nodes.

Note  This constraint is only applicable to the operation of asynchronous Events in OAS
clusters. It does not apply to WLS clusters, because WLS supports clustered JIMS and
has no single “primary” or “JMS-host” node.

Event Error Handling Rule

Event Error Handling Rule is used in conjunction with Event Handlers executed synchronously.
Options are Continue and Stop. The selected option determines the behavior of Agile PLM when an
error is encountered while executing the Event Handler. For more information on error handling
rules, refer to Agile PLM Administrator Guide.

o Continue — If there is an error during the execution of a Handler with synchronous execution
mode, the error is ignored.

o Stop — If there is an error during the execution of a Handler with synchronous execution mode,
the original action and the Event Subscription is ceased.

Event Order

Event Order is a positive integer that determines the sequential "Order" in which the Event handler is
invoked. This allows you to control the execution order of Event Handlers when there are multiple
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Event Subscribers for the same Event type on the same Agile object.

Note If you have both Custom PXs and Java synchronous PXs configured for a Workflow
Change Status action, Java PXs always execute before Custom PXs.

Event FAQs

This section answers common questions about the Event framework and Java and Script process
extensions.

What are the differences between Custom process extensions and Java process extensions (Java PX)?

Similar to Custom process extensions, Java PXs also extend the functionality of Agile PLM clients
through custom actions. This is done by implementing the IEventAction interface in
com.agile.px in Event framework . Process extensions can be used to connect the Agile PLM
server and Agile PLM users to external systems. In addition, Java PXs contain Event COntext
objects which provide more information than Custom PXs.

Can | use Agile's Java API within a Java process extension program?

Yes. You can use Agile's Java API and other external Java APIs as you did with Custom PXs.
Do Java PXs have special security requirements?

No, similar to Custom PXs.

How are roles and privileges defined for Java PXs/Script PXs?

By default, a custom action (a Handler) uses the roles and privileges of the current user. However, if
you want to configure a custom action to have expanded privileges, you can specify the roles
required for the Handler in the Java Client. When the Handler is executed, the roles and privileges
specified for the Handler override those of the current user. Once the Handler is completed, the
client reverts to the user's original roles and privileges.

Do user assigned roles override roles assigned to a Java or Script PX during configuration?

No. Roles assigned to a Java or Script PX override the user's original roles. Thus all actions that
occurred inside the PX Handler are subject to privileges based on these roles. However, the access
of the event context object doesn't need the privilege check, including the getXxX and setXxX
method calls.

How do | configure and deploy a Java process extension?

Similar to Custom PXs, place the JAR file(s) for a process extension in the

agile home/integration/sdk/extensions folder on the application server. Included with
the JAR file(s) should be a file named com.agile.px.IEventAction in the META-INF/services
directory. The contents of these files are the fully qualified Java class names, one class per line, for
an Event action.

After deploying a Java PX on the application server, how do | enable it?

Once Java PX code is deployed, you can configure them for use within Agile PLM in Java Client by
selecting Admin > Settings > System Settings > Event Management > Event Handlers > New > Create Event
Handler > Java PX > Event Action.
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After I've deployed JAR file(s) for a Java PX Handler, do | need to update the application server classpath?

No. The classpath is updated automatically by a special-purpose classloader. The classloader
extends the application server classpath with any classes located in
agile_home/integration/sdk/extensions (or the location specified for the sdk.extensions property in
the agile.properties file).

Which Custom PXs can | migrate to Event framework?

The Event framework supports migrating only Custom Action PXs. These are PXs that are initiated
from the Actions Menu, Tools Menu, and Change Status for Workflow.

The corresponding Event types are: Extend Actions Menu. Extend Tools Menu, and Change Status
for Workflow.

What error handling rules the developer/user must specify?

For Synchronous Handler, the user must specify the error handling rule to determine how the
system reacts if it encounters an error while processing this subscription. The error handling rule
only applies to synchronous Handlers. It supports the following two choices, Stop and Continue.

Agile PLM stops any further event processing, and then returns to the originator who raises the
event. All remaining synchronous subscribers are not called.

In the case of pre-event, upon receiving the error from the subscriber, the originator simply throws
the error to the client that initiates the action and the original action is not performed. The system
may also rollback changes made by Handlers. However, whether the transaction can be rolled back
or not depends on the Handler type. If it is a Java PX Handler, no transaction rollback is performed
since the Handler is a SDK program which has its own transaction.

Do | need to deploy script PXs?

No, Scripts are pasted to the editor in the Script Handler and Agile PLM will store the code in the
database. Consequently, programs are delivered in plain text files and not in object code.

Can | send Notifications using Event Handler?

Yes, you can send a Notification from a Java PX and a Script PX.

When should | use scripting?

Use Scripts for prototyping, simple operations, and test driven development.
Do | need to compile my Script code?

No, Script code is validated for syntax errors when you save it in the Handler and will be compiled
when the Event is triggered.

What are Dirty files and related methods and interfaces?

They are documented in Javadoc generated SDK documentation folder under
IEventDirtyRowFileUpdate. To access the SDK samples folder, see the Note in Client-Side

Components on page 2.

Can a single action trigger multiple Events?
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Yes, for some actions such as Update Multiple Attachment Rows, a single action will trigger multiple
Events. In addition, if there are Subscriber for Pre and Post trigger types, then the order in which
the Subscribers are invoked can vary depending on the PLM client, the action, and the object type.
For example, if you are deleting three rows from an Attachment Table with one Subscriber for the
Pre trigger and one Subscriber for the Post trigger, the behavior in PLM clients are as follows:

= Web Client— A single Update Table Event is triggered

= JavaClient — Three Update Table Events are triggered and one Event for each deleted row as
shown below:

* For Changes, Items, TransferOrders, MFR Parts, Suppliers, Sites, Customers, and
Package objects, the sequence of the Event Subscribers that are invoked is:
=  Pre (handler from the pre trigger subscriber - for the first row )
=  Pre (handler from the pre trigger subscriber - for the second row )
=  Pre (handler from the pre trigger subscriber - for the third row )
= Post (handler from the post trigger subscriber - for the first row )
=  Post (handler from the post trigger subscriber - for the second row )
= Post (handler from the post trigger subscriber - for the third row )

* For Product Service Requests, Quality Change Requests, MFRs, Users, User Groups, the
sequence is: Pre - Post - Pre - Post - Pre - Post

Best practices?
8 What should we avoid in Handlers for Pre-Event?

Use Pre-Event mainly for validation. Although you can modify the Context object, you should
avoid direct object updates using SDK calls. (Sometimes, using SDK calls in Pre-Event may
cause object version mismatch)

o Subscriber Ordering?

Sometimes, for the same event type, you can have the Event Subscribers at Base Class level,
Class level, and Subclass level. For example, you may have a number of Event Subscribers for
Create Object Event Type: one at Item Base Class level, one at the Part Class level, and one
at the Part Subclass level. If you prefer to execute the Subscribers based on Class hierarchy, it
is recommended to allocate an order range for the Base Class, each Class, and each
Subclass. For example, you can assign the following range for different Hierarchy levels:

Base Class 0 — 99; Class 100 — 199; Subclass 200 — 299
@ Can I mix Agile SDK calls and Script PX within Script PX?

You can mix the two as long as you don't use both SDK calls and script PX calls to update
Agile objects in the same Handler code. If you want to update the Agile object, you can either
use SDK calls or update APIs that are supported by Script Context object, but not both. For
procedures, see Accessing SDK with Scripts on page 133.

What are the differences between Variant Management events and other system events?

@ Variant Management does not have "Pre" or "Post" trigger types. Once an event is enabled, it
replaces the system behavior instead of extending it.

= Variant Management event types are only applicable to the Model part subtype.

o The Variant Management event types are not linked to a specific action only.

78 Agile Product Lifecycle Management



Chapter 5: Working with Agile PLM Events and Event Context Objects

= Variant Management event types support only one specific execution mode (Synchronous) and
error handling rule (Stop).
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Working with Event Context Objects

This chapter includes the following:

= Understanding EVent CONEXE ODJECES. .....c.cvvrierrereiricrirs e sers s sssessanes 81

The flowing paragraphs provide describe the role of Event Context objects, their creation, different
Event types, and the information they maintain.

Understanding Event Context Objects

The Context object passes information from the Event to the Handler and between Handlers. When
an Event is raised, an Event context object is created. Information maintained by the context object
includes Event type, pre- and post-Event triggers, plus business-related data for the given Event,
such as the Agile object for which the Event occurred. The business-related data varies for based
on Event type.

Different Event types have different Context objects. Interfaces for Context objects are documented
in Event Information Objects and Event Script Objects. These interfaces are documented in
Javadoc HTML files as Event Information objects (Java interfaces) and Event Script objects (Script
interfaces). To find the Javadoc HTML files in the SDK_samples.zip folder, see the Note in client-
Side Components on page 2.

Persistent and Transient Data

In Event framework, objects passed to Event Handlers (Java PX or Script PX) by Context objects
contain "Persistent" and "Transient" data.

Note  For Variant Management all Context objects contain "Transient" data only.

o Persistent data — This is data that is already in PLM databases. All Agile SDK APIs and Process
Extensions including Web or URL extensions deal with this type of data. When you use
getDataObject () to get the values of an IDataObject object, the data you get is already
in the database, hence "Persistent."

Note  Onlythe getDataObject () method returns Persistent data. Other context object
get data methods will return Transient data unless stated otherwise in Javadoc API
definition.

= Transient data — This is data that is not in the PLM database as yet and is in a state of change.
Transient data contains information about user requests for the action that triggered the Event.

When the Event is triggered, Agile PLM creates Transient data in the Event Context object. The
same Transient data is passed on by the Context object to all Handlers for “Pre” and "Post" unless
specified otherwise in the Javadoc API definition.
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Note  You must not modify Transient data in the "Post" Event triggering instance. If
modified, it will throw an exception. Variant Management events do not have "Pre"
or "Post" trigger types. Once a Variant Management event is enabled, it replaces the
system behavior instead of extending it.

Event Information Objects

These are the interfaces for the Java PXs.

Event Type Event Information Object
"Approve for Workflow" and "Reject for Workflow" ISignOffEventInfo
"Audit for Workflow" TAuditStatusEventInfo
"Change Approvers" or "Observers for Workflow" IChangeAppObserverEventInfo
"Change Status for Sourcing Object" ISourcingObjectChangeStatusEventInfo
"Change Status for Workflow" IWFChangeStatusEventInfo
"Comment for Workflow" IRoutableObjectCommentEventInfo
"Create Object" ICreateEventIno
"Create Variant Instance", "Derive Variant Model Option IVMEventOb]

BOM?", "Update Variant Configuration", "Validate Variant
Configuration”, "Validate Variant Instance Selections", and
"Validate Variant Model Option BOM",

"Delete Object" IDeleteEventInfo

"Escalation for Workflow" IEscalationEventInfo

"Export Object" IExportEventInfo

"Extend Tools Menu" and "Scheduled Event" and the base IEventInfo

interface for all Event information objects

"Get File", "Check In Files", "Check Out Files", and "Cancel IFileEventInfo

Check Out Files"

"Incorporate Item", "Unincorporate Item", "Extend Actions IObjectEventInfo

Menu", and "Compliance Rollup on Object"

"Promotion Failure for Workflow" IPromotionFailureEventInfo
"Purge Version Files" IPurgeFileEventInfo
"Reminder for Workflow" IReminderEventInfo

"Save As Object" ISaveAsEventInfo

"Transfer Authority" ITransferAuthorityEventInfo
"Update Table" and "Update Relationship” IUpdateTableEventInfo
"Update Title Block" IUpdateTitleBlockEventInfo
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Figure 14: Event information objects class hierarchy
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Event Script Objects

These are the interfaces for the Script PXs.

TUpdateEventInfo [d
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Event Type

Script Object Interface

"Approve for Workflow" and "Reject for Workflow"

ISignoffScriptObj

"Audit for Workflow"

TAuditStatusScriptObj

"Change Approvers or Observers for Workflow"

IChangeApproverObserverScriptOb
J

"Change Status for Sourcing Object"

ISourcingObjectChangeStatusScri
ptObj

"Change Status for Workflow"

IChangeStatusScriptObj
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"Comment for Workflow" IRoutableObjectComment ScriptObj
"Create Object" ICreateScriptObj

"Create Variant Instance", "Derive Variant Model Option BOM", IVMScriptObj

"Update Variant Configuration”, "Validate Variant Configuration",

"Validate Variant Instance Selections”, and "Validate Variant

Model Option BOM",

"Delete Object" IDeleteScriptObj

"Escalation for Workflow"

IEscalationScriptObj

"Export Object" IExportScriptObj
"Extend Tools Menu" and "Scheduled Event "Event Script objects, IBaseScriptObj

also the base interface for all Event Script objects

"Get File', "Check In Files", 'Check Out Files' and "Cancel Check IFileEventScriptObj
Out Files"

“Incorporate Item", "Unincorporate Item", "Extend Actions Menu", IBaseObjectScriptObj

and "Compliance Rollup on Object"

"Promotion Failure for Workflow"

IPromotionFailureScriptObj

"Purge Version File Folder" IPurgeFileScriptObj

"Reminder for Workflow" IReminderScriptObj

"Save As Object" ISaveAsScriptObj

"Transfer Authority" ITransferAuthorityScriptObj

"Update Table" and "Update Relationship"

IUpdateTableScriptObj

"Update Title Block"

IUpdateTitleBlockScriptObj

Note In Script PX, you can invoke any SDK or Java call. You can also access any third party
Java or Groovy Libraries if they are deployed on the SDK extensions directory.
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Figure 15: Event script objects class hierarchy
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Working with Event Information and Event Script
Objects

Information provided in this section uses the Event Information objects and Event Script Objects to
develop PX Handlers for Event-related actions, for example, general object actions such as Create
Object, Delete Object; Workflow actions such as Change Status for Workflow.

Descriptions and samples for Event Information objects and Event Script objects appear in the
following paragraphs. Other information includes code samples using these objects and guidelines
to ensure proper handling of special instances of Events in Agile PLM.

Working with Base Event Actions

Base Event Information objects are Java interfaces that are used by all other Event Information
objects. See the illustration in Event Information Objects Class Hierarchy on page 85 .

Base Event Information Object - Java PX

The Base Event Information object is IEventInfo.

o Purpose and function — This is the interface for Extend Tools Menu and Scheduled Event Event
Information objects. In addition, IEventInfo is the inherited interface for all Event
Information objects. It maintains information on Event type, Event trigger type, Event name,
Event Subscriber name, Event Handler name, and user defined Maps.

User defined Maps serve as a place holder for any user defined data and provide a
communication channel between subscribers. They are set in the Synchronous Java PXs and
read by subsequent Synchronous Java PXs and Asynchronous Java PXs. Maps set inside
Asynchronous PXs cannot be used by other Java PXs. If the Java PX fails, the Map is still
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accepted by the Agile PLM and is passed to the next Java PX but all other changes in the
Event Context objects are discarded.

IObjectEventInfo is the base event information object for object-related events.

o Purpose and function — I0bjectEvent Info contains Agile object for which the Event is
triggered. Also, it is the interface for Incorporate Item, Unincorporate Item, Extend Actions
Menu, and Compliance Rollup on object Event Information objects and inherits from
IEventInfo.

8 Inherited interface: IEventInfo

The following examples show using IEvent Info and IObjectEventInfo.

Example: Using IEventinfo

private void testIEventInfo (IEventInfo req)throws APIException{
// getEventType ()
int evttype = req.getEventType() ;

// getEventTriggerType ()

int evtTriggerType = req.getEventTriggerType () ;
// getEventName ()

String eventName = reqg.getEventName () ;

// getEventSubscriberName ()

String subscriberName = reqg.getEventSubscriberName () ;
// getEventHandlerHame ()

String handlerName = req.getEventHandlerName () ;

// setUserDefinedMap ()

Map map = new HashMap() ;

map.put (""METHOD", "setUserDefinedMap()") ;

req.setUserDefinedMap (map) ;

// getUserDefinedMap ()

Map map2 = new HashMap () ;

map2 = req.getUserDefinedMap () ;

String mapValue = map2.get (""METHOD") .toString() ;

Example: Call made by IObjectEventinfo
private void testIObjectEventInfo (IEventInfo req)throws APIException(

String objNumber = "";
IObjectEventInfo info = (l0bjectEventInfo)reqg;

// getDataObject ()
IDataObject obj = info.getDataObject();
if (obj==null)
objNumber = "NULL";
else

}
Base Event Script Objects - Script PX

objNumber = obj.getName () ;

Base Event Script objects is IBaseScriptObj.

= Purpose and function — This is the interface for Extend Tools Menu and Scheduled Event Event

86 Agile Product Lifecycle Management



Chapter 6: Working with Agile PLM Events and Event Context Objects

Script objects. IBaseScriptObj is the inherited interface for all Event Script objects.
IBaseScriptObj maintains information on Event type, Event trigger type, Event name, Event
Subscriber name, Event Handler name, and User Defined Maps.

Note  This interface provides a Script method for sending Agile PLM Notifications.

IBaseObjectScriptObj is the base event information object for object-related events.

m]

m]

Purpose and function — IBaseObjectScriptObj contains Agile object for which the Event is
triggered. Also, it is the interface for Incorporate Item, Unincorporate Item, Extend Actions
Menu, and Compliance Rollup on object Event Information objects and inherits from
IBaseScriptObj.

Inherited interface: IBaseScriptObj

The following examples show using IBaseScriptObj and IBaseObjectScriptObj.

Example: Using IBaseScriptObj

This example opens a SDK session and retrieves information pertaining
to the Event.

void invokeScript (IBaseScriptObj obj)

{

// getEventType ()
int evttype = obj.getEventType() ;

// getEventTriggerType ()

int evtTriggerType = obj.getEventTriggerType () ;
// getEventName ()

String eventName = obj.getEventName () ;

// getEventSubscriberName ()

String subscriberName = obj.getEventSubscriberName () ;
// getEventHandlerHame ()

String handlerName = obj.getEventHandlerName () ;
//logMonitor ()

obj.logMonitor ("Status is Passed") ;

//getAgileSDKSession ()

IAgileSession session = obj.getAgileSDKSession() ;
//getPXEventInfo ()

IEventInfo req = obj.getPXEventInfol() ;
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//sendNotification ()

obj.sendNotification ("Test", true, [ "admin"], " passed from
BaseScriptObj" + eventName) ;

// setUserDefinedMap ()

obj.setUserDefinedMap ( [ 'Agile 93' : 'PLM Product',
'Scripting':'Is Fun Tool']);

// getUserDefinedMap ()

Map myMap = obj.getUserDefinedMap () ;

Example: Using IBaseObjectScriptObj

IBaseObjectScriptObj retrieves Class ID and object number and sets P1,
P2, and P3 attribute values of the object

void testIBaseObjectScriptObj (IBaseScriptObj obj)

{

String objNumber = "";
//Disable all the warning exceptions raise
obj.disableAllWarnings () ;

//get class ID
int classID = obj.getClassId();

//get object number
objNumber = obj.getObjectNumber () ;

//set attributes
obj.setValueByAttId (CommonConstants.ATT PAGE TWO TEXTO01l, "Text

Value") ;

// setValueByAttId one from each attribute type
/*

* Date: Page Two.DateOl

* Text: page Two.TextO01l

* MultiText: Page Three.MultiTextl10
* List: Page Two.ListO01l

* MultilList: Page Three.MultiListOl
* Numeric: Page Two.Numeric 01

* Money: Page Three.MoneyOl

*/

// get attribute value

obj.getValueByAttId (CommonConstants.ATT PAGE TWO_TEXTO01) ;
//log information to handler monitor

obj.logMonitor ("Object Number:" + objNumber) ;
obj.logMonitor ("Class Id :" + classID);
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Working with General Object Actions

General Object actions are actions such as Create, Delete, Save As, and Update Title block.
Information objects and Script Event objects for these Events are grouped and described according
to their inherited interfaces.

General Object Actions - Java PX

Create Object

The Information object for this Event is ICreateEventInfo.

= Purpose and function — ICreateEventInfo retrieves the number and Subclass identifier of the
requested new object. It can also overwrite the number and Subclass set by the clients.

o Inherited interfaces — IUpdateEventInfo, I0ObjectEventInfo, IEventInfo

@ Inherited interface purpose and function:
® TIObjectEventInfo

* IUpdateEventInfo retrieves the Array of Dirty attributes and users can overwrite or set
new attributes and values.

The following examples show using ICreateEventInfo and IUpdateEventInfo.
Example: Using ICreateEventinfo

private void testICreateEventInfo (IAgileSession session, IEventInfo
req) throws APIException {
ICreateEventInfo info = (ICreateEventInfo)req;
String number = "";
Integer subclass = null;
String newNumber = getNewNumber (info); // user defined method
Integer newSubclassId = getNewSubclassId(session, req); // user
defined method
Integer newSubclass = null;
// getNewNumber ()
number = info.getNewNumber () ;

// getNewSubclassId()
subclass = info.getNewSubclassId()

// setNewNumber ()
info.setNewNumber (newNumber) ;

// setNewSubclassId()
info.setNewSubclassId (newSubclassId) ;
newSubclass = info.getNewSubclassId() ;

v9.3.1.2 89



SDK Developer Guide - Developing PLM Extensions

Example: Using IUpdateEventinfo

private void testIUpdateEventInfo (IAgileSession session, IEventInfo
req) throws Exception

// Interface methods

IUpdateEventInfo info = (IUpdateEventInfo)req;

//getCells ()

IEventDirtyCell[] cells = info.getCells();
// getAttributelIds ()

Integer[] attrs = info.getAttributelIds() ;

// setCell()
// Get class specific P1 attribute
Integer plattrId = getPlAttribute (session, info);

// Override client value
info.setCell (plattrId, "set desc from CO");

// Add new Dirty value

info.setCeldirtyl (CommonConstants.ATT PAGE TWO_ TEXTO02, "setCell()");
String value2 =

info.getValue (CommonConstants.ATT PAGE TWO TEXTO02) .toString() ;

// setCell() one from each attribute type

* Date: Page Two.DateOl
* Text: already cover
* MultiText: Page Three.MultiTextl10
* List: Page Two.ListO01l
* MultilList: Page Three.MultiListOl
* Numeric: Page Two.Numeric 01
* Money: Page Three.Money0Ol
*
/

Integer subClassId = getSubclassId(info) ;

IAttribute attrl =
session.getAdminInstance () .getAgileClass (subClassId) .getAttribute
(CommonConstants.ATT PAGE TWO_ LISTO1) ;

IAttribute attr2 =
session.getAdminInstance () .getAgileClass (subClassId) .getAttribute
(CommonConstants.ATT PAGE THREE MULTILISTO1) ;

IAgileList listl =
(IAgilelist)attrl.getAvailablevValues() ;

listl.setSelection(new Object[]{"b"});

IAgileList list2 = null;

if (attr2!=null) {
list2 = (IAgilelist)attr2.getAvailableValues() ;
list2.setSelection (new Object[]{"a", "b", "e"});

SimpleDateFormat df = new SimpleDateFormat ("MM/dd/yyyy") ;

String 4 = "1/31/2009";

Date date = df.parse(d);

info.setCell (CommonConstants.ATT PAGE TWO DATE(01l, date);

String multitext = "set multitext field in CO";

info.setCell (CommonConstants.ATT PAGE TWO LISTO01l, listl);
info.setCell (CommonConstants.ATT PAGE TWO LISTO02, listl); // To test
IEventDirtyCell

info.setCell (CommonConstants.ATT PAGE TWO NUMERICOl, 888.66) ;

if (attr2!=null){
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info.setCell (CommonConstants.ATT PAGE THREE MULTITEXT1O,
multitext) ;
info.setCell (CommonConstants.ATT PAGE THREE MULTILISTO1l, list2);

}

Money money = new Money (new Integer(100), "USD");
// removeCell ()
info.removeCell (CommonConstants.ATT PAGE THREE TEXTO1) ;

}
Update Title Block
The Information object for this Event is ITUpdateTitleBlockEventInfo.

o Purpose and function — TUpdateTitleBlockEventInfo is the interface for Update Title Block
Event information object. Checks whether this is a redline update or undo-redline update on the
Title Block of IItem object which has originated from the Affected Items table of the Change
object

o Inherited interfaces — IUpdateEventInfo, I0bjectEventInfo, IEventInfo
Save As Object

The Information object for this Event is ISaveAsEventInfo.

= Purpose and function — ISaveAsEventInfo performs the following tasks:
* Retrieves the number and Subclass of the newly saved object
*  Overwrites the number and Subclass that are set by PLM clients

o Inherited interfaces — IUpdateEventInfo, I0bjectEventInfo, IEventInfo
Delete Object

The Information object for this Event is IDeleteEventInfo.

o Purpose and function — IDeleteEventInfo is the interface for Delete Event information object.
It performs the following tasks:

* Retrieves the number and Subclass of the newly deleted object
* Checks if the action performed is a soft or hard delete

o Inherited interfaces — IObjectEventInfo, IEventInfo
Export Object

The Information object for this Event is IExportEventInfo.

o Purpose and function — IExportEventInfo performs the following tasks:
* Retrieves the format of the export file
* Returns the array of objects that are exported
* Returns the tables for exporting the object

8 Inherited interfaces — IEventInfo
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Working with General Base Event Script Objects

Create Object

The Script Event object for this Event is ICreateScriptObj.
= Purpose and function — The same as ICreateEventInfo
o Inherited interfaces — IUpdateScriptObj, IBaseObjectScriptObj, IBaseScriptObj

o Inherited interface purpose and function — The same as IUpdateEventInfo,
IObjectEventInfo and IEventInfo

The following examples show using ICreateScriptObj and IUpdateScriptObj.
Example: Using ICreateScriptObj

// In the example, ICreateScriptObj modifies the number and class ID of
the new object.

void testICreateScriptObj (IBaseScriptObj obj)

{

String origNumber = "";
String newNumber = "";
int newSubclassId =
ItemConstrants.CLASS DOCUMENT ; // new subclass ID of choice
int newSubclass ;
int subclass;
// getNewNumber ()
origNumber = obj.getNewNumber () ;
newNumber = origNumber +"new";

// setNewNumber ()
obj.setNewNumber (newNumber) ;
newNumber = obj.getNewNumber () ;
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// getNewSubclassId()
subclass = obj.getNewSubclassId() ;

// setNewSubclassId()
obj.setNewSubclassId (newSubclassId) ;
newSubclass = obj.getNewSubclassId() ;

// log new object number and new subclass ID in to handler

monitor
obj.logMonitor ("new object number is:" + newNumber) ;
obj.logMonitor ("new subclass ID is:" + newSubclass) ;

}

Example: Using IUpdateScriptObj

// In this example, IUpdateScriptObj gets the ID and value of Dirty
attributes, sets Dirty attribute values from context object, and
removes the value of Dirty attributes.

void testIUpdateScriptObj (IBaseScriptObj obj)
{

String dirtyAttr = "";

String dirtyValue = "";

// get Attribute Ids
int [] attrs = obj.getAttrIds();
attrs.each {attr-»>

// get Attribute value
dirtyAttr = obj.getDirtyAttr (attr);

// log attribute Id and value in to handler monitor
obj.logMonitor ("Dirty Attr Id :" + attr);
obj.logMonitor (" dirty Attr value:" + dirtyAttr);

// Overwrite client value

obj.setDirtyAttrValue (CommonConstants.ATT PAGE TWO TEXT02, "set text
value from CO") ;

//Remove Dirty Attribute value

obj.removeDirtyAttr (CommonConstants.ATT PAGE TWO TEXTO02) ;

// get dirty attribute value after removing value from CO

dirtyValue =

obj.getDirtyAttrValue (CommonConstants.ATT PAGE TWO TEXTO02) ;

//log original attribute value in to handler monitor

obj.logMonitor ("Attribute value after remove:" + dirtyValue) ;

Update Title Block

The Script Event object for this Event is ITUpdateTitleBlockScriptObj.

o Purpose and function — IUpdateTitleBlockScriptObj checks whether this is a redline
update or undo-redline update on the Title Block of the TItem object which has originated from
the Affected Items table of Change object

o Inherited interfaces — ITUpdateScriptObj, IBaseObjectScriptObj, IBaseScriptObj
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Save As Object
Script Event object for this Event is ISaveAsScriptObj.
= Purpose and function — ISaveAsScriptObj retrieves the name or number for the new object.

o Inherited interfaces — IUpdateScriptObj, IBaseObjectScriptObj, IBaseScriptObj
Delete Object

The Information object for this Event is IDeleteScriptObj.
@ Purpose and function — IDeleteScriptObj deletes the Event Script object.

= Inherited interfaces — IBaseObjectScriptObj, IBaseScriptOb]j
Export Object

Script Event object for this Event is IExportScriptObj.
= Purpose and function — TExportScriptObj retrieves the format for the export object.

o Inherited interfaces — IBaseScriptObj

Example: Using IExportScriptObj

In this example, IExportScriptObj retrieves information about the
object that is exported.

void testIExportScriptObj (IBaseScriptObj obj)

{

int format;
int [] selectedTables =
String objects ="";
String user = "";
String objectNumber =
"PO0002" ; // the object number being exported
// get current user
obj.getCurrentUser () ;
// get file format for the export.
format = obj.getExtractedFormat () ;

// get list of Object Names being exported
objects = obj.getExtractedObjects() ;

// get tables selected for export

selectedTables = obj.getSelectedTables (objectNumber) ;

// log current user, extracted format, object names and tables which
exported in to handler monitor

obj.logMonitor ("current user is:" + user);

obj.logMonitor ("file format is:" + format) ;

obj.logMonitor ("Object Names are:" + objects);
(

obj.logMonitor ("Selected Tables are:" + selectedTables);

Working with Table and Relationship Actions

These actions include updating the supported object tables for specific business objects.
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Table and Relationship Actions - Java PX

Update Table

The Information object for this Event is TUpdateTableEventInfo.

= Purpose and function — TUpdateTableEventInfo is the interface for Update Table and
Update Relationship. It retrieves the Dirty table for the affected object.

= Inherited interfaces — IObjectEventInfo and IEventInfo. See Base Information Objects -
Java PX on page 85.

o Related interfaces:

IEventDirtyFile is the interface for a Dirty file associated with
IEventDirtyRowFileUpdate or IFileEventInfo. It represents a single row in a file
table and retrieves the checkout date of the Dirty file.

IEventDirtyTable is the interface for a Dirty table associated with
IUpdateTableEventInfo or IEventDirtyRow. The Dirty table contains a collection of
modified rows. It provides access to transient table information for modified tables.

IEventDirtyCell is the interface for a Dirty cell associated with
IEventDirtyRowUpdate Or IUpdateEventInfo. Represents a single cell in a row It
returns the attribute identifier corresponding to this Dirty cell.

IEventDirtyRowFileUpdate retrieves the Dirty file. It is the interface for a Dirty row
used to perform Dirty Row Actions (Add file, Replace file).

IEventDirtyRowUpdate retrieves the Dirty row for which the update occurs. This
interface is used by the update on all tables except the attachment table.

Note  You can find information on "Dirty" objects in the SDK samples Documentation

folder. To access this folder, see the Note in Client-Side Components on page 2.
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These examples use IEventDirtyTable and IEventDirtyRowUpdate on ltem BOM table.
Example: Using IEventDirtyTable

private void testIEventDirtyTable (IAgileSession session,

IEventDirtyTable table, IDataObject obj, int evtTriggerType) throws
Exception

//getTableId ()
String tableName = getTableName (obj, table);

// size()

int size = table.size();

//iterator ()
Iterator it = table.iterator () ;
while (it.hasNext ()) {
IEventDirtyRow row = (IEventDirtyRow)it.next () ;
if (row.getAction () ! =EventConstants.DIRTY ROW ACTION ADD FILE&

&row.getAction () !=EventConstants.DIRTY ROW ACTION REPLACE FIL
E)

//user defined method//
testIEventDirtyRowUpdateCommon (session, row, obj,
evtTriggerType) ;

else

testIEventDirtyRowFileUpdate (row) ; // user defined method

}

Example: IEventDirtyRowUpdate on Item BOM table

private void

testIEventDirtyRowUpdate ItemBOM Update (IEventDirtyRowUpdate row,
IDataObject obj) throws Exception

IEventDirtyCell[] cellsl = row.getCells();

readCells (cellsl); // user defined method
/* setCell() - Override
* List0l ==> c
* MultiText30 ==> setCell() on update
* Text0l ==> setCell()on update
* NumericOl ==> 888.66
* BOM Notes ==> setCell() from CO
*
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//List01
IAttribute attrList =
obj.getAgileClass () .getAttribute (ItemConstants.ATT BOM BOM LISTO1) ;

IAgileList list =
(IAgilelist)attrList.getAvailableValues() ;

list.setSelection (new Object[]{"c"});

row.setCell (ItemConstants.ATT BOM BOM LIST01l, list);

//MultiText30

row.setCell (ItemConstants.ATT BOM BOM MULTITEXT30, "setCell() MT30
update") ;

//Text0l

row.setCell (ItemConstants.ATT BOM BOM TEXTO01l, "setCell() TO1
update") ;

// NumericO0l row.setCell (ItemConstants.ATT BOM BOM NUMERICO1,
888.66) ;

// BOM Notes row.setCell (ItemConstants.ATT BOM BOM NOTES, "setCell ()
Notes update") ;

* setCell() - New
* Ligt02 ==> a
* Text02 ==> setCell() on update

// Listo02

row.setCell (ItemConstants.ATT BOM BOM LIST02, list);

//Text02

row.setCell (ItemConstants.ATT BOM BOM TEXT02, "setCell() TO2
update") ;

// Qty row.setCell (ItemConstants.ATT BOM QTY, new Integer(2));
//removeCell () ==> Date0l & Ref Des

row.removeCell (ItemConstants.ATT BOM_BOM DATEO1) ;
row.removeCell (ItemConstants.ATT BOM FIND NUM) ;
// getCell()

IEventDirtyCell cell =

row.getCell (ItemConstants.ATT BOM BOM LISTO02) ;

Update Relationship

See Update Table in Table and Relationship Actions - Java PX on page 95.

Table and Relationship Actions - Script PX

Update Table

The Script Event object for this Event is TUpdateTableScriptObj.

m]

Purpose and function — TUpdateTableScriptOb is the interface for Update Table and Update
Relationship. It retrieves the dirty table for the affected object.

Inherited interfaces — IBaseObjectScriptObj. See Base Event Script Objects - Script PX on
page 86 .
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u]

Related interfaces:

IEventDirtyRow is the base interface for a dirty row associated with
IUpdateTableScriptObij. It represents a single row in a table. There is an action
associated with the row.

IEventDirtyRowFileUpdate retrieves the dirty file row. It is the interface for a dirty file
row used to perform Dirty File Row Actions (Add file, Replace file).

IEventDirtyRowUpdate retrieves the Dirty row. It is the interface for a Dirty row used to
perform Dirty Row Actions (Add, Delete, Update, Redline Add, Redline Delete, Redline
Update, Undo Redline.)

IEventDirtyFile is the interface for a Dirty file associated with
IEventDirtyRowFileUpdate or IFileEventInfo. It represents a single row in a file
table and retrieves the checkout date of the Dirty file.

The following examples show using IEventDirtyTable and IEventDirtyRowUpdate on ltem
BOM table on Item BOM table.

Example: Using IEventDirtyTable
// IUpdateTableScriptObj: get table id and Dirty row ids

{

}

void testIUpdateTableScriptObj (IBaseScriptObj obj)

//getTableId ()
int table id= obj.getTableId() ;
obj.logMonitor ("Table Id" + table id);

// getDirtyRowIds ()

rowIDs =obj.getDirtyRowIds () ;
rowIDs.each{rID-> //loop through Dirty rows
obj.logMonitor ("rowID is " + rID);

//getDirtyRow ()
row = obj.getDirtyRow (rID) ;

// getAction
action = row.getAction() ;
obj.logMonitor ("Action" + action);

if ((action == EventConstants.DIRTY ROW ACTION ADD FILE) || (action
== EventConstants.DIRTY ROW ACTION REPLACE FILE))
testIEventDirtyRowFileUpdate (obj,row,rID); // user method

else
testIEventDirtyRowUpdate (obj,row,rID); // user method

Example: Using IEventDirtyRowUpdate

//This Item BOM table example gets the object number and action for a
single row associate with IUpdateTableScriptObj

void testIEventDirtyRowUpdate (IBaseScriptObj obj, IEventDirtyRow row,
int rID )

{

//getRowId ()
int rid = row.getRowId() ;
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// getObjectNumber ()
int rnumber = row.getObjectNumber () ;
obj.logMonitor ("row object" + rnumber) ;

// getDirtyRow
dirtyRow = obj.getDirtyRow (rID) ;

//from client, update following attributes in Bom table
// find number,Bom notes, Multi Text0l,List01l,date0l,

numericO
//getDirtyAttrIds ()

dirtyAttrs = dirtyRow.getDirtyAttrIds() ;

def sort attrs = dirtyAttrs as List;

sort_attrs.sort(); //sort attribute Ids

// getDirtyAttrvalue ()
sort_attrs.each {dirtyAttr-»>

attrValue = dirtyRow.getDirtyAttrValue (dirtyAttr) ;
obj.logMonitor ('***'+"attribute value" +'='

// array of vlues to overwrite attributes from Context object
// [find number,Bom notes, Multi Text01l,List01,date01l,

numeric01l]

set dirty value = ["5","Bom Note","Multi text 03",

08:00:00","Text 01","224466"];

//setDirtyAttrValue , overwrite attribute values

int indexy =0;
sort_attrs.each{att->

dirtyRow.setDirtyAttrValue (att , set dirty value[indexy++]);

}

// getDirtyAttrValue() after overwrite in CO

int indexB=0;
sort_attrs.each {dirtyAttr-»>

attrValue2 = dirtyRow.getDirtyAttrValue (dirtyAttr) ;
all attrValue2[indexB++]= attrValue2;

// removetDirtyAttr () remove dirty attributes and rollback changes

sort attrs.each {dirtyAttr-»>

dirtyRow.removetDirtyAttr (dirtyAttr) ;

Update Relationship

See Update Table in Table and Relationship Actions - Java PX on page 95.

Working with Variant Management Events

+ attrvalue) ;

Variant Management events include:

m]

Create Variant Instance

The event handler creates the derived Instance BOM.

"e","2009-01-30
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= Derive Variant Model Option BOM

The event handler creates the logical structure of the Instance BOM without actually creating
new items or changing the BOM tab of an item.

@ Update Variant Configuration

The event handler adds or removes configuration options and runs propagations and pre-
selections.

@ Validate Variant Configuration

The event handler checks the consistency of the Configuration Graph and the Model Option
BOM.

o Validate Variant Instance Selections

The event handler checks validation rules for the configuration, e.g. minimum/maximum
violations, or if an Option Class has sufficient number of valid child options.

o Validate Variant Model Option BOM

The event handler checks validation rules on the Model Option BOM, e.g. if the minimum
guantity value is smaller/equal to the maximum quantity value, or if an Option Class has valid
child options.
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These events can only be triggered on Model part subtype. Once the event is enabled, it replaces
the system behavior instead of extending it.

Note  The Variant Management SPX and JPX default scripts can be downloaded from Oracle
Agile PLM's Event and Web Services Samples Web site at:
https://codesamples.samplecode.oracle.com/servlets/tracking/id/S614.

Variant Management Events - Java PX

The information object for these Events is IVMEventObj :
o Create Variant Instance

@ Derive Variant Model Option BOM

= Update Variant Configuration

= Validate Variant Configuration

o Validate Variant Instance Selections

o Validate Variant Model Option BOM

IVMEventObj is the interface for the Variant Management events information object. It provides
access to the Configuration Graph, the Model Option BOM and the Instance BOM (if available).

Note  You can find more information on the purpose and function of these Events and when
they are triggered, in the Agile PLM Administrator Guide and the chapter entitled
"Configuring Variant Management" in Agile PLM Product Collaboration User Guide.

Inherited interfaces - I0bjectEventInfo, IEventInfo

The following example shows how to use IVMEventObj:

private void testIVMEventObj (IVMEventObj req) {
// get configuration graph
IConfigurationGraph graph = req.getConfigurationGraph() ;
// get Model Option BOM
IModelOptionBOM mob = reqg.getModelOptionBOM() ;

// getting unique id of item that has been
selected/deselected/modified

// by the user

IUniqueId currentId = req.getCurrentUniqueId() ;
IModelOptionBOMItem item = mob.findItem( currentId) ;
graph.selectOption( item ) ;

Variant Management Events - Script PX

The information object for these Events is IVMScriptObj:
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o Create Variant Instance

= Derive Variant Model Option BOM

@ Update Variant Configuration

@ Validate Variant Configuration

o Validate Variant Instance Selections

@ Validate Variant Model Option BOM

IVMScriptObj is the interface for the Variant Management events information object. It provides
access to the Configuration Graph, the Model Option BOM and the Instance BOM (if available).

Note  You can find more information on the purpose and function of these Events and when
they are triggered, in the Agile PLM Administrator Guide and the chapter entitled
"Configuring Variant Management" in Agile PLM Product Collaboration User Guide.

Inherited interfaces - IBaseObjectScriptObj, IBaseScriptObj

The following example shows how to use TVMScriptObj:

void testIVMEventObj (IBaseScriptObj obj)
// get configuration graph
IConfigurationGraph graph = obj.getConfigurationGraph() ;
// get Model Option BOM
IModelOptionBOM mob = obj.getModelOptionBOM () ;
for ( IConfigurationOption option in graph ) {
IModelOptionBOMItem mobItem = mob.findItem(
option.getUniquelId() ) ;
if (option.getQuantity() > mobItem.getMaxQuantity()) {

obj.addErrorMessage ( option, "Quantity must not be
greater than max. quanity())

}
}

Working with Workflow Object Actions

These are Worflow-related actions such as, Change Status for Workflow, Change Approvers or
Observers for Workflow, and the change the status of Product Cost Management's Sourcing
Project.

Workflow Object Actions - Java PX

Change Status for Workflow

The Information object for this Event is IWFChangeStatusEventInfo.

o Purpose and function — IWFChangeStatusEventInfo retrieves changes in Workflow status of
the object and assigned notifiers and checks whether the "auto-promote" flag is set or not set.

o Inherited interfaces — IRoutingSlipEventInfo, IRoutableObjectEventInfo,
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IObjectEventInfo, IEventInfo

o Inherited interfaces purpose and function:

® TIRoutingSlipEventInfo — Isthe inherited interface for all Event Information objects that
contain the Routing slip Object and provides methods to set/get approvers, observers,
comments, and urgent flags

® TIRoutableObjectEventInfo — Istheinherited interface for all Event Information objects
related to workflow actions and provides methods such as get/set approvers or observers

The following examples show using IWFChangeStatusEventInfo,
IRoutingSlipEventInfo, and IRoutableObjectEventInfo

Example: Using IWFChangeStatusEventinfo

private void testIWFChangeStatusEventInfo(IAgileSession session,
IEventInfo req) throws APIException
IWFChangeStatusEventInfo info = (IWFChangeStatusEventInfo)req;
//getNotifiers()
IDataObject[] notifiers = info.getNotifiers();

// isAutoPromote ()

boolean isAutoPromote = info.isAutoPromote () ;
// setNotifiers/()

IUser user = getUser(session, "yvonnec");
IUserGroup ug = getUserGroup (session, "SOA");
Collection col = new ArrayList () ;

col.add (user) ;

col.add (ug) ;

info.setNotifiers(col) ;

// getFromStatus ()
IStatus fromStatus = info.getFromStatus() ;

// getToStatus ()
IStatus toStatus = info.getToStatus() ;
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Example: Using IRoutingSlipEventinfo

private void testIRoutingSlipEventInfo (IAgileSession session,

IEventInfo req)

throws APIException
IRoutingSlipEventInfo info
Collection colAppvrs

Collection colObsvrs = new ArrayList();

Collection colNewAppvrs
Collection colNewObsvrs

new ArrayList () ;
new ArrayList () ;

(IRoutingSlipEventInfo) req;
new ArrayList () ;

String newComments = "Override in context object.";
//getApprovers ()

IDataObject[] approvers info.getApprovers ()
String approverList = arrayToString (approvers
//getObservers ()

IDataObject[] observers info.getObservers () ;
//getComments ()

String comments = info.getComments () ;
//isUrgent ()

boolean isUrgent = info.isUrgent () ;
//setApprovers ()

IUser userl = getUser (session,
getUser (session,
IUser user3 = getUser (session,
IUserGroup ugl = getUserGroup (session,

IUser user2

colAppvrs.
colAppvrs.
colObsvrs.
colObsvrs.

info.setApprovers (colAppvrs) ;
IDataObject [] newApprovers

add (userl)
add (user2)
add (user3)
add (ugl) ;

//setObservers ()

info.setObservers (colObsvrs) ;
IDataObject [] newObservers

//setComments ()

info.setComments (newComments) ;
String latestComments

//setUrgent ()

boolean newUrgent = getOppositeBoolean (isUrgent) ;
info.setUrgent (newUrgent) ;

7
7
7

"badriv") ;

"albertl") ;

"brucec") ;

info.getComments () ;

boolean latestUrgent

"SOA" ) ;

info.getApprovers () ;

info.getObservers () ;

= info.isUrgent () ;
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Example: Using IRoutableObjectEventinfo

private void testIRoutableObjectEventInfo (IEventInfo req) throws
APIException
IRoutableObjectEventInfo info = (IRoutableObjectEventInfo)req;
//getWorkFlow ()
IWorkflow wf = info.getWorkFlow() ;

}
Approve for Workflow

The Information object for this Event is ISignOffEventInfo.

o Purpose and function — ISignOffEventInfo is the interface for Approve for Workflow and
Reject for Workflow. It returns and overwrites information about status, approvers (users),
approver groups, and checks the status of the signoff flag.

o Inherited interfaces — IRoutableObjectCommentEventInfo
IRoutableObjectEventInfo, IObjectEventInfo, IEventInfo

o Inherited interfaces purpose and function — IRoutableObjectCommentEventInfo is the
interface for Comment for Workflow. It retrieves and overwrites data entered for Comments for
Workflow, Approve for Workflow, and Reject for Workflow Events.

Reject for Workflow
See Approve for Workflow.
Escalation for Workflow

The Information object for this Event is ITEscalationEventInfo.

o Purpose and function — IEscalationEventInfo retrieves the following information about the
Escalation for Workflow Event:

* Sign-off user, escalated to users, escalation period, and status of the workflow
o Inherited interfaces — IRoutableObjectEventInfo, IObjectEventInfo, IEventInfo

@ Inherited interfaces purpose and function — See Approve for Workflow.
Reminder for Workflow

The Information object for this Event is IReminderEventInfo.

o Purpose and function — IReminderEventInfo returns notifiers assigned to the Workflow
reminder.

o Inherited interfaces — IRoutableObjectEventInfo, IObjectEventInfo, IEventInfo
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Audit for Workflow

The Information object for this Event is TAuditStatusEventInfo.

o Purpose and function — IAuditStatusEventInfo retrieves the type of Workflow Audit Action
that is performed.

o Inherited interfaces — IAuditResultEventInfo, IRoutableObjectEventInfo,
IObjectEventInfo, IEventInfo

o Inherited interfaces purpose and function — IAuditResultEventInfo is the interface for Audit
for Workflow and Promotion Failure for Workflow. It retrieves error messages for the audit or
promotion failure.

Promotion Failure for Workflow
See Audit for Workflow.
Comment for Workflow

The Information object for this Event is IRoutableObjectCommentEventInfo. See Approve for
Workflow.

Change Approvers or Observers for Workflow

The Information object for this Event is IChangeAppObserverEvent Info.

o Purpose and function — IChangeAppObserverEvent Info retrieves the action type, status, and
applied to status of the Change Approvers or Observers for the Workflow Event.

o change action by the approver or observer on the Workflow state.

o Inherited interfaces — See TRoutingSlipEventInfo.

Workflow Object Actions - Script PX

Change Status for Workflow

The Information object for this Event is IChangeStatusScriptObj.

o Purpose and function — IChangeStatusScriptObj retrieves changes in Workflow status of the
object, the assigned notifiers, and checks whether the "auto-promote" flag is set or not set.

o Inherited interfaces — IRoutingSlipScriptObj , IRoutableScriptObj,
IBaseObjectScriptObj, IBaseScriptObj
o Inherited interfaces purpose and function:
® TIRoutingSlipScriptObj — Inherited interface for all Event Script objects that contain the
Routing slip Object

® TIRoutablecriptObj — Inherited interface for all Event Script objects related to workflow
actions

The following examples show using IChangeStatusScriptObj, IRoutingSlipScriptObj,
and IRoutableObjectScriptObj.

Example: Using IChangeStatusScriptObj
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IChangeStatusScriptObj: Change Status for Workflow Event script object.
void testIChangeStatusScriptObj (IBaseScriptObj obj)

{

// getFromStatus ()
String current status = obj.getFromStatus() ;

// getToStatus ()
String next status = obj.getToStatus() ;

// getNotifiers()
String notifiers =obj.getNotifiers() ;

// setNotifiers/()

obj.setNotifiers(["admin", "demol", "weiz", "demo5"]) ;
// isAutoPromote ()

boolean auto = obj.isAutoPromote() ;

Example: Using IRoutingSlipScriptObj
void testIRoutingSlipScriptObj (IBaseScriptObj obj)

{

// getCurrentUser ()
String user= obj.getCurrentUser() ;

// getObservers ()
def observers = obj.getObservers() ;

// getApprovers ()
def approvers = obj.getApprovers() ;

// getComments ()
String comments = obj.getComments () ;

// isUrgent ()
boolean flag = obj.isUrgent() ;

// setApprovers ()
obj.setApprovers (["admin", "demol"]) ;

// setObservers ()
obj.setObservers (["demo6", "demo5"]) ;
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// setComments ()
obj.setComments (" new comments") ;
boolean new_urgent= true;

// setUrgent ()
obj.setUrgent (new_urgent) ;

Example: Using IRoutableScriptObj

IRoutableScriptObj : get workflow
void testIRoutableScriptObj (IBaseScriptObj obj)

// getWorkflow ()
String wf = obj.getWorkflow/() ;

Approve for Workflow

The Information object for this Event is ISignOffScriptObj.

u]

Purpose and function — 1SignOffScriptObj is the interface for Approve for Workflow and
Reject for Workflow. It returns information about status, approvers (users), approver groups,
and checks the status of the signoff flag.

Inherited interfaces — IRoutableObjectCommentScriptObj, IRoutableScriptObj,
IBaseObjectScriptObj, IBaseScriptObj

Inherited interfaces purpose and function — IRoutableObjectCommentScriptObj — Interface
for Comment for Workflow. It retrieves comments entered for the Routable object.

Reject for Workflow

See Approve for Workflow.

Escalation for Workflow

The Information object for this Event is IEscalationScriptObj.

m]

Purpose and function — ITEscalationScriptObj retrieves names of users to whom the
Workflow is escalated to.

Inherited interfaces — IRoutableScriptObj, IBaseObjectScriptObj, IBaseScriptObj

Inherited interfaces purpose and function — See Approve for Workflow
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Reminder for Workflow

The Information object for this Event is IReminderScriptObj.

o Purpose and function — TReminderScriptObj returns notifiers assigned to the reminder period
and Workflow reminder.

o Inherited interfaces — IRoutableScriptObj, IBaseObjectScriptObj,
IBaseScriptObj

Audit for Workflow

The Information object for this Event is TAuditStatusScriptObj.

o Purpose and function — IAuditStatusScriptObj retrieves the type of Workflow Audit Action
that is performed.

o Inherited interfaces — IAuditResultScriptObj, IRoutableScriptObij,
IObjectScriptObj, IBaseScriptObj

o Inherited interfaces purpose and function — IAuditResultEventInfo is the interface for Audit
for Workflow and Promotion Failure for Workflow. It retrieves error or warning messages and
Workflow status information for the audit or promotion failure.

Promotion Failure for Workflow
See Audit for Workflow.
Comment for Workflow

The Information object for this Event is IRoutableObjectCommentScriptObj. See Approve for
Workflow.

Change Approvers or Observers for Workflow

The Information object for this Event is IChangeAppObserverScriptObj.

= Purpose and function — IChangeAppObserverScriptObj retrieves the action type, status, and
applied to status of the Change Approvers or Observers for the Workflow Event.

o Inherited interfaces — See TRoutingSlipScriptObj.

Working with Specific Object-Based Actions

These actions support incorporating and unincorprating the Item object in PLM's Production
Collaboration solution and change status for Sourcing projects.

Specific Object-Based Actions - Java PX

Incorporate Item and Unincorporate Item

The Information object for this Event is I0bjectEventInfo. This interface and applicable
inherited interfaces are documented in General Object Actions - Java PX on page 89.
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Change Status for Sourcing Project

The Information object for this Event is ISourcingObjectChangeStatusEventInfo

= Purpose and function — ISourcingObjectChangeStatusEvent Info retrieves the type of
action that is performed on the Sourcing object.

o Inherited interfaces — I0bjectEventInfo and IEventInfo
Specific Object-Based Actions - Script PX

Incorporate Item and Unincorporate Item

The Script Event object for this Event is IBaseObjectScriptObj. This interface and applicable
inherited interfaces are documented in General Object Actions - Script PX on page 92.

Change Status for Sourcing Project

The Information object for this Event is ISourcingObjectChangeStatusScriptObj.

o Purpose and function — ISourcingObjectChangeStatusScriptObj retrieves the type of
action that is performed on the Sourcing object.

o Inherited interfaces — IBaseObjectScriptObj and IBaseScriptObj

Working with Files and Attachments Objects Actions
These are the file-related actions such as check out file, check in file, and purging version files.
Files and Attachments Objects Actions - Java PX

Get File, Check Out Files, Check In Files, Cancel Check Out Files

The Information object for these Events is IFileEventInfo.

@ Purpose and function — IFileEventInfo retrieves the Dirty files for the selected file
attachments.

o Inherited interfaces — I0bjectEventInfo and IEventInfo

o Related interfaces — IEventDirtyFile represents a single row in a file table, the interface for
IEventDirtyRowFileUpdate or IFileEventIno

The following example show using IFileEventInfo.

Example: Using IFileEventinfo

private void testIFileEventInfo(IEventInfo req) throws APIException
IFileEventInfo info (IFileEventInfo)req;
StringBuffer buffer new StringBuffer();

// getFiles()
IEventDirtyFile[] files = info.getFiles();
if (files!=null) {
int length = files.length;
if (length!=0) {
for (int i=0;i<length;i++) {
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String fileName = files[i] .getFilename() ;
String msg = 1 + ": " + fileName;
System.out.println (msg) ;

}else {//rows == null
throw new APIException (new Exception("getFiles() returns
null")) ;

// Test IEventDirtyFile
testIEventDirtyFile(files) ;

}
Purge File Version
The Information object for this Event is ITPurgeFileEventInfo.
o Purpose and function — IPurgeFileEvent Info retrieves the version for the purged file.

o Inherited interfaces — I0bjectEventInfo and IEventInfo
Files and Attachments Objects Actions - Script PX

Get File, Check Out Files, Check In Files, Cancel Check Out Files

The Event Script object for these Events is IFileEventScriptObj.

= Purpose and function — IFileEventScriptObj retrieves the Dirty files for the selected file
attachments.

o Inherited interfaces — IBaseObjectScriptObj and IBaseScriptObj

Purge File Version

The Event Script object for this Event is ITPurgeFileScriptObj.
= Purpose and function — TPurgeFileScriptObj retrieves the version for the purged file

o Inherited interfaces — IBaseObjectScriptObj and IBaseScriptObj

The following example show using IFileEventScriptObj.

Example: Using IFileEventScriptObj

// FileEventScriptObj: get file for file actions related events
void testIFileEventScriptObj (IBaseScriptObj obj,IEventDirtyRow row)

// getFile ()
file = row.getFile();
testIEventDirtyFile (obj, file) ;

}

Example: Using IEventDirtyFile

IEventDirtyFile: get file information for Dirty file associated with
IEventDirtyRowFileUpdate

void testIEventDirtyFile (IBaseScriptObj obj, IEventDirtyfile file)

{
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// getFilename ()

String file name = file.getFilename() ;
// getSize()

int file size = file.getSize();

// getType ()

file type = file.getType() ;

// getFileFolderNumber ()

file folder num = file.getFileFolderNumber () ;

// getFileFolderVersionNumber ()

file folder ver = file.getFileFolderVersionNumber () ;
//getCheckoutUser ()
user = file.getCheckoutUser() ;

// getCheckoutDate ()

date = file.getCheckoutDate() ;
obj.logMonitor ("file name is:" + file name) ;
obj.logMonitor ("file size is:" + file size);
obj.logMonitor ("file type is:" + file type);
obj.logMonitor ("file folder number is:" + file folder num);
obj.logMonitor ("file folder version number is:" +
file folder ver);
obj.logMonitor ("checkout user is:" + user);
obj.logMonitor ("checkout date is:" + date);

Working with Product Governance and Compliance Actions

This action supports checking compliance of PG&C objects.

Product Governance and Compliance Actions - Java PX

Compliance Rollup On Object

The Information object for this Event is I0bjectEventInfo. This interface and applicable
inherited interfaces are documented in General Object Actions - Java PX on page 89.

Product Governance and Compliance Actions - Script PX

Compliance Rollup On Object

The Information object for this Event is IBaseScript0Obj. This interface and applicable inherited
interfaces are documented in General Object Actions - Script PX on page 92.

Working with Miscellaneous Object Actions

These are the file-related actions such as check out file, check in file, and purging version files
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Miscellaneous Object Actions - Java PX

Transfer Authority

The Information object for this Event is ITransferAuthorityEventInfo.

= Purpose and function — ITransferAuthorityEventInfo contains the data belonging to
Transfer Authority action and retrieves and overwrites data set by the PLM client for the
Transfer Authority action.

o Inherited interfaces — See IExportEventInfo.
Miscellaneous Object Actions - Script PX

Transfer Authority

The Information object for this Event is ITransferAuthorityScriptObj.

o Purpose and function — ITransferAuthorityScriptObj retrieves and overwrites data set by
the PLM client for the Transfer Authority action.

o Inherited interfaces — IBaseScriptObj

Working with Event Integration Points in PLM Clients

Events can be invoked from Agile PLM clients' Extend Actions Menu, Extend Tools Menu, and
Scheduled Event described below.

Event Integration Points - Java PX

Extend Actions Menu

The Information object for this Event is I0bjectEventInfo. This interface and applicable
inherited interfaces are documented in General Object Actions - Java PX on page 89.

Extend Tools Menu

The Information object for this Event is IEventInfo. This interface and applicable inherited
interfaces are documented in General Object Actions - Java PX on page 89.

Scheduled Event

The Information object for this Event is IEventInfo. This interface and applicable inherited
interfaces are documented in General Object Actions - Java PX on page 89.

Event Integration Points - Script PX

Extend Actions Menu

The Information object for this Event is IBaseScript0Obj. This interface and applicable inherited
interfaces are documented in General Object Actions - Script PX on page 92.
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Extend Tools Menu

The Information object for this Event is IBaseObjectScriptObj. This interface and applicable
inherited interfaces are documented in General Object Actions - Script PX on page 92.

Scheduled Event

The Information object for this Event is IBaseScriptObj. This interface and applicable inherited
interfaces are documented in General Object Actions - Script PX on page 92.

Guidelines for Java PX and Script PX Handlers

These comments and recommendations are intended to ensure the proper development and
implementation of your Java PXs and Script PXs. They include:

= Information that you need from the Agile PLM Administrator to code the handler and
information that you must convey to the Administrator to configure and implement the Event

= Information to ensure proper handling of Events

@ Information to test your PXs
Working with Agile PLM Administrator

The Agile PLM Administrator will convey the necessary information to determine the Event type,
execution mode and trigger type. Once you have developed the Java PX or Script PX handlers, you
must inform the Administrator about the Event subscriber. This information includes Event
type,execution mode, trigger type, order, and applicable error handling rule.

In addition to information about Event subscriber, the Administrator needs the following specific
information to configure the Event Handler.
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Java PX Handlers — Java PXs are deployed on the server, for procedures, see Packaging and
Deploying a Custom Action on page 15. Once deployed, the Administrator locates it in Java
Client by selecting Admin > Settings > System Settings > Event Management > Event Handlers > New.
The Create Event Handler dialog box appear. In Event Handler Type field select > Java PX > Event
Action. The Administrator needs to know the name that appears in the Event Action field and
proceed to configure the Handler.

Figure 16: Create event Handler dialog

< Create Event Handler El

Event Handler Type |Java P b/ |

Marme: |Migrat\on Example - E. Handler |

API Mame  MigrationExampleEHandier A

Deschiption  |Handler For Migration Example -Selects Event action

Enabled |y35 he |
Role | =
Event Action |com.oracle.px.IEventActiDn.HaHoWorId hd |

= Script PX Handlers — The script PX code is a text file. You must send the script text file to the PLM
Administrator. The Administrator will then paste it in the Script field of Create Event Handler
dialog and proceed to configure the Subscriber. This field is accessed from Java Client by
selecting Administrator > Event Management > Event Handlers > Create Event Handler > Script PX >
Script.

Figure 17: Create Script PX

2 Create Event Handler

X

Event Handler Type  |Femaa=3

Mame

APT Mame

&

Description

Enabled |‘f’es w |

Role

&

Script | import com.agie, agileDsL, SoriptObj. IEaseScriptobj
1! add other import statements here

woid invokescript(IBaseScriptObi obi) {

Hscript body starts here,

t
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Testing Event Java PX and Event Script PX

If the Agile PLM Administrator uses your Handlers to configure the Event Subscriber, you should
coordinate testing the PXs with the Administrator. On the other hand, if you do the configurations,
then use the following information for this purpose.

Invoke the new Java PX or Script PX to ensure the action specified in the Handler (code) executes
properly.

If the PX is configured to be invoked by a user action from the Tools menu, you can test it in Web
Client or Java Client as follows:

o In Web Client tool bar select the & ~ button > <Event_name>.

o In Java Client tool bar select the Process Extensions i button or Tools > Process Extensions >
<Event_name>.

Triggering Guidelines for Java PX, Script PX, and Notification Handlers

Use the following guidelines when developing Handlers to ensure proper triggering of the special
instances of these Event types.

General Object Actions

Create Object Event and SaveAs Event

o Web Client and Java Client behavior — This action will trigger one Create Object Event (or SaveAs
Event) and its Context object will contain all Dirty attributes for Page 1, Page 2 and Page 3.

o SDK behavior — This action will trigger one Create object Event (or SaveAs Event). In addition,
depending on table attributes that are updated (Page 1, Page 2 and Page 3), one to three
Update Title Block Events are triggered. The context object will contain all Dirty attributes
belonging to that table.

Update Title Block Event

Web Client, Java Client, and SDK behavior — Depending on table attributes that are updated (Page 1,
Page 2 and Page 3), one to three Update Title Block Events are triggered, one for each table. The
context object will contain all Dirty attributes belonging to that table.

Update Table Event

When you add, modify, or delete more than one row, this action has the following Event triggering
behavior:

o One Event is triggered and the Context object will contain all applicable rows. The only
exceptions are in Java Client:

* Relationships Table- One Event is triggered for each applicable row and the Context Object
will contain the applicable row

* Attachment Table — For Update and Delete Actions, one Event is triggered for each
applicable row and the Context Object will contain the applicable row
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Workflow Actions

Promotion Failure for Workflow Event

This Event is triggered by the following actions:

u]

m]

Failure of Change Status triggered through Relationship

Autopromotion Failure — Autopromotion Failure is invoked by the following object actions when
autopromotion conditions are not met after the completion of these actions. In addition, each
triggered Event is tracked in the object History.

®* Change Status

* Sign off the change

®* Remove Approvers

* Update Cover Page, Page 2, and Page 3 attributes

* Edit Affected Item Table, Relationship, File Attachment Tab

Note Only editing will trigger "autopromote.”

* Cancel checkout attachment
®*  Checkin attachment

Create Automatic Transfer Object Action (ATO)

ATO creation is enabled when ECO status is changed from Pending to Submitted. The sequence of
Events that are triggered when the ATO is created is:

1.

2.
3.

Pre and Post Event Subscribers are created for:
* ECO Change status

® ATO Create

®* ATO Change Status

An ECO is created

Workflow is assigned and status is changed to submitted

Files and Attachments Actions

Check In File Event

This action will trigger the following Events:

m]

Check In File Event on File Folder objects - This Event is triggered when the Check In file
action is performed on File Folder objects

Check In File Event and Update Table Event on Business objects — These Event are triggered
when the Check In file action is performed on Business objects

Note  Update Table Event on Business objects is triggered after Check In File Event is
triggered. Also, The Event is only triggered if the folder version of the attachment is
not set to [LATEST]. In Web Client one Event is triggered for all selected rows. In
Java Client, one Event is triggered for each selected row.
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Check Out File Action
This action will trigger the following Events:

= Check Out Files Event and Get File Event on File Folder objects - These Events are triggered
when the Check Out file action is performed on File Folder objects

o Check Out Files Event and Get File Event on Business objects - These Events are triggered
when the Check Out file action is performed on Business objects in Java Client,

* If Download files in one ZIP file option is selected, one Get File Event is triggered and each
row triggered a Checkout Event

* If Download files in one ZIP file option is not selected, each row triggers one checkout Event
and each file triggers a Get File event

Note In Web Client one Event is triggered for all selected rows. In Java Client, one Event
is triggered for each selected row.

Cancel Check Out File Event

This action will trigger the following Events:

@ Cancel Check Out Files Event on File Folder objects - This Event is triggered when the Cancel
Check Out file action is performed on File Folder objects

o Cancel Check Out Files Event on Business objects — This Event is triggered when the Cancel
Check Out file action is performed on Business objects

Note In Web Client one Event is triggered for all selected rows. In Java Client, one Event
is triggered for each selected row.

Get File Event

This Event is triggered by:

= Clicking the Get button on the Attachments table of Business objects or Files table of File
Folder objects

@ Clicking Filename on the Attachments table of the object

Note If the file is viewable, Agile Viewer is launched and no event will be triggered.
o Check Out file action

Note In Java Client, if users choose to download files individually instead of downloading the
.ZIP file, one Event is triggered for each selected File.
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Migrating Custom Process Extensions to
Event Framework

This Appendix includes the following:
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About this Appendix

This appendix provides information to:

1. Modify the Custom PX Java code created in Developing Process Extensions for use in Event
framework.

2. Configure the modified code to function as a Java PX in the Event framework.

Understanding Custom PXs and Java PXs

The following paragraphs describe the difference between these PXs and lists the Custom PXs that
you can migrate to Event framework and configure as Java PXs in Working with Events.

Custom PXs in PX Framework

Custom PXs defined and configured in Developing Process Extensions are a Java class deployed
on the Agile Application Server, or a link to a URL. These PXs run in the PX framework. See the
illustration in SDK Architecture on page 3. The Java class Custom PXs includes the following types:

o Custom action PXs that implemented the server-side Java APl ICustomAction interface in
com.agile.px package

= Custom autonumber source PXs that implemented the server-side Java API
ICustomAutoNumber interface in com.agile.px package
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Process Extensions in Event Framework

PXs configured in the Working with Events are one of the following types:

= Java process extensions (Java PX) that implemented the server-side APl IEventAction
interface in com.agile.px package

= Script process extensions (Script PX) that implemented the server-side API
invokeScript (IBaseScriptObj obj) interface in com.agile.agile.DSLObj package

Note  To ensure proper operation of all Java process extensions, Oracle recommends
recompiling existing Java-based PXs with the version of the JDK that is shipped with
your application server.

Custom PXs You Can Migrate to Event Framework

The Event framework supports migrating only Custom Action PXs. These are PXs that are initiated
from the Actions Menu, Tools Menu, and Workflow State (Status). See Using the Process Extension

Library on page 16.

The corresponding Event types are:

Custom PX Java PX
Actions Menu Extend Actions Menu
Tools Menu Extend Tools Menu
Workflow State (Status) Change Status for Workflow

Migration Task List

Complete the following tasks to properly migrate a Custom PX to the Event framework and ensure
its proper operation as a Java PX in this environment.

Task - 1: Modify the Custom PX Code

The following code samples show how to change an existing Custom PX code to a Java PX code in
Event framework. The principal difference between a Java PX and a Custom PX is the interface the
PX must implement. Java PXs implement IEventAction and Custom PXs implement
ICustomAction.
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Custom PX Code

This is an example of an existing Custom PX that appeared in Defining a Custom Action. To
migrate Custom PXs, you must modify the code as shown in Java PX Code on page 121.

Example: A Custom PX
public class HelloWorld implements ICustomAction

public ActionResult doAction(IAgileSession session, INode
actionNode, IDataObject affectedObject)

{

return new ActionResult (ActionResult.STRING, "Hello World") ;

}
Java PX Code

The following example is the modified Custom PX to run in the Event framework. Code
modifications that enabled this migration appear in the bold font.

Example: The Custom PX code after modification
public class HelloWorld implements IEventAction

public EventActionResult doAction(IAgileSession session, INode
actionNode, lEventlnfo request)

I0ObjectEventInfo objectEventlinfo = (I0bjectEventInfo) request;
IDataObject affectedObject = objectEventinfo.getDataObject();

ActionResult actionResult = new ActionResult (ActionResult.STRING,
"Hello World") ;

return new EventActionResult (request, actionResult) ;

}

Note Java PXs get their IDataObject values from IEventInfo.
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Task - 2: Package and Deploy the Modified Code

Create JAR files to package and deploy the modified Java code for use in the Event framework. For
procedures, see Packaging and Deploying a Custom Action on page 15. This package is the

"action" that you will use to complete Task - 3: Configure Event in Event Framework on page 122.

Task - 3: Configure Event in Event Framework

The Event Types dialog lists the supported Event types in Event framework. The supported types
for Custom PXs you are migrating are Change Status for Workflow, Extend Actions Menu, and
Extend Tools Menu. Procedures to create and configure these Events appear next. You can find
additional information in Working with Events and in the Agile PLM Administrator Guide.

PE Event Types

CEX

E] = Total Mumber of recordis): 29
Mame Description Enabled
Approve For Workflow workflow, Approve es ~
Audit For WorkFlow workflow, Audit es

Cancel Check Qut Files

Files, Cancel Check Out

‘fes

Change Approvers or Observers For WorkFlow

workflow, Change Approvers or Observers

‘fes

Change Status for Sourcing Object
aw

Change Status for Wo
Check In Files

Sourcing Object, Change Status

workflow, Change Status
Files, Chedk In

fes

Check Qut Files

Files, Check Out

Comment for Workflow

workflow, Comment

Compliance Rollup on Object

Object, Compliance Rollup

Create Cbject Object, Create es
Delete Object Object, Delete es
Escalation For Workflow 'workflow, Escalation es

Expork: Object

Create Event

To create the Event:

File, Get

1. Log into Java Client with Administrator privileges.

|€

2. Select Admin > System Settings > Event Management > Events > New button %2, The Create Event

dialog appears.
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3. In Event Type, point to the drop-down arrow select your Event from the list.
Figure 18: Create an Extend Tools Menu Event

Create Event [Xl
Event Type ‘Extend Taols Menu -3 |
Mame | Migration Example 5]
APTMame  MigrationExample =]

Description  Migrating Custom PX to Java P

Enabled ‘Yes v
Figure 19: Change Status for Workflow Figure 20: Extend Actions Menu
Create Event 3] Create Event X
Event Type |changestatu5 For Workflow vl Event Type |Extend Actions Menu v‘
Name | A Name | A
APLName | =] AP Name: | =]
Description Description
Enabled |Ves vl Enabled |yes v‘
workflow | Default Change Crders v Object Type | Changes v
CHEETED |ChangeOrders v| Change Orders 2_
Stas- o | £o
ECOZ
Status-To | = ECO3 —
Change Requests
ECR.
ECRZ v

Note  Fields in the Create Event dialog are not the same for all Event Types. For example, in
Update Title Block, you are assigning the object's class, but in Approve for Workflow,
you select a status for the Workflow. For information on assigning object classes and
Workflow status, see Assigning Process Extensions to Classes Assigning Process
Extensions to Classes on page 18 and Assigning Process Extensions to Workflow
Statuses on page 18.
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4. Select your Event Type and provide the required information, for example, as shown below. For
more information on completing this dialog, refer to Agile PLM Administrator Guide.

Figure 21: Create an Extend Tools Menu Event

Event Type ‘Extend Taols Menu -3 |
Mame | Migration Example 5]
APTMame  MigrationExample =]

Description  Migrating Custom PX to Java P

Enabled ‘ Yes v

5. Click OK. The Event:<Event _Name> page appears.
Figure 22: Event General Information page

51 Event:Migration Example

General INformation || wihere Used | History

Ewent Type

Mame |Migratinn Example

AP Name  |MigrationExample

Description |Migrating Customn P¥ ta Java P

Enabled | Yes

You can modify the Event from this dialog. When you make a change, the Save button is enabled.
Also, this Event is listed in the Events view. To view, select Event Management > Events. The next task
is to create the handler for this Event.

Create Event Handler

The Event Handler enables executing the compiled Java code. The following procedure guides you
through this step.
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To create the Event Handler:

1. InJava Client with Administrator privileges and select Admin > Systems Settings > Event
Management > Event Handlers > New button 2. The Create Event Handler dialog opens.

Figure 23: Create event Handler dialog

‘2 Create Event Handler &l
Event Handler Type | 13,5 pi v
Mame  |pigration Example - E. Handler
APL Mame |MigrationExampleEHandler ]
Deschiption  |Handler For Migration Example -Selects Event action
Enabled |ygq W
Role 1]
Event Action | om, aracle, px. IEventaction HeloWorld hd

2. In Create Event Handler dialog, do as follows:
* In Event Handler drop-down list, select Java PX.

* In Event Action field, select the one you created in Task - 2: Package and Deploy the
Modified Code on page 122.

* In Role field, if left blank, Event Handler will use the roles and privileges of the current user
by default. However, you can configure a custom action to have override privileges. Refer
to Agile PLM Administrator Guide for information and procedures.

®* Complete the remaining fields and click OK.
Create Event Subscriber

This is a process that binds a Java PX to a specific event. This is done using the Create Event
Subscriber dialog to:

= Bind the Event with the Event Handler
o Set the triggering order (sequence)

o Set the execution mode
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To create Event Subscriber:

1. Loginto Java Client with Administrator privileges and select Admin > Systems Settings > Event
Management > Event Subscribers > New button %2 The Create Event Subscriber dialog opens.
Figure 24: Create Event Subscriber dialog

Create Event Subscriber

3

Mame \Migration Example]- E. Subscriber EE‘

AP Mame \MigrationExampIeESubscriber EB\
Description

Enabled ‘Ves w ‘

Event | [F 1)

Event Handler | B

2. Inthe Create Event Subscriber dialog, do as follows:

Select Event for this Event Subscriber: Click the drop-down list E in the Event field. The
Select Event dialog opens.

In Select Event dialog locate and select the applicable Event and move it to the Selected

column.

Figure 25: Select Event for Event Subscriber

Select Event

(X

Fiter By |Mame | Mateh IF | Starts With ~ | Value | | [ Aty | I
Choices: Selected:
Mame & (Fvent Type Iﬂame AlEvent Type
Grace - Update Title Block Item Group2 Update Title & Migration Example [Extend Taol...
Grace - Update Title Block Ikems Update Title
Grace - Update Title Block Suppliers Brakerl Update Title
Grace - Update Title Black Task Update Title
Grace - Lpdate Titls Black User Graup2 Update Title
Grace - Lpdate Titls Table Fils Folders? Update Tabl
gracel Creats Obje’™
Gracetestz - Lipdate Relationship Update Relz
Incorporate Ikem Idea Incorporate
Java PX Migration Example Extend Tool | 4
jwaus - Cancel Check Out File Folder: Changes Cancel Cher
jwus - Change Status For worldflow Change Stal 4
jwaus - Check In File Folder: Changes Check In File
jwia - Check Ot File Folder: Changes Check Out F
v - Create Parks Create Obje
i - Get File: Changes Gek File
wu-Change ECO Status For Wiarkflow Change Stal
wu-Change Status For Change Orders Change Stal
anioj Create ECO Event Create Obje
r3r Reject for ..
Reiect WF Reisct for ..
3 |
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* Select Event Handler for this Event Subscriber: Click the drop-down list E in the Event
Handler field. The Select Event Handler dialog opens. In Select Event Handler dialog
locate and select the applicable Event Handler and move it to the Selected column.

Figure 26: Select Event Handler for Subscriber

Select Event Handler @
Fiter By |Hame | Match 1F | Starts With |+ | alus | | [ apely ]I
Choices: Selected:

Mame a|Hardier Ty Harme  |Handler Type
(Grace - Durnmy Script for Reject for Workflow <., [Script P A Migration Example - E. Hardler [Java P

Grace - Dummy Script for Remindsr For Workflow. .. [Seript PX
Grace - Dummy Script for Removs Approvers of ... [Seript PX

Grace's Script P21 - Pre Script PX

Grace's Script PAZ - Pre Script PX

Handler for Migration Example lava PR

Helo Script Script PA
Helloworld Jawva PR

jody create Script PA
iosephine-attachment-post Script P |
osephine-attachment-pre Script P

i - Update Ttem dava P 4
wu - UpdatePackage Java P

kamal-kest Script P
Kk-Yalidate Unique UPC Code Script P

kk: Set Idea to Under Investigation upon setking... [Script PX
kkCreate Project on Setting IER ko Investigate Script PK

Iy Hello Script PR
FrinkStatusChange Java P2

Set Rule Java P2
saClearltemvalues Serint P Y
£ b

Note  After completing this step, some of the four fields in the Create Event Subscriber
dialog that are grayed out can be configured now. For example, Trigger Type and
Execution Mode.
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Configure Trigger Type, Execution Mode, Order, and Error Handling
Rule

Event trigger types and Event execution mode plus the order in which the Event is invoked and
error handling rule options that you must set are defined below.

Trigger Type Field

This field has two options as follows:

o Pre— This trigger type signals a point prior to the occurrence of an action. The Pre trigger is
commonly used for events that require data or other preparations for the upcoming action.
Event subscribers configured with this trigger type are executed in the Synchronous Execution
Mode only.

= Post— This trigger type signals a point immediately after the occurrence of an action. This
trigger is used for events that perform auditing tasks based on the prior action. You can
execute Event subscribers configured with this trigger type in either Synchronous or
Asynchronous Execution Modes.

Note  For migrated Custom PXs, always select Post. Custom PXs always run after the
action has occurred.

Execution Mode Field

This field has the Synchronous and Asynchronous options. In general, the term synchronous means
occurring simultaneously and asynchronous means not occurring simultaneously. A synchronous
operation blocks a process until the operation completes while an asynchronous operation is non-
blocking and only initiates the operation.

In Agile PLM, the difference between the two options is:

o Synchronous — In this mode, the Event Handler will be executed in the same thread as the Agile
PLM thread that triggers the event (for example, a change in a Workflow status). The original
Agile PLM action will resume after the handler action finishes (Block).

Note  For migrated PXs always select Synchronous.

= Asynchronous — In this mode, the Event Handler has its own thread and it cannot be stopped
once it is started. This transaction is either committed or rolled back based on its own status.
The Agile PLM thread that triggers the event will continue to run independently regardless of
the Handler action has finished or not (Non-block).

Order Field

Order field is a positive integer that determines the "Order" in which the Event handler is invoked.
This is useful when there are multiple Event Subscribers for the same Event type on the same Agile
object.

Note If you have both Custom PXs and Java PXs configured for a Workflow Change Status
action, Java PXs always execute before Custom PXs.
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Error Handling Rule

This field is set by the user for the Synchronous Execution Mode only. Options are Continue (the
default value) and Stop. The selected option determines the behavior of Agile PLM when an error is
encountered while processing the Event Subscriber. For more information on error handling rules,
refer to Agile PLM Administrator Guide.

@ Continue — This option ignores the error and the Event continues to process the remaining
subscriptions.

= Stop — This option will stop further Event processing and returns to the originator that raised the
Event.

Note  For migrated PXs, select Continue.

Example: Configure Event Subscriber for Migrated PX:

1. In Java Client select Admin > Event Management > Event Subscribers > New button . The Event
Subscriber dialog appears.

2. Set the options in Trigger Type, Execution Mode, and Error Handling Rule fields as shown
below.

These are the recommended options for migrated PXs.
Figure 27: Event Subscriber

Create Event Subscriber @‘
Mame | Change Orders Default Migration Px A
APIMame | ChangeCrdersDefaultMigrationPy =]
Descripkion

Enabled | yeg R’

Event  Migration Example [

Evert Handler  Migration Example - E, Handler [

Trigger Type | post b

Execution Made | Synchranous ~
Crder |

Error Handing Rule | continue b
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Task - 4: Test the Migrated PX in Event Framework

Invoke the new Java PX to ensure the action specified in the Handler (code) occurs. Depending on
the Event type, the Java PX can be invoked by a user from the Extend Actions or Extend Tools
menu, or by a Change Status in Workflow. Make sure the migrated PX's behavior in Event
framework is the same as its behavior in PX framework.

If the PX is configured to be invoked by a user action from the Tools menu, you can test it in Web
Client or Java Client as follows:

o In Web Client tool bar select the & ~ button > <Event_name>.

o In Java Client tool bar select the Process Extensions e button or Tools > Process Extensions >
<Event_name>.

Task - 5: Remove Custom PX from Process Extension Library

It is a good practice to delete the Custom PX that you have migrated from the Agile Process
Extensions Library. This will prevent any duplicate execution of the Custom PX and Java PX.

To remove the Custom PX from PX library:

1. Delete all references to the Custom PX and because you cannot remove the Custom PX if it is
in use.

2. Open Java Client's Process Extensions Library and select and delete the PX.

Task - 6: Inform PLM Administrator

As shown in the Task - 3: Configure Java in Event Framework Task - 3: Configure Event in Event
Framework on page 122, Event configuration is a Ul-based Admin function performed in the Java
Client by an Admin user. Depending on your role as the SDK developer, be sure to inform the PLM
Admin as follows:

= If Event Subscriber creation and configuration is a PLM Admin function, be sure to inform the
cognizant administrator after deploying the modified Custom PX code in Task - 2: Package and
Deploy the Modified Code on page 122. This is to inform the PLM Admin of the new Event
Handler and its specifics to use and complete the remaining tasks.

@ If on the other hand you perform the Ul-based configurations in Java Client, inform your PLM
Admin of the new Java PX, its intended purpose and function and the necessary information to
use the new Java PX in PLM clients.
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Groovy Implementation in Event
Framework

This Appendix includes the following:
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About this Appendix

This appendix provides a description of the Groovy scripting language and sources of information
about this tool, Other topics addressed include how to start a script, access the SDK using scripts,
and sample use cases

What is Groovy?

Groovy is an object-oriented programming language that can be used as a scripting language for
the Java Platform.

Sources of Information

World Wide Web provides links to many sites that offer information about Groovy. Publishers and
vendors of the print media also offer information on this tool. A few are listed below.

8 From World Wide Web:

*  Groovy Home — Provides links to documentation, downloads, tutorial, user guide, Eclipse
plugin examples, advanced usage guide, and other sites maintained by Groovy Home
(http://groovy.codehaus.org/ )

@ From publishers and vendors:

®  Publisher: Manning Publications — Groovy in Action by Dierk Koenig, Andrew Glover, Paul
King, and Guillaume Laforge

®  Publisher: Morgan Kaufmann — Groovy Programming: An Introduction for Java Developers by
Kenneth Barclay and John Savage
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Script PX or Java PX?

Scripts are suitable for rapid development and deployment of applications with simple business
logics. They empower Agile PLM Admins and power users to develop extensions unique to their
requirements and make rapid modifications when necessary. Scripts are not suitable for developing
complex applications with performance critical data structures.

Use scripts to:

u]

Automate functions with simple business logic such as data validation, notification, or defaulting
field values

Implement unique customization for existing applications
Build extensions to existing systems
Rapid prototyping

Write test use cases

Event Framework Implementation

Event framework implementation requires running the scripting engine. Key inplementation
considerations are summarized below.

Key implementation considerations

m]

The scripting engine runs inside the Java 2 Platform Enterprise Edition (J2EE) on the Agile
PLM server and is based on the Groovy language.

Groovy is fully embedded in Event framework.
Groovy is the only supported scripting language.
Script codes are currently stored in the CLOB field in Agile PLM database.

Event Script objects (Event Script PX handlers) that you develop are text files that are deployed
from the Event Management Node by selecting Event Management > Event Handlers in Java Client.

Scripts can call Script APl and Agile SDK.

The Agile PLM Administrator Guide provides both background information and sample
procedures to understand and manage Events.
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Starting a Script

1. Use void invokeScript (IBaseScriptObj obj) to startyour script. InvokeScript is
script’s starting point of the execution and IBaseScriptObj is the base interface for all Event
Script Objects.

2. The run time type of the obj is dynamically resolved based on the type of Event that invoked
this script. For example, if the script is invoked on a Create Event, then ICreateScriptObj is
dynamically resolved as the type of obj at run time. You can invoke any method defined on
ICreateScriptObj and its super-interfaces on the instance of this obj.

3. Use IAgileSession getAgileSDKSession () to access SDK session and invoke SDK
functions.

4. Use AgileDSLException to return "exception" information from scripts.

Accessing SDK with Scripts

You can access an SDK session and Java PX Event object to write SDK programs in script.
/* *

Returns agile SDK session.
@return agile SDK session
@throws AgileDSLException

if the method fails
@since \@Agile93e

* ok X F ok

*/
public IAgileSession getAgileSDKSession() throws AgileDSLException;

/**

Returns PX eventInfo.

@return PX eventInfo

@throws AgileDSLException
if the method fails

@since \@Agiled3e

* % F ok X

*/
public IEventinfo getPXEventinfo() throws AgileDSLException;

Use Cases

You can find Script PX Handler examples for most Event types in Client-Side Components on page
2. These handlers utilize the Pre/Post triggers and Synchronous/Asynchronous executions and
cause different actions when they are invoked.
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Variant Management Configuration
Graph Schema

This Appendix includes the following:
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About this Appendix

The schema in this appendix describes the structure of a Configuration Graph XML document.

The XML Schema

<?xml version="1.0" encoding="windows-1252"?>

<xsd:schema
targetNamespace="http://xmlns.oracle.com/Agile/ABO/Configuratoxr"
xmlns="http://xmlns.oracle.com/Agile/ABO/Configurator"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
elementFormDefault="qualified" attributeFormDefault="unqualified"s>
<xsd:element name="ConfiguratorInitReq"
type="ConfiguratorInitReqType"/>
<xsd:complexType name="ConfiguratorInitRegType">
<xsd:annotations
<xsd:documentation xml:lang="en">
<b>The request ABO for getURL service call in Agile getURL
Requester ABCS.</b>
<b>ModelID: The model ID for which the init message has to be
created.</b>
<b>Organisation: The organisation that is to be used for this
BOM. </b>
<b>ReturnURL: The return URL for the termination message if
any from client side.</b>
</xsd:documentations
</xsd:annotation>
<xsd:sequence>
<xsd:element name="ModelD" type="xsd:string"/>
<xsd:element name="Organisation" type="xsd:string"
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minOccurs="0"/>
<xsd:element name="ReturnURL" type="xsd:string"
minOccurs="0"/>
<xsd:element name="ConfigHeaderId" type="xsd:string"
minOccurs="0"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="ConfiguratorInitResponseType">
<xsd:annotations>
<xsd:documentation xml:lang="en"s>
<b>The Response ABO for getURL service call in Agile
getURL Requester ABCS.</b>
<b>URL: url of the target server.</b>
<b>initializePL: Init message to be posted on the URL
as a long String.</b>
<b>any: If the init message is XML.</b>
</xsd:documentations>
</xsd:annotation>
<xsd:sequence>
<xsd:element name="URL" type="xsd:string"/>
<xsd:element name="initializePL" minOccurs="0">
<xsd:complexType>
<xsd:simpleContent>
<xsd:extension base="xsd:string">
<xsd:attribute name="paramName" type="xsd:string"/>
</xsd:extension>
</xsd:simpleContent>
</xsd:complexType>
</xsd:element>
<xsd:any minOccurs="0"/>
</xsd:sequence>

</xsd:complexType>

<xsd:complexType name="ConfiguratorBOMType">
<xsd:annotations>

<xsd:documentation xml:lang="en">

<b>The configuratorBOM response type.</b>
<b>AppHeader:The App header for agile specific
parameters.</b>

<b>ConfigHeader: Configurator Header</b>

<b>BOM: BOM representing the selected option BOM.</b>
</xsd:documentations
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</xsd:annotation>
<xsd:sequence>
<xsd:element name="AppHeader" type="AppHeaderType"
minOccurs="0"/>
<xsd:element name="ConfigHeader"
type="ConfiguratorHeaderType" minOccurs="0"/>
<xsd:element name="BOM" type="BomType" minOccurs="0"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="AppHeaderType">
<xsd:annotations>
<xsd:documentation xml:lang="en">
<b>The header for adding agile specific data.</b>

</xsd:documentations>
</xsd:annotation>
<xsd:sequence>

<xsd:element name="UserID" type="xsd:string"/>
</xsd:sequence>

</xsd:complexType>
<xsd:complexType name="ConfiguratorHeaderType">

<xsd:annotation>

<xsd:documentation xml:lang="en">
<b>The header info from Configurator EBRO.</b>
<b>ConfigHeaderId: Header ID</b>
<b>ConfigRevision: Confi Revision</b>
<b>ValidConfiguration: Represent ValidConfiguration</b>
<b>CompleteConfiguration: Complete configuration</b>
<b>ExitType: Exit type</b>
<b>PricesCalculatedFlag: Flag to see if the price
calculated.</b>
<b>BomQuantity: Quantity of the BOM itself.</b>
</xsd:documentations>

</xsd:annotation>

<xsd:sequence>
<xsd:element name="ConfigHeaderId" type="xsd:string"/>
<xsd:element name="ConfigRevision" type="xsd:string"/>
<xsd:element name="ValidConfiguration"
type="xsd:string"/>
<xsd:element name="CompleteConfiguration"
type="xsd:string"/>
<xsd:element name="ExitType" type="xsd:string"/>
<xsd:element name="PricesCalculatedFlag"
type="xsd:string"/>
<xsd:element name="BomQuantity" type="xsd:int"/>

</xsd:sequence>
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</xsd:complexType>
<xsd:complexType name="BomType'">
<xsd:annotations>
<xsd:documentation xml:lang="en">
<b>The BOM consisting of different options.</b>
<b>ModelID: Model ID</b>
<b>0OrganizationCode: Organisation code for the BOM</b>
<b>ConfigParameters: BomParameters for the BOM</b>
<b>Option: The child Options</b>
</xsd:documentations
</xsd:annotation>
<xsd:sequence>
<xsd:element name="ModelID" type="xsd:string"/>
<xsd:element name="OrganizationCode"
type="xsd:string"/>
<xsd:element name="ConfigParameters"
type="BomParameters"/>
<xsd:element name="Option" type="OptionType"
minOccurs="0" maxOccurs="unbounded"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="OptionType">
<xsd:annotations>
<xsd:documentation xml:lang="en"s>
<b>The option line items.</b>
<b>ItemID: The ItemID</b>
<b>ConfigParameters: The Bom parameteres for this
Option</b>
<b>Option: The child Options</b>
</xsd:documentations
</xsd:annotation>
<xsd:sequence>
<xsd:element name="ItemID" type="xsd:string"/>
<xsd:element name="PositionID" type="xsd:string"
minOccurs="0"/>
<xsd:element name="ConfigParameters"
type="BomParameters" />
<xsd:element name="Option" type="OptionType"
minOccurs="0" maxOccurs="unbounded"/>
</xsd:sequence>
</xsd:complexType>
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<xsd:complexType name="BomParameters"s>

<xsd:annotation>

<xsd:documentation xml:lang="en"s>

<b>The type representing the Bom parameters.</b>
<b>BomTypeCode: Represents BOM type code</b>

<b>Quantity: Quantity used</b>
<b>Uom: Unit of measurement</b>

</xsd:documentations>

</xsd:annotations>
<xsd:sequence>

<xsd:element name="BomTypeCode" type="xsd:string"/>
<xsd:element name="Quantity" type="xsd:float"/>
<xsd:element name="Uom" type="xsd:string"/>

</xsd:sequence>
</xsd:complexType>

<xsd:simpleType name="ABCSStatus">

<xsd:annotations>

<xsd:documentation xml:lang="en"s>
<b>Status texts for responses</b>
</xsd:documentations

</xsd:annotation>

<xsd:restriction base="xsd:string">

<xsd:enumeration
<xsd:enumeration
<xsd:enumeration
<xsd:enumeration
<xsd:enumeration
</xsd:restriction>
</xsd:simpleType>

</xsd:schema>

value="SUCCESS"/>
value="FAILURE" />
value="WARNING" />
value="ERROR" />
value="FATAL" />
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